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MỞ ĐẦU 

1. Lí do chọn đề tài 

Ngày nay, chúng ta đang sống trong thời đại của nền kinh tế tri thức, thời đại 

mà công nghệ thông tin (CNTT) được gắn kết với hầu hết các sản phẩm và dịch vụ 

kinh tế-xã hội. Chính vì vậy, việc ứng dụng CNTT nhằm nâng cao tính tích cực 

trong dạy học là một xu hướng tất yếu. Theo chỉ thị số 29/2001/CT-BGD&ĐT của 

Bộ trưởng Bộ giáo dục và đào tạo ngày 30/07/2001 về việc tăng cường giảng dạy, 

đào tạo và ứng dụng CNTT trong giáo dục, một trong bốn mục tiệu đặt ra là “Đẩy 

mạnh ứng dụng CNTT trong công tác giáo dục và đào tạo ở các cấp học, bậc học, 

ngành học theo hướng sử dụng CNTT như là một công cụ hỗ trợ nhất cho đổi mới 

phương pháp giảng dạy, học tập ở các môn học”. 

Mặt khác, mạng lưới Internet đã được phủ khắp trên thế giới phục vụ cho các 

nhu cầu đa dạng của con người, giáo dục cũng được phát triển lên một tầm cao mới. 

Học tập trực tuyến (E-learning) và học tập bằng sách điện tử (E-Book) đang dần 

khẳng định vị trí của mình trong nền giáo dục. So với sách in, E-Book không chỉ 

truyền dẫn thông tin dưới dạng văn bản mà còn các ứng dụng đa truyền thông khác 

như hình ảnh, âm thanh, đoạn phim, các hiệu ứng,…và tạo được tương tác giữa 

người học và máy tính. Với những ưu thế đó, E-Book đã trở thành công cụ tiện ích 

quan trọng cho việc học tập của mỗi người trong thời đại bùng nổ CNTT ngày nay. 

Vì vậy, việc ứng dụng CNTT trong dạy học hóa học bằng việc khai thác thông 

tin trên Internet, sử dụng các phần mềm dạy học, bài giảng điện tử, E-Learning, E-

Book đã góp phần nâng cao hiệu quả dạy học lên rất nhiều. Tuy nhiên, dạy học hóa 

học hiện nay không chỉ dừng lại ở việc ứng dụng CNTT để thiết kế bài giảng điện 

tử sinh động, hấp dẫn…mà còn phải tạo động lực và sự hứng thú, sự chủ động ở học 

sinh trong học tập. Với mục tiêu như trên, sử dụng các trò chơi trong dạy học là một 

phương pháp đem lại hiệu quả rõ rệt. Nếu nhìn bằng con mắt tiêu cực, đôi khi các 

trò chơi được coi là nội dung phi giáo dục và gây nghiện. Nhưng trong mắt của các 

nhà giáo dục, trò chơi lại là một phương pháp có thể kích thích được tính chủ động 

trong tâm lý người học. 



Theo Comenxki – ông tổ của nền sư phạm cận đại, “Muốn người học tiếp thu 

nhanh chóng và hứng thú, tốt nhất là người dạy phải biết dùng ngôn ngữ càng vui 

nhộn, hài hước càng tốt. Quá trình học sinh tự mình khám phá, vận dụng kiến thức 

không phải lúc nào cũng thuận lợi và dễ dàng”. 

Một câu hỏi đặt ra, tại sao không lợi dụng khả năng “gây nghiện” trò chơi để 

truyền đạt nội dung học?  

 Để tạo ra những trò chơi mang tính giáo dục và gây được động cơ hứng thú, 

người dạy không chỉ cần chú ý đến nội dung khoa học mà quan trọng hơn là việc 

ứng dụng CNTT để thiết kế nên các thể thức trò chơi hay, hấp dẫn. Tuy nhiên, việc 

ứng dụng CNTT vào trong dạy học hóa học còn nhiều hạn chế. Đặt biệt là sử dụng 

CNTT để thiết kế các trò chơi trong dạy học hóa học chưa được chú trọng do còn 

gặp nhiều khó khăn, như hạn chế về ý tưởng các trò chơi, kỹ năng sử dụng các phần 

mềm để thiết kế trò chơi,… 

Với mong muốn hỗ trợ giáo viên (GV), sinh viên (SV) sư phạm – GV tương 

lai, hình thành, rèn luyện và nâng cao kỹ năng ứng dụng các phần mềm để thiết kế 

trò chơi dạy học thông qua sử dụng học liệu điện tử. Chúng tôi đã lựa chọn đề tài 

“XÂY DỰNG E-BOOK ỨNG DỤNG CÔNG NGHỆ THÔNG TIN ĐỂ THIẾT KẾ 

TRÒ CHƠI TRONG DẠY HỌC HÓA HỌC”. 

2. Mục đích nghiên cứu 

Xây dựng E-Book nhằm hỗ trợ GV, SV sư phạm ứng dụng CNTT để thiết kế 

các trò chơi sử dụng trong dạy học hóa học. 

3. Nhiệm vụ của đề tài 

− Nghiên cứu cơ sở lý luận về sử dụng trò chơi trong dạy học và trong dạy học 

hóa học. 

− Nghiên cứu tổng quan về các phần mềm Microsoft Office PowerPoint 2007, 

Hot Potatoes 6, ProShow Gold,…có thể dùng để thiết kế các trò chơi sử dụng trong 

dạy học hóa học và CourseLab 2.4 để xây dựng E-Book. 

− Xây dựng nội dung ý tưởng các trò chơi hóa học. 

− Hướng dẫn thiết kế các trò chơi hóa học bằng các phần mềm tiện ích. 



− Nghiên cứu về cấu trúc, nội dung E-Book, phương pháp xây dựng E-Book. 

− Sử dụng phần mềm CourseLab 2.4 để xây dựng E-Book. 

− Thực nghiệm (TN) để đánh giá kết quả của đề tài nghiên cứu. 

4. Khách thể và đối tượng nghiên cứu  

Khách thể nghiên cứu:  

− Quá trình đào tạo SV sư phạm Hóa học ở các trường Đại học, Cao đẳng. 

Đối tượng nghiên cứu:  

− Việc xây dựng E-Book hỗ trợ SV sư phạm ứng dụng CNTT để thiết kế các trò 

chơi sử dụng trong dạy học hóa học ở trường phổ thông. 

5. Giới hạn phạm vi nghiên cứu 

− Đối tượng : SV sư phạm ở các trường Đại học, Cao đẳng. 

− Xây dựng E-Book hỗ trợ SV sư phạm ứng dụng CNTT để thiết kế các trò chơi 

trong dạy học hóa học bằng một số phần mềm: Microsoft Office PowerPoint 

2007, Hot Potatoes 6, ProShow Gold. 

6. Giả thuyết khoa học  

Nếu xây dựng E-Book đảm bảo tính khoa học, thẩm mỹ, thân thiện, trực quan, 

sẽ góp phần nâng cao kỹ năng ứng dụng CNTT để thiết kế trò chơi dùng trong dạy 

học hóa học của SV sư phạm Hóa học, từ đó góp phần nâng cao chất lượng đào tạo 

SV sư phạm tại các trường Đại học. 

7. Phương pháp nghiên cứu  

− Đọc và nghiên cứu các tài liệu có liên quan đến đề tài. 

− Phân tích, tổng hợp các thông tin. 

− Sử dụng máy tính và các phần mềm tin học Microsoft Office PowerPoint 

2007, Hot Potatoes 6, ProShow Gold để hướng dẫn thiết kế một số trò chơi hóa 

học và phần mềm Courselab 2.4 để xây dựng E-Book. 

− Điều tra thực trạng bằng cách phát phiếu khảo sát thực trạng. 

− Thực nghiệm sư phạm: Phát phiếu khảo sát ý kiến SV sau khi sử dụng E-

Book “ỨNG DỤNG CÔNG NGHỆ THÔNG TIN ĐỂ THIẾT KẾ TRÒ CHƠI 



TRONG DẠY HỌC HÓA HỌC”, tiến hành thu sản phẩm trò chơi và hồ sơ bài 

dạy của SV thiết kế. 

− Tổng hợp và xử lí kết quả điều tra, kết quả TNSP theo phương pháp thống kê 

toán học.  

8. Đóng góp mới của đề tài 

Xây dựng E-Book nhằm cung cấp cho SV khoa Hóa trường ĐHSP TP.HCM 

một công cụ hỗ trợ hiệu quả, giúp GV, SV hình thành, rèn luyện và nâng cao kỹ 

năng ứng dụng CNTT trong việc thiết kế trò chơi dạy học. Qua đó cũng giúp cho 

GV, SV có được một tài liệu tự học bổ ích, một công cụ hỗ trợ học tập hiệu quả. 



CHƯƠNG 1. CƠ SỞ LÝ LUẬN VÀ THỰC TIỄN CỦA ĐỀ TÀI 

1.1. Lịch sử vấn đề nghiên cứu 

Cùng với sự phát triển mạnh mẽ, không ngừng của CNTT và truyền thông, 

ứng dụng CNTT trong dạy học hóa học bằng việc khai thác thông tin trên Internet, 

sử dụng các phần mềm dạy học, bài giảng điện tử, E-Learning, E-Book đã góp phần 

nâng cao hiệu quả dạy học lên rất nhiều. Tuy nhiên, dạy học hóa học hiện nay 

không chỉ dừng lại ở việc ứng dụng CNTT để thiết kế bài giảng điện tử sinh động, 

hấp dẫn…mà còn phải tạo động lực và sự hứng thú, sự chủ động ở học sinh trong 

học tập. Với mục tiêu như trên, việc sử dụng các trò chơi trong dạy học là một 

phương pháp đem lại hiệu quả cao.  

Vì vậy, các đề tài nghiên cứu về hoạt động này đang được SV và GV quan tâm 

nhiều hơn nhưng chỉ dừng lại ở bước sử dụng để tăng hoạt động hứng thú nhận thức 

cho học sinh. Sau đây là một số luận văn và khóa luận tiêu biểu: 

Khóa luận tốt nghiệp “Tạo hứng thú khi mở đầu bài giảng điện tử trong 

giảng dạy hóa học ở trường phổ thông” của sinh viên Nguyễn Thị Ngọc Quỳnh, 

khoa Hóa học trường ĐHSP TP. Hồ Chí Minh (năm 2010) [18]. 

 Ưu điểm 

Khóa luận đã trình bày khá chi tiết về cơ sở lý luận cũng như một số hình thức hoạt 

động tạo hứng thú khi mở đầu bài giảng điện tử. Trong khóa luận, tác giả đã đề xuất 

3 biện pháp để mở đầu bài giảng điện tử là 

− Mở đầu bài giảng bằng cách kể chuyện qua hình ảnh. 

− Mở đầu bài giảng bằng cách liên hệ thực tế cuộc sống. 

− Mở đầu bài giảng bằng hoạt động đố vui: điển hình như trò chơi ô chữ, trò 

chơi hình ảnh. 

 Hạn chế 

Trong khóa luận, tác giả có đề cập đến hình thức mở đầu bài giảng bằng trò chơi ô 

chữ, nhưng khóa luận cũng chỉ dừng lại ở bước giới thiệu trò chơi ô chữ. Tác giả 

vẫn chưa hướng dẫn người đọc cách thiết kế trò chơi đó như thế nào và trò chơi chỉ 

được thiết kế bằng phần mềm Microsoft Office PowerPoint. 



Khóa luận tốt nghiệp “Thiết kế một số hoạt động dạy học gây hứng thú 

nhận thức trong môn hóa học lớp 10” của sinh viên Tô Quốc Anh, khoa Hóa 

trường ĐHSP TP.Hồ Chí Minh (2007) [1]. 

 Ưu điểm 

Tác giả đã đưa ra một số thiết kế sau: 

− Thiết kế một số trò chơi dạy học hóa học lớp 10: Tác giả đã chia ra thành các 

loại trò chơi như các trò chơi củng cố kiến thức, các trò chơi rèn luyện kỹ năng giải 

bài tập, các trò chơi ôn tập chung. 

− Thiết kế một số dụng cụ dạy học hóa học. 

− Thiết kế một số giáo án dạy học hóa học lớp 10. 

Nhìn chung, đây là một tài liệu khá chi tiết về vấn đề gây hứng thú nhận thức trong 

dạy học. Nội dung những hoạt động dạy học gây hứng thú được đề cập trong khóa 

luận mới lạ và hấp dẫn. Tác giả đã thiết kế được 11 trò chơi dạy học hóa học lớp 10 

được sử dụng với mục đích dạy học khác nhau. Phần nội dung “Thiết kế trò chơi 

dạy học lớp 10” khai thác 11 trò chơi dạy học hóa học có thể áp dụng cho các khối 

lớp và bộ môn khác. Đây có thể làm tài liệu tham khảo tốt cho GV và giáo sinh thực 

tập sư phạm bộ môn Hóa học cũng như các bộ môn khác. 

 Hạn chế 

Tuy nhiên, phần trò chơi trong khóa luận này vẫn chưa ứng dụng cũng như khai 

thác được vai trò CNTT, cũng như chưa giúp cho GV và SV hình thành và rèn 

luyện các kỹ năng thiết kế được các trò chơi đó. Nếu hệ thống trò chơi mà tác giả 

thiết kế được có sự ứng dụng CNTT thì trò chơi sẽ hấp dẫn, sinh động hơn. 

Khóa luận tốt nghiệp “Ứng dụng công nghệ thông tin thiết kế một số họat 

động gây hứng nhận thức cho học sinh phổ thông trong tiết luyện tập hóa học” 

của Trương Thị Huyền Trang, khoa Hóa trường ĐHSP TP.Hồ Chí Minh 

(2009) [22]. 

 Ưu điểm 

Khóa luận đã ứng dụng được phần mềm Microsoft Office PowerPoint thiết kế các 

trò chơi dạy học và được vận dụng trong một dạng bài cụ thể là luyện tập hóa học. 



Tổ chức hoạt động vừa luyện tập, vừa chơi cho học sinh nhằm phát huy khả năng 

học tập tích cực, rèn luyện kỹ năng vận dụng kiến thức, tạo không khí học tập mới. 

Với hệ thống 4 trò chơi lớn (đấu trường X, chung sức, đối mặt, đường lên đỉnh 

Olympia) mà tác giả thiết kế như là một GameShow giúp học sinh cảm thấy gần 

gũi, hứng thú trong hoạt động học tập hơn. Ngoài ra, tác giả còn nêu được các lưu ý, 

bài học kinh nghiệm trong thiết kế và tổ chức trò chơi dạy học khi giảng dạy bài 

luyện tập. 

 Hạn chế 

Tuy nhiên, khóa luận vẫn còn chưa thể hiện hết khả năng mà CNTT có thể làm 

được trong việc thiết kế các trò chơi trong dạy học hóa học. Hệ thống trò chơi chỉ 

được thiết kế bằng phần mềm Microsoft Office PowerPoint, các hướng dẫn thiết kế 

trò chơi chưa được hệ thống lại trong học liệu điện tử nhằm hỗ trợ được SV, GV 

trong khâu thiết kế trò chơi, ý tưởng trò chơi,… 

Luận văn thạc sĩ giáo dục học “Một số biện pháp tích cực hóa hoạt động 

nhận thức của học sinh khi dạy bài luyện tập, ôn tập phần hữu cơ lớp 11 trung 

học phổ thông” của Đinh Thị Thu Hiền (2011) [9]. 

 Ưu điểm 

Luận văn đã nghiên cứu được một số vấn đề về tích cực hóa hoạt động nhận thức 

vận dụng trong việc dạy học các bài luyện tập, ôn tập cụ thể. 

Tác giả đã đề xuất 7 biện pháp tích cực hóa hoạt động nhận thức của học sinh trong 

các bài luyện tập, ôn tập là 

− Sử dụng sơ đồ tư duy để tích cực hóa hoạt động của học sinh. 

− Sử dụng phương pháp Grap dạy học. 

− Sử dụng hệ thống bài tập. 

− Sử dụng Algorit dạy học. 

− Sử dụng hình thức nhóm học tập sử dụng phiếu học tập. 

− Sử dụng trò chơi để kích thích hứng thú học tập. 

− Sử dụng phối hợp các PPDH tích cực. 



Luận văn thạc sĩ giáo dục học “Một số biện pháp nâng cao chất lượng việc 

ôn tập, tổng kết môn hóa học lớp 10 chương trình nâng cao ở trường trung học 

phổ thông” của Nguyễn Thị Minh Thanh (2011) [20]. 

 Ưu điểm 

Cả 2 luận văn trên đã nghiên cứu và trình bày khá đầy đủ và rõ ràng về cơ sở lý 

luận, cũng như đã đề xuất được một số biện pháp tích cực hóa hoạt động nhận thức, 

nâng cao chất lượng việc ôn tập tổng kết môn hóa học lớp 10, 11 chương trình nâng 

cao. Trong đó có biện pháp là sử dụng các đồ dùng dạy học trực quan, các phương 

tiện kỹ thuật như dạy học cộng tác nhóm  nhỏ, tổ chức trò chơi hóa học,… 

Ngoài ra, luận văn thứ nhất đã nêu được tác dụng của trò chơi học tập [9]: 

− Trò chơi có tác dụng hòa đồng sâu rộng và thu hút mức độ tập trung của học 

sinh mà không một phương pháp nào so sánh được. 

− Tổ chức học tập kết hợp với trò chơi không chỉ làm tăng hứng thú, tình cảm của 

học sinh đối với môn học và GV mà còn làm tăng mối quan hệ gắn kết giữa các 

thành viên trong lớp.  

 Hạn chế 

Tuy nhiên, cả 2 luận văn chỉ dừng lại ở bước giới thiệu, nêu ra chứ chưa làm nội 

bật được vai trò, cũng như hỗ trợ, hướng dẫn được người đọc ý tưởng trò chơi, 

cách thiết kế trò chơi đó có ứng dụng CNTT.  

Tóm lại, các nghiên cứu trên là những tư liệu quý giá, có nhiều giá trị về mặt 

lý luận cũng như thực tiễn giúp chúng tôi có thể rút ra nhiều điều bổ ích và những 

gợi ý quan trọng cho đề tài nghiên cứu của mình. Tuy nhiên, nếu chú trọng hơn tới 

việc hướng dẫn kỹ năng phát hiện các hình thức trò chơi, kỹ năng thiết kế ra các trò 

chơi đó có ứng dụng CNTT, cũng như có nguồn tư liệu, hướng dẫn, kho trò chơi 

mẫu cho người xem thì khóa luận sẽ hữu ích hơn vì GV, SV không chỉ là người sưu 

tầm mà còn là người phải biết chủ động tạo ra các trò chơi đó bằng các công cụ, 

phần mềm có sẵn. 

1.2. Giáo dục thế kỉ XXI 

Giáo dục thế kỉ 21 đang chịu tác động của nhiều yếu tố, trong đó đáng kể là [4] 



− Sự phát triển nhanh chóng của khoa học, kỹ thuật đặc biệt là CNTT. 

− Sự tương tác ở mức độ cao của các hệ thống kinh tế, chính trị, xã hội. 

− Nhu cầu tự khẳng định của từng cộng đồng, vùng và lãnh thổ. 

− Quá trình toàn cầu hóa. 

Các yếu tố tác động trên đã dẫn đến những biến đổi cơ bản sau: 

− Sự thay đổi của mục tiêu giáo dục: Từ trang bị kiến thức và kỹ năng sang 

hình thành năng lực, phẩm chất nhân cách của người học. Mục tiêu giáo dục của 

chúng ta hiện nay là tạo ra những con người có năng lực, đầy tự tin, có tính độc lập, 

sáng tạo. 

− Xu hướng giáo dục toàn diện được đề cao. Nhiều môn học mới thiết thực với 

cuộc sống được đưa vào chương trình đào tạo. 

− Do sự phát triển cả về bề sâu và bề rộng của khoa học nên sự giao thoa giữa 

các môn học và ngành học ngày càng lớn. 

− Internet trở thành một phương tiện giáo dục quan trọng. Nhờ Internet quá 

trình tìm kiếm, trao đổi thông tin, sự hội nhập giữa các nền văn hóa trở nên thuận 

lợi hơn. 

− Sự thay đổi các phương tiện và phương pháp dạy học (PPDH): Máy tính cá 

nhân ngày càng trở nên quan trọng với người học. Phương pháp thuyết giảng dần 

mất đi vai trò là PPDH chủ yếu, mà thay vào đó là hệ thống các PPDH linh hoạt và 

đa dạng. 

− Không gian giáo dục và các loại hình đào tạo được mở rộng. Người học 

không nhất thiết phải đến lớp và giảm dần sự tiếp xúc trực diện với GV. 

− Xuất khẩu giáo dục là một lợi thế đem lại nguồn thu nhập cao cho các cường 

quốc giáo dục. 

Vậy giáo dục thế kỉ XXI chịu nhiều tác động, nhưng nhìn chung đặc điểm, yêu 

cầu nổi bật của giáo dục thế kỉ XXI là sử dụng rộng rãi Internet, CNTT trong mọi 

khâu giáo dục, từ nội dung cho đến phương pháp, tổ chức, quản lí. Lí do dễ hiểu là 

vì CNTT đã len lỏi vào mọi hoạt động kinh tế và đời sống trong xã hội hiện đại, 

khiến cho hiểu biết tối thiểu về tin học trở nên cần thiết cho mọi người. Mặt khác, 



máy tính, Internet, viễn thông, truyền thông không dây đã trở thành những công cụ 

có thể hỗ trợ đắc lực trong việc giảng dạy và học tập. Giáo dục thế kỉ XXI không 

chỉ coi trọng tri thức mà còn phải chú ý rèn luyện trí tưởng tượng, làm cơ sở cho tư 

duy, sáng tạo. Thực hiện giáo dục công bằng, dân chủ để bảo đảm cho mọi công 

dân quyền bình đẳng về cơ hội học tập và cơ hội thành đạt trong học vấn. Ngoài ra, 

trong giáo dục thế kỉ XXI cũng yêu cầu mọi người đều cần học tập, học thường 

xuyên, học suốt đời và đòi hỏi sự thay đổi cách quản lí giáo dục. 

1.3. Đổi mới phương pháp dạy học 

1.3.1. Khái niệm phương pháp dạy học  

Theo PGS.TS.Trịnh Văn Biều [4], PPDH là một trong những thành tố quan 

trọng của quá trình dạy học. Cùng một nội dung, học sinh có hứng thú tích cực hay 

không, có hiểu bài một cách sâu sắc hay không, phần lớn phụ thuộc vào PPDH của 

GV. Chính vì PPDH có tầm quan trọng đặc biệt như vậy nên nó luôn được các nhà 

giáo dục quan tâm. 

PPDH là cách thức thực hiện phối hợp, thống nhất giữa người dạy và người 

học, nhằm thực hiện tối ưu các nhiệm vụ dạy học. Đó là sự kết hợp hữu cơ và thống 

nhất biện chứng giữa hoạt động dạy và hoạt động học. PPDH theo nghĩa rộng bao 

gồm phương tiện dạy học, hình thức tổ chức dạy học, PPDH dạy học theo nghĩa 

hẹp. 

1.3.2. Một số xu hướng đổi mới phương pháp dạy học 

Trên thế giới và ở nước ta hiện nay đang có rất nhiều công trình nghiên cứu, 

thử nghiệm về đổi mới PPDH theo các hướng khác nhau. Theo PGS.TS.Trịnh Văn 

Biều [4], một số xu hướng đổi mới cơ bản như sau:  

− Phát huy tính tích cực, tự lực, chủ động, sáng tạo của người học. Chuyển 

trọng tâm hoạt động từ GV sang học sinh. Chuyển lối học từ thông báo tái hiện sang 

tìm tòi khám phá. 

− Phục vụ ngày càng tốt hơn hoạt động tự học và phương châm học suốt đời. 

Không chỉ dạy kiến thức mà còn dạy cách học, trang bị cho học sinh phương pháp 

học tập, phương pháp tự học để thực hiện phương châm học suốt đời. 



− Tăng cường rèn luyện năng lực tư duy, khả năng vận dụng kiến thức vào 

cuộc sống thực tế. Chuyển lối học nặng nề về tiêu hóa kiến thức sang lối học coi 

trọng việc vận dụng kiến thức. 

− Cá thể hóa việc dạy học. Việc dạy học thích ứng với năng lực và điều kiện 

của từng người học ở mức độ từ thấp đến cao. Biện pháp: Chia nhỏ lớp, dạy học 

theo nhóm nhỏ,… 

− Tăng cường sử dụng CNTT trên mạng, sử dụng tối ưu các phương tiện dạy 

học đặc biệt là tin học và CNTT vào dạy học. 

− Từng bước đổi mới kiểm tra đánh giá, giảm việc kiểm tra trí nhớ đơn thuần 

sang khuyến khích việc kiểm tra khả năng suy luận, vận dụng kiến thức, sử dụng 

nhiều loại hình kiểm tra thích hợp với từng môn học. 

− Gắn dạy học với nghiên cứu khoa học với mức độ ngày càng cao. 

1.3.3. Đổi mới phương pháp dạy học với sự hỗ trợ của CNTT 

Với sự phát triển như vũ bão của CNTT, việc phổ biến kiến thức ngày càng 

nhanh chóng thông qua mạng Intertnet, lao động của con người được đơn giản hóa 

và hiệu quả hơn. Do đó, việc dạy và học cũng cần thích ứng và tận dụng những 

thành tựu của công nghệ để đạt được kết quả cao hơn. Hiện nay, hầu như không còn 

tranh cãi về việc có nên hay không nên áp dụng CNTT vào trường học. Mọi người 

đều đồng ý rằng GV, học sinh cần phải được tiếp cận với máy tính, Internet và các 

công nghệ hiện đại khác. Khả năng sử dụng những công nghệ này cũng chính là 

điểm thiết yếu cho việc chuẩn bị nghề nghiệp cho học sinh. 

Mặt khác, để đổi mới PPDH đòi hỏi người thầy không chỉ có bản lĩnh nghề 

nghiệp vững vàng mà còn đòi hỏi người thầy phải làm quen với CNTT và những 

phương tiện dạy học hiện đại. Vì vậy, trong những năm gần đây, người ta đặc biệt 

quan tâm đến việc khai thác một cách hiệu quả nhất máy tính và Internet nhằm nâng 

cao chất lượng giáo dục ở mọi cấp độ, mọi cơ sở đào tạo và mọi hình thức đào tạo. 

Sử dụng CNTT để dạy học, PPDH cũng thay đổi. GV là người hướng dẫn học sinh 

học tập chứ không đơn thuần chỉ là người cung cấp thông tin cho học sinh. GV 

cũng phải học tập thường xuyên để nâng cao trình độ về CNTT, sử dụng có hiệu 



quả CNTT trong giảng dạy và học tập. Học sinh có thể lấy thông tin từ nhiều nguồn 

phong phú khác như sách, Internet, CD-ROM,..Lúc này học sinh phải biết đánh giá 

và lựa chọn thông tin, vì nguồn thông tin vô cùng phong phú. 

Như vậy, chúng ta có thể khẳng định rằng đổi mới PPDH với sự hỗ trợ của 

CNTT là xu thế của thời đại ngày nay. Tuy nhiên, ứng dụng làm sao để khai thác 

hợp lí và hiệu quả của CNTT vào dạy học nói chung và dạy học hóa học nói riêng 

lại cần phải có những nghiên cứu sâu. 

1.4.  Sách điện tử E-Book 

1.4.1. Khái niệm E-Book 

Theo trang web www.thuvien-ebook.com [37] “E-Book là từ viết tắt của 

electronic book (sách điện tử). Hiểu theo cách đơn giản nhất, sách điện tử (ebooks 

hay digital books) là phiên bản dạng số (hay điện tử) của sách. Nội dung của sách 

số có thể lấy từ sách giấy hoặc mang tính độc lập tùy thuộc vào nguồn xuất bản. 

Một số người thường sử dụng thuật ngữ này để chỉ luôn cả thiết bị dùng để đọc sách 

dạng số (còn gọi là book-reading appliances hay ebook readers)”. Giống như e–mail 

(thư điện tử), chỉ có thể dùng các công cụ như máy vi tính, máy trợ giúp kỹ thuật số 

cá nhân (palm, pocket pc…) hay một số loại điện thoại di động thông minh 

(smartphone) để xem E-Book. Một đặc điểm nổi bật của E-Book chính là khả năng 

lưu trữ của nó. 

Một số ví dụ về E-Book: 

− E-Book có thể là một cuốn tiểu thuyết, truyện ngắn, một tác phẩm văn học, 

với nhiều tranh, ảnh,…minh họa. 

− E-Book có thể là một cuốn sổ tay đào tạo nhân sự trong doanh nghiệp. 

− E-Book có thể là một cuốn sách chuyên ngành, sách tự học. 

− E-Book có thể là một CD-CROM đa năng có đầy đủ âm thanh, hình ảnh và 

video clips,… 

Trong khóa luận này, chúng tôi quan niệm E-Book theo hướng như là một 

cuốn sách tham khảo được số hóa, có bổ sung hình ảnh, phim hướng dẫn và khai 

thác các thế mạnh của kỹ thuật đồ họa, khả năng tương tác với người dùng để làm 

http://www.thuvien-ebook.com/


cho giao diện sách thêm phần sinh động, hấp dẫn. Sách chỉ được dùng hiệu quả với 

máy tính điện tử kết hợp với CD-CROM hoặc có thể sao chép và cài thẳng vào máy 

tính. E-Book hoạt động như một website nhưng không trực tuyến.  

1.4.2. Ưu điểm và nhược điểm của E-Book 

 Ưu điểm của E-Book 

− E-Book có được những tính năng ưu việt mà sách in thông thường không có được. 

− Rất gọn, có thể điều chỉnh về cỡ chữ, màu sắc và các thao tác cá nhân hóa tùy theo 

sở thích của người dùng. 

− Nhiều nội dung minh họa hấp dẫn như hình ảnh, âm thanh, phim,…làm tăng hứng 

thú người dùng. E-Book có thể tích hợp thêm một số phần mềm khác. Vì vậy E-

Book thể hiện nội dung kiến thức không phải dưới dạng văn bản khô khan mà 

bằng các thao tác tương tác, giao diện hấp dẫn, phong phú làm cho người đọc thích 

thú khi tiếp cận các thông tin trong E-Book. 

− Khả năng lưu trữ lớn, có thể chứa rất nhiều thông tin, hình ảnh, phim,… 

− Bằng thao tác tương tác cao với người dùng, E-Book cho phép truy xuất đến các 

mục, các phần trong E-Book bất cứ lúc nào mà không cần tra mục lục hay kiếm 

từng trang sách. 

− Việc xuất bản E-Book hiện nay được thực hiện với các phần mềm chuyên dụng 

khác nhau. Sản phẩm E-Book sau khi xuất bản có định dạng tùy theo tác giả hoặc 

kết hợp với các phần mềm hỗ trợ khác để xuất thành phẩm. 

− Cùng với sự phát triển vượt bậc của mạng Internet và kết hợp với các thiết bị kỹ 

thuật cao cấp, hầu hết các sách in giấy thông thường đều có thể làm thành sách 

điện tử. Chính vì vậy, mà ngày nay không khó khăn lắm để chúng ta tìm ra một tác 

phẩm nổi tiếng để đọc trực tiếp trên mạng hay tải về máy tính để xem theo dạng E-

Book. 

 Nhược điểm của E-Book 

− Giống như e-mail (thư điện tử) E-Book chỉ có thể dùng các công cụ như máy vi 

tính, máy trợ giúp kỹ thuật số cá nhân (palm, pocket pc…) để xem. 



− Không giống như sách in thông thường, sách điện tử có những “định dạng” khác 

nhau. Sở dĩ khác nhau vì chúng được làm từ những chương trình khác nhau và vì 

thế, muốn đọc được chúng, chúng ta cần phải có những chương trình tương ứng. 

− Xem E-Book trên máy tính lâu có hại cho mắt. 

1.4.3. Các yêu cầu khi xây dựng E-Book 

Việc xây dựng E-Book phục vụ cho giáo dục đòi hỏi phải đáp ứng những đặc 

điểm riêng về mặt nghe, nhìn, tương tác, do đó theo tác giả Nguyễn Trọng Thọ [21] 

để đáp ứng nhu cầu tự học, chúng ta phải tuân theo đầy đủ các bước của việc thiết 

kế dạy học (ADDIE là chữ viết tắt của 5 bước): 

1. Analysis: Phân tích tình huống để đề ra chiến lược phù hợp: 

− Hiểu rõ mục tiêu. 

− Các tài nguyên có thể có. 

− Đối tượng sử dụng. 

2. Design: Thiết kế nội dung cơ bản: 

− Các chiến lược dạy học. 

− Siêu văn bản (hypertext) và siêu môi trường (hypermedia). 

− Hướng đối tượng, kết nối và phương tiện điều hướng. 

3. Development: Phát triển các quá trình: 

− Thiết kế đồ họa. 

− Phát triển các phương tiện 3D và đa môi trường (multimedia). 

− Hình thức và nội dung. 

− Phương tiện thực tế ảo. 

4. Implementation: Triển khai thực hiện: 

− Cần tích hợp với chương trình CNTT của trường học. 

− Chuẩn bị phù hợp với thực tế các phòng máy tính. 

− Thủ tục tiến hành với thầy. 

− Triển khai trong toàn bộ các đối tượng dạy, học và quản lí. 

− Quản lí tài nguyên (nhân lực và vật lực). 



5. Evaluation: Lượng giá: 

Đánh giá hiệu quả huấn luyện thường sử dụng mô hình 4 bậc do Donald Kirkpatrick 

phát triển (1994). Theo mô hình này, quá trình lượng giá luôn được tiến hành theo 

thứ tự vì thông tin của bậc trước sẽ làm nền cho việc lượng giá ở bậc kế tiếp: 

Bậc 1: Phản ứng tích cực hay tiêu cực (Reaction). 

Bậc 2: Hiệu quả học tập (Learnings). 

Bậc 3: Khả năng chuyển giao hay chuyển đổi (Transfers). 

Bậc 4: Kết quả thực tế (Results). 

Hình 1.1. Mô hình lượng giá bốn bậc theo Kirkpatrick 

1.4.4. Một số phần mềm mã nguồn mở để xây dựng E-Book 

Phần mềm mã nguồn mở là phần mềm với mã nguồn được công bố và sử dụng 

một giấy phép nguồn mở. Giấy phép này cho phép bất kì ai cũng có thể nghiên cứu, 

thay đổi hoặc cải tiến phần mềm. Như vậy có thể hiểu đơn giản, phần mềm mã 

nguồn mở là những phần mềm được phân phối một cách tự do kèm theo mã nguồn 

và người sử dụng được phép sửa đổi những mã nguồn đó theo mục đích cá nhân mà 

không cần hỏi ý kiến tác giả. 

− Một số phần mềm mã nguồn mở dùng để xây dựng E-Book như: 

E-Learning XHTML editor (eXe) là một công cụ xây dựng nội dung được 

thiết kế chạy trên môi trường web, nhờ đó eXe giúp đỡ được GV và các học viên 

trong việc thiết kế, phát triển và xuất bản các tài liệu dạy và học trên web mà không 

cần sự am hiểu hay thành thạo về HTML hay các ứng dụng xuất bản web phức tạp 



khác, sau đó xuất ra dưới dạng các trang web hoặc một gói tuân theo chuẩn 

SCORM hoặc IMS Content Packaging. 

Hầu kết phần mềm thiết kế web theo kĩ thuật truyền thống đều không chú 

trọng vào việc thiết kế riêng cho các nội dung giáo dục. Trong khi đó, eXe nhắm 

đến việc cung cấp một công cụ trực quan, dễ sử dụng cho phép người dùng xuất bản 

thành các trang web chuyên biệt để dạy học. 

Ngoài ra, eXe còn là phần mềm mã nguồn mở, được phát triển bởi Ủy ban 

giáo dục Đại học của Chính phủ NewZeaLand.  

CourseLab 2.4 [25] đã được cung cấp miễn phí tại www.courselab.com từ 

năm 2008, được dùng để tạo bài giảng cho E-Learning, dễ sử dụng. CourseLab tạo 

ra một môi trường lập trình tự do theo kiểu “Thấy gì được nấy” (What You See Is 

What You Get) để tạo ra các nội dung E-Learning tương tác chất lượng cao. Các nội 

dung này có thể xuất bản trên Internet, trên các hệ thống quản lí học tập (Learning 

Management System-LMS), CD-CROM hoặc các thiết bị lưu trữ khác. CourseLab 

được đánh giá là một trong 100 công cụ giáo dục hàng đầu thế giới (Top 100 Tools 

for Learning). Ở các nước Châu Âu và Châu Mỹ, CourseLab được sử dụng nhiều và 

khá nổi tiếng, tuy nhiên ở Châu Á, đặc biệt là Việt Nam nó vẫn còn mới mẻ và chưa 

phổ biến. 

CourseLab đứng đầu công cụ chuyên nghiệp, dễ sử dụng cho soạn giáo trình, 

giáo án, bài kiểm tra (Test) và mô hình mô phỏng, chấm điểm Online /Offline và 

cho phép xuất ra được hầu hết các chuẩn trên web như SCORM, CD/DVD,… 

CourseLab hiện có 2 phiên bản: 

− Phiên bản miễn phí CourseLab 2.4 cung cấp các tính năng cơ bản và nâng 

cao. Tuy nhiên CourseLab 2.4 có 2 chức năng bị giới hạn là “Requires optional 

Screen Capture Pack” (chức năng quay, chụp màn hình và ghi âm) và “Requires 

optional PowerPoint Import Pack” (chức năng xuất dữ liệu từ tập tin PowerPoint). 

− Phiên bản thương mại CourseLab 2.7 cung cấp một số lượng đáng kể các 

tính năng mới làm cho nó trở thành một công cụ mạnh mẽ, ưu việt, linh hoạt và dễ 

sử dụng hơn so với phiên bản CourseLab 2.4 miễn phí. Đây là phiên bản tạo E-



Learning tương thích với các phiên bản mới nhất của các trình duyệt web phổ biến 

Internet Explorer, Google Chrome, Firefox, Opera, Safari. Đặc biệt là tính năng cho 

phép “Import file PowerPoint và Screen Capture” vào CouseLab và xuất ra theo các 

chuẩn trên web. 

Các đặc trưng chủ yếu của phiên bản miễn phí CourseLab: 

− CourseLab cho phép người dùng dễ dàng thiết kế cấu trúc của một mô-đun 

học tập không chỉ có giao diện có sẵn mà còn được hỗ trợ hầu hết các định dạng và 

chức năng như trong phần mềm Microsoft Office PowerPoint 2007 quen thuộc. 

Hỗ trợ Unicode sử dụng bất kỳ phông chữ và mã hóa được hỗ trợ bởi hệ điều hành 

Windows®, bao gồm cả các bộ ký tự double-byte. 

− Giao diện gồm các slide giống như phần mềm Microsoft Office PowerPoint, 

tạo môi trường thiết kế và quản lí nội dung E-Learning cao không cần đòi hỏi có kỹ 

năng về HTML và lập trình. 

− Mô hình hướng đối tượng cho phép tạo ra các nội dung E-Learning ở nhiều 

cấp độ phức tạp bằng cách đơn giản như là tập hợp các khối lắp ghép lại với nhau. 

− Xây dựng các tương tác phức tạp của các đối tượng theo kịch bản chỉ với 

một cái nhấp chuột. 

− Giao diện dựa trên mô hình đối tượng mở (Open Object) cho phép dễ dàng 

mở rộng và nâng cấp các thư viện đối tượng và các khuôn mẫu (Template). 

− Có khả năng tạo ra các bài kiểm tra tích hợp vào nội dung E-Book. 

− Thêm bất kì nội dung đa phương tiện nào (Macromedia® Flash®, Java®, 

Shockwave ®) và đoạn phim dưới các định dạng khác nhau. 

− Trang HTML đầu ra (nội dung E-Learning được phát triển trong CourseLab) 

có thể được mở trong một trình duyệt web mà không cần Java® hoặc bất kỳ phần 

mềm đặc biệt nào khác. 

1.5. Trò chơi dạy học 

1.5.1. Khái niệm, phân loại trò chơi dạy học 

 Trò chơi giáo dục 



“Trò chơi giáo dục được đặc trưng bởi tác dụng cải thiện tri thức, kỹ năng, 

tình cảm, ý chí, kinh nghiệm cá nhân của người tham gia và để thực hiện những 

nhiệm vụ, hành động, luật, quy tắc và yêu cầu của trò chơi thì người tham gia phải 

sử dụng tri thức, kỹ năng, kinh nghiệm, phải huy động tình cảm, ý chí của mình ở 

mức độ nhất định” [11]. 

Như vậy, trò chơi giáo dục có ở cả trong và ngoài nhà trường, trong hay ngoài 

ngành giáo dục. 

 Trò chơi dạy học 

“Những trò chơi giáo dục được lựa chọn và sử dụng trực tiếp để dạy học, tuân 

theo mục đích, nội dung, các nguyên tắc và PPDH, có chức năng tổ chức, hướng 

dẫn và động viên trẻ hay học sinh tìm kiếm và lĩnh hội tri thức, học tập và rèn luyện 

kỹ năng, tích lũy và phát triển các phương thức hoạt động và hành vi ứng xử xã hội, 

văn hóa, đạo đức, thẩm mỹ, pháp luật, khoa học, ngôn ngữ, cải thiện và phát triển 

thể chất, tức là tổ chức và hướng dẫn quá trình học tập của học sinh khi họ tham gia 

trò chơi, gọi là trò chơi dạy học. Các nhiệm vụ, quy tắc, luật chơi và các quan hệ 

trong trò chơi dạy học được tổ chức tương đối chặt chẽ trong khuôn khổ các nhiệm 

vụ dạy học và được định hướng vào mục tiêu, nội dung dạy học [11]. 

Các trò chơi học tập có thể lấy từ các trò chơi trong thực tế. Đối với loại trò 

chơi này, GV chỉ cần “ủy thác” nội dung dạy học vào nội dung của trò chơi. Ngoài 

ra do yêu cầu đa dạng của việc học tập, GV cũng có thể tạo ra những trò chơi mới. 

 Các loại trò chơi dạy học 

Theo Đặng Thành Hưng [11], căn cứ vào chức năng có thể chia trò chơi dạy 

học thành 3 nhóm: 

Trò chơi phát triển nhận thức: Nhằm mục đích cải thiện và phát triển các khả năng 

nhận thức, quá trình và kết quả nhận thức của người học. Trò chơi phát triển nhận 

thức lại được phân thành một số nhóm nhỏ: 

− Các trò chơi phát triển cảm giác và tri giác. 

− Các trò chơi phát triển và rèn luyện trí nhớ. 

− Các trò chơi phát triển tưởng tượng và tư duy. 



Trò chơi phát triển giá trị: Định hướng vào việc kích thích, khai thác thái độ, tình 

cảm tích cực, động viên ý chí và nhu cầu xã hội, khuyến khích sự phát triển các 

phẩm chất cá nhân của người tham gia. 

− Các trò chơi phân vai, đóng kịch theo chủ đề. 

− Các trò chơi dân gian. 

− Một số trò chơi đòi hỏi khả năng đánh giá sự vật hay hành vi, hành động, 

tính cách con người,… 

Trò chơi phát triển vận động 

Cách phân loại trên chỉ mang tính tương đối, dựa vào chức năng phát triển chủ 

yếu mà trò chơi đó hướng tới vì có nhiều trò chơi đồng thời phát triển nhiều chức 

năng cùng một lúc. 

Dựa vào hình thức tổ chức có thể chia trò chơi ra thành nhiều dạng. Sau đây 

là một số dạng trò chơi dạy học phổ biến và dễ áp dụng: 

Các dạng trò chơi tranh tài: Các nhóm cùng thực hiện một chủ đề nhất định nhưng 

có sự thi đua về thời gian hoặc chất lượng kết quả. 

Các trò chơi đố vui: Đó là một biến thể của trò chơi tranh tài, lúc này nội dung học 

tập được “ủy thác” vào trò chơi dưới dạng các câu hỏi nhỏ mà GV đặt ra hay các 

đội chơi đặt cho nhau. 

Các trò chơi thách đố: Loại trò chơi này thường đặt người chơi vào trạng thái suy 

nghĩ và hành động khẩn trương, căng thẳng trí tuệ vì thách đố là những thử thách có 

phần vượt quá khả năng thông thường của người học. Đây cũng chính là yếu tố kích 

thích học sinh tham gia. 

Đối với học sinh phổ thông thì lại cần thiết phải chia các trò chơi dạy học theo 

các lĩnh vực học tập. Trong đó có các lĩnh vực đáng chú ý như sau: 

− Các trò chơi khoa học: Trò chơi Vật lí, trò chơi Hóa học, trò chơi Sinh 

học,… 

− Các trò chơi Ngôn ngữ: Phản ánh nội dung học tập trong các môn Văn học, 

Ngoại ngữ,… 

− Các trò chơi nghệ thuật: Theo các môn Nhạc, Họa,… 



− Các trò chơi Thể dục - vận động. 

− Các trò chơi Xã hội: Phản ánh nội dung giáo dục công dân, các sinh hoạt 

trong Đoàn, Hội, Câu lạc bộ. 

− Các trò chơi Kỹ thuật. 

1.5.2. Các chức năng dạy học của trò chơi 

− Phối hợp thể chất từ đơn giản đến phức tạp 

− Sự khéo léo thể chất đơn giản 

− Rèn luyện trí nhớ 

− Rèn luyện tính sáng tạo 

− Rèn luyện tính linh hoạt trong vận dụng kiến thức để giải quyết các nhiệm vụ 

được giao. 

− Học những kĩ năng phán đoán 

− Học những kĩ năng “đánh lừa” 

− Học kĩ năng hợp tác 

− Học và rèn luyện các hành động theo các qui luật 

− Học cách làm chủ thái độ đối với thành công và thất bại 

− Cải thiện nhận thức về tính thân thiện 

− Rèn luyện sự tự tin, sự mạnh dạn đối mặt với thử thách. 

1.5.3. Ý nghĩa của trò chơi dạy học 

Trò chơi dạy học là kĩ thuật, hoạt động bổ trợ trong quá trình dạy học. Hoạt 

động này thiên về phần chơi, trong lúc chơi con người dường như quên đi mọi nỗi 

ưu tư, phiền muộn. Chính vì vậy mà trò chơi dạy học giúp xua đi nỗi lo âu nặng nề 

của việc học cho học sinh, giúp gắn kết tình cảm giữa GV và học sinh trong lúc 

chơi. 

Trong lúc chơi tinh thần của học sinh thường rất thoải mái nên khả năng tiếp 

thu kiến thức trong lúc chơi sẽ tốt hơn hoặc sau khi chơi cũng sẽ tốt hơn. 

Trò chơi dạy học cũng có thể hình thành nên cho học sinh những kỹ năng của 

môn học, học sinh không chỉ có cơ hội tìm hiểu kiến thức, ôn tập lại các kiến thức 

đã biết mà còn có thể có được kinh nghiệm, hành vi. 



Một số trò chơi dạy học còn giúp cho học sinh có khả năng tư duy cách giải 

quyết vấn đề nhanh không chỉ trong lĩnh vực chơi mà cả ở lĩnh vực của cuộc sống. 

Một số trò chơi có thể giúp cho học sinh có khả năng quyết định các phương 

án đúng, cách giải quyết các tình huống một cách hợp lí. 

Trò chơi dạy học cũng có thể là biện pháp mà GV tạo ra sự thi đua giữa các cá 

nhân học sinh hoặc giữa các nhóm học sinh. Khi tổ chức cho học sinh chơi theo 

nhóm còn tạo sự gắn kết cho học sinh và tăng tinh thần đoàn kết cho học sinh. 

1.5.4. Ưu điểm và hạn chế của phương pháp dạy học bằng trò chơi 

 Ưu điểm 

− Nhiệm vụ học tập được chuyển giao một cách tự nhiên cho học sinh. 

− Học sinh trở thành người tham gia tích cực chứ không phải là người quan sát 

thụ động trong quá trình học. 

− Yếu tố cảm xúc, trí tuệ tình cảm thể hiện rõ, mạnh, có lợi cho việc củng cố 

kiến thức cho học sinh. 

− Quá trình lĩnh hội kiến thức của học sinh trở nên nhẹ nhàng, thoải mái, bớt 

căng thẳng hơn. 

− Học sinh hứng thú hơn trong hoạt động thi đua kiến thức với bạn bè. 

− Rèn luyện các kĩ năng hoạt động, tư duy cho học sinh. 

 Hạn chế 

− Dễ làm phương hại đến tính hệ thống của các nội dung dạy học đã được qui 

định trong chương trình. 

− Tốn thời gian. 

− Đối với những trò chơi có sự vận động thì sẽ khó tổ chức trong những lớp 

học bố trí theo kiểu truyền thống. 

− Đòi hỏi GV phải mất nhiều công sức sáng tạo, thiết kế và tổ chức các hoạt 

động của trò chơi dạy học phù hợp với nội dung của bài học mà vẫn đảm bảo kiến 

thức cần nắm cho học sinh. 

− Tốn kém hơn do phải chuẩn bị các đồ dùng cho trò chơi dạy học. 

1.5.5. Những lưu ý khi tổ chức trò chơi dạy học  



1) Xác định rõ mục tiêu dạy học - giáo dục của trò chơi. Nếu không, trò chơi chỉ là 

một công cụ để “giết thời gian”. 

2) Trò chơi cần có quan hệ chặt chẽ với nội dung học tập. 

3) Chỉ lựa chọn những yếu tố, vấn đề quan trọng, cần thiết và thích hợp với 

phương thức chơi để đưa vào trò chơi với phán đoán rằng trò chơi mang lại hiệu 

quả cao hơn so với giờ học căn bản. 

4) Chọn trò chơi phù hợp với kinh nghiệm học tập của học sinh. 

5) Tùy mức độ nhận thức và mức độ kỹ năng cần hình thành mà chọn loại trò chơi 

và độ khó của trò chơi khác nhau. 

6) Trong trò chơi vai trò và nhiệm vụ của học sinh phải được xác định rõ ràng. 

7) Mọi trò chơi đều phải có luật chơi. Luật chơi là những quy định mà tất cả người 

chơi đều phải tự giác chấp hành. Những quy định ấy nếu được thực hiện 

nghiêm túc sẽ đảm bảo cuộc chơi đoàn kết, vui vẻ, an toàn, công bằng, khách 

quan. Luật chơi và quy tắc chơi cần dễ hiểu, tự nhiên, tránh gò bó và được học 

sinh hiểu rõ, chấp nhận trước khi tiến hành trò chơi. 

8) Trò chơi dạy học theo đúng nghĩa của nó phải là một tình huống học tập có tính 

tự giác cao nên phải tránh trường hợp người chơi bị cưỡng bức tham gia. 

9) Bất kì trò chơi nào cũng cần phải có động lực kích thích, thúc đẩy người chơi. 

Động lực của trò chơi dạy học có thể nằm trong chính nội dung chơi hoặc có 

thể nằm ngoài trò chơi (trò chơi có thưởng). Yếu tố củng cố (phần thưởng, điểm 

thưởng) trong trò chơi dạy học cũng phải được coi là quan trọng. 

10)  Cần có sự thảo luận, tổng kết sau khi chơi ở 2 điều: Nội dung và mục tiêu học 

tập đạt được đến đâu, học sinh học được cái gì bổ ích theo yêu cầu dạy học và 

ngoài yêu cầu dạy học; nhận xét hiệu quả hoạt động của các nhóm, rút kinh 

nghiệm về tổ chức. Tất cả những điều trên phải được ghi vào vở hoặc gạch vào 

tài liệu học tập. 

11)  Thảo luận sau trò chơi cần kết hợp với giao bài tập hay nhiệm vụ về nhà. 



12)   GV cần chuẩn bị chu đáo về mọi mặt, từ dụng cụ đến cách diễn đạt luật chơi, 

hướng dẫn và điều chỉnh quá trình chơi, dự đoán các thắc mắc của học sinh để 

có khả năng giải đáp,… 

13)   GV cần yêu cầu, dặn dò học sinh chuẩn bị trước bài ở nhà để tham gia vào trò 

chơi dạy học đảm bảo hiệu quả của trò chơi và học sinh nắm được kiến thức. 

 Một số biện pháp khắc phục 

− Để khắc phục các hạn chế trên, GV cần thực hiện tốt 13 lưu ý khi áp dụng 

các trò chơi dạy học trong giảng dạy. 

− Sử dụng tối đa các phương tiện kĩ thuật hiện đại, ứng dụng CNTT trong việc 

thiết kế các trò chơi dạy học giúp tiết kiệm thời gian phổ biến luật chơi, thiết kế 

các đồ dùng dạy học. Hiệu quả của trò chơi được nâng cao hơn do được thiết kế có 

kèm theo các hiệu ứng hoạt hình, âm thanh, hình ảnh, phim thí nghiệm,…làm tăng 

tính hấp dẫn của trò chơi. 

− Trò chơi học tập phải có tên gọi, luật chơi rõ ràng. Tên gọi của trò chơi hàm 

chứa mục đích và gợi sự hứng thú, tò mò muốn khám phá của học sinh trong trò 

chơi. Luật chơi (hình thức tổ chức) cần rõ ràng, dễ thực hiện. GV không nên chú 

trọng vào việc tạo nhiều hiệu ứng khi thiết kế trò chơi mà chỉ nên thiết kế đơn giản 

nhưng thu hút, hấp dẫn. 

− Phải căn cứ vào đặc điểm tình hình lớp, trình độ học sinh để GV lựa chọn, 

thiết kế và tổ chức trò chơi dạy học một cách dễ dàng. 

1.6. Ứng dụng CNTT trong dạy học hóa học 

Với sự bùng nổ của CNTT hiện nay, việc ứng dụng rộng rãi đa phương tiện 

(Multimedia) vào quá trình dạy học là xu hướng tất yếu của các trường học trên thế 

giới và ở Việt Nam nói riêng. Việc ứng dụng CNTT vào dạy học sẽ nâng cao tính 

tích cực tự lực nhận thức của học sinh vì khi “thầy dạy bằng đa phương tiện, trò học 

bằng đa giác quan” thì vai trò của người thầy lúc này chỉ giữ chức năng định hướng, 

tư vấn còn người học tùy vào năng lực, điều kiện và nhu cầu của bản thân để chiếm 

lĩnh kiến thức mới, đạt được mục đích mình mong muốn. 



Akbert Einstein đã nói “Nghệ thuật cao cả của người thầy là khơi dậy niềm vui 

trong sự diễn tả và nhận thức sáng tạo”. 

Vì vậy để ứng dụng CNTT trong dạy học một cách có hiệu quả thì cần phải 

xây dựng các phần mềm dạy học, khai thác sử dụng các phần mềm công cụ đa 

phương tiện khác nhau như Microsoft Office PowerPoint 2007, PhotoShop, 

ProShow Gold, Hot Potatoes 6, Adobe Flash,…để thiết kế các trò chơi hỗ trợ và gây 

hứng thú nhận thức cho học sinh. Một số tầm quan trọng của việc ứng dụng CNTT 

vào dạy học hóa học: 

− Sự nghiệp giáo dục nước ta cần bắt kịp xu thế đổi mới PPDH trên thế giới, 

nhằm nâng cao chất lượng dạy và học. Ứng dụng CNTT trong dạy học hóa học là 

một trong những nội dung quan trọng của xu thế tất yếu đó. 

− Công cuộc công nghiệp hóa, hiện đại hóa đất nước cũng như thời đại thông 

tin, nhân loại đang quá độ sang nền kinh tế tri thức mà đặc điểm của nó là sự bùng 

nổ thông tin, tri thức đòi hỏi có những con người năng động, sáng tạo. Sử dụng 

CNTT là một trong những bước đào tạo ra những con người đáp ứng yêu cầu của 

thời đại mới. 

− Ứng dụng CNTT trong giảng dạy hóa học giữ một vị trí vô cùng quan trọng 

để đổi mới phương pháp dạy của thầy, buộc người GV phải không ngừng nỗ lực 

học tập và tìm hiểu để nâng cao tri thức để có thể chủ động trong quá trình giảng 

dạy. Một thực tế hiện nay cho thấy học sinh rất năng động, sáng tạo, thông minh và 

rất thích tò mò tìm hiểu về CNTT. 

Đối với môn hóa học, việc ứng dụng CNTT trong giảng dạy sẽ tạo ra một bước 

chuyển cơ bản trong quá trình đổi mới nội dung PPDH. Cụ thể là: 

− CNTT là một công cụ đắc lực hỗ trợ cho việc xây dựng các kiến thức mới. 

− CNTT tạo môi trường để khám phá kiến thức nhằm hỗ trợ cho quá trình học 

tập. 

− CNTT tạo môi trường để hỗ trợ học tập qua thực hành, qua cộng đồng, qua 

phản ánh. 



− CNTT giúp cho việc đánh giá định tính và định lượng dạy học hóa học chính 

xác hơn. 

− GV chuẩn bị bài dạy một lần thì sử dụng được nhiều lần vì chỉ cần bổ sung, 

thay đổi những kiến thức mới. 

− Các phương tiện hiện đại sẽ tạo ra khả năng để GV trình bày nội dung kiến 

thức một cách sinh động hơn, hấp dẫn hơn. 

− Giúp GV tiết kiệm được thời gian trên lớp trong mỗi tiết học, giúp GV điều 

khiển được hoạt động nhận thức của học sinh, kiểm tra, đánh giá kết quả học tập 

của các em được thuận lợi và cho hiệu suất cao hơn. 

− Đặc biệt nếu áp dụng hình thức đào tạo điện tử (E-Learning) sẽ đáp ứng 

được mọi tiêu chí: Hình thức đào tạo đa dạng, học mọi nơi, học mọi lúc, học mọi 

thứ và học mềm dẻo, học một cách mở, học suốt đời và tiết kiệm chi phí cho cả 

người dạy lẫn người học. Bởi đặc điểm của E-Learning là có hệ thống giảng bài và 

có tài liệu học tập được giới thiệu dưới dạng số hóa, được đặc trưng bởi tính đa và 

siêu phương tiện, có sự tương tác qua lại giữa người học, hệ thống dạy và người 

dạy. 

− Giải phóng người thầy khỏi một lượng lớn các công việc tay chân do đó làm 

tăng khả năng nâng cao chất lượng dạy học. 

1.7.  Thực trạng ứng dụng CNTT để thiết kế trò chơi trong dạy học hóa học 

của SV sư phạm khoa Hóa trường ĐHSP TP.Hồ Chí Minh, GV ở các trường 

trung học phổ thông hiện nay 

Mục đích :  

Nhằm nắm được thực trạng ứng dụng CNTT trong dạy học hóa học và kỹ 

năng sử dụng CNTT để thiết kế trò chơi trong dạy học của SV sư phạm khoa Hóa 

trường ĐHSP TP.Hồ Chí Minh và GV ở các trường trung học phổ thông (THPT) 

trong giai đoạn hiện nay, chúng tôi có thực hiện phần điều tra từ tháng 10/2012 đến 

tháng 4/2013 đối với các SV thuộc các khối lớp sư phạm năm 3, 4 và GV ở các 

trường trên địa bàn TP.Hồ Chí Minh như: THPT Trần Khai Nguyên, THPT Nguyễn 

Hữu Thọ, THPT Mạc Đĩnh Chi, THPT Trưng Vương. 



Trong phạm vi nghiên cứu, chúng tôi chỉ khảo sát SV năm 3, 4 sắp chuẩn bị 

thực tập sư phạm đợt 1 và đợt 2. 

− Số lượng SV sư phạm tham gia cuộc khảo sát như sau: 

SV năm thứ 3: 70 SV 

SV năm thứ 4: 69 SV 

− Số lượng GV tham gia cuộc khảo sát là 25 

Cách tiến hành: 

Đối với SV sư phạm khoa Hóa trường ĐHSP TP.Hồ Chí Minh: Gởi phiếu điều 

tra đến 139 SV với trình độ khác nhau. 

Đối với GV ở trường THPT: Gửi phiếu điều tra đến 25 thầy (cô) với thâm niên 

giảng dạy khác nhau. Chúng tôi đã thống kê được một số kết quả rất thú vị, phản 

ánh trung thực tình hình ứng dụng CNTT để thiết kế trò chơi trong dạy học hóa học 

như sau: 

Tình hình chung: 

Trong cuộc khảo sát, đa số các SV có trình độ tin học đại cương từ loại trung 

bình khá trở lên (hình 1.2) và có 89,21% SV có máy tính để bàn hoặc laptop (máy 

tính xách tay), trung bình có khoảng 79,86% SV mỗi ngày dành ra khoảng trên 1 

tiếng đồng hồ để sử dụng máy tính. Nhìn chung, đa phần SV sư phạm Hóa hiện nay 

được trang bị máy tính và có điều kiện, thời gian tiếp cận với công nghệ tương đối 

thuận lợi. Phần lớn, SV sử dụng máy tính vào các mục đích khác nhau như: giải trí, 

tìm kiếm thông tin, thiết kế bài giảng, thiết kế các trò chơi, làm tiểu luận, làm bài 

tập, làm việc nhóm, lập trình,… 

Sau đây là kết quả điều tra cụ thể: 

 Đối với SV 

Câu 1: Trong học phần tin học đại cương, thành tích bạn đạt được là 



 
Hình 1.2. Biểu đồ về thành tích của SV trong học phần tin học đại cương 

Qua biểu đồ chúng ta thấy, đa số SV hiện nay đều có trình độ tin học căn bản từ 

mức khá trở nên. Cho nên, SV đã có sự quan tâm, đầu tư kiến thức về tin học cho 

bản thân. 

Câu 2: Bạn thường sử dụng máy tính vào mục đích gì? (bạn có thể chọn nhiều ý). 

Bảng 1.1. Kết quả điều tra mục đích sử dụng máy tính của SV 

 Tổng số SV Tỉ lệ 

Giải trí 121 87,05% 

Tìm kiếm thông tin 115 82,73% 

Thiết kế bài giảng 60 43,17% 

Thiết kế các trò chơi 13 9,35% 

Làm tiểu luận, làm bài tập, làm việc nhóm 97 69,78% 

Nhìn chung SV thường sử dụng máy tính vào các mục đích như giải trí, tìm 

kiếm thông tin cần thiết hoặc làm tiểu luận, bài tập, thảo luận nhóm. Có khoảng 

60/139 SV (43,17%) sử dụng máy tính để thiết kế bài giảng và có rất ít SV quan 

tâm đến việc thiết kế các trò chơi chỉ 13/139 SV (9,35%). 

Câu 3: Trong đợt thực tập sư phạm lần 1, bạn có ứng dụng CNTT trong dạy học 

hóa học không?. 

Câu 4: Trong đợt thực tập sư phạm lần 1, bạn có thiết kế trò chơi nào mà có ứng 

dụng CNTT để tổ chức chơi trên lớp không?. 

24.46% 

33.81% 
26.62% 

13.67% 

1.44% 
Từ 9.0 trở lên 
Từ 8.0 đến dưới 9.0 
Từ 7.0 đến dưới 8.0 
Từ 5.9 đến dưới 7.0 
Dưới 5.9 



Với 2 câu hỏi này, chúng tôi khảo sát đối với 69 SV sư phạm năm thứ 4 sau 

khi trải qua kì thực tập sư phạm đợt 1. Kết quả chúng tôi nhận được có 44 SV 

(63,77%) có ứng dụng CNTT trong dạy học hóa học và trong đó chỉ có 13 SV 

(29,55%) có ứng dụng CNTT để thiết kế trò chơi tổ chức chơi ở trên lớp. Qua đó, 

cho thấy việc thiết kế trò chơi có ứng dụng CNTT trong dạy học còn chưa được chú 

trọng. Vậy nguyên nhân có thể là do đâu?. 

Theo kết quả điều tra, khi khảo sát 139 SV sư phạm Hóa năm thứ 3, 4 với câu 

hỏi “Theo bạn, việc SV, GV ngại thiết kế các trò chơi hóa học có ứng dụng CNTT 

là do đâu? (bạn có thể chọn nhiều ý)”, chúng tôi đã thu được kết quả: 

Bảng 1.2. Kết quả điều tra nguyên nhân SV ngại thiết kế các trò chơi hóa học có 

ứng dụng CNTT 

 Tổng số Tỉ lệ  

Không có thời gian 78 56,12% 

Không biết dùng phần mềm nào để thiết kế 79 56,83% 

Không biết thiết kế do kỹ năng CNTT còn kém 101 72,66% 

Ý kiến khác: Không biết thiết kế, không có phần mềm và 

không được hướng dẫn chi tiết. 

2 1,44% 

Theo những số liệu đó, ta thấy hầu hết SV đều nhận thấy rằng SV, GV không 

biết thiết kế trò chơi có sử dụng CNTT do kỹ năng CNTT còn kém và nếu có muốn 

thì cũng không biết dùng phần mềm nào để thiết kế, thiết kế như thế nào cũng như 

chưa có sự đầu tư về mặt thời gian cho công việc này (bảng 1.2). 

Với câu hỏi, “Bạn đã bao giờ ứng dụng CNTT để thiết kế các trò chơi không?” 

thì có 57/139 SV (41%) trả lời là có ứng dụng CNTT để thiết kế các trò chơi, trong 

đó có 77,19% ý kiến dùng để phục vụ cho hoạt động giáo dục ngoài giờ lên lớp và 

63,16% cho các bài tiểu luận, thuyết trình còn sử dụng trong dạy học hóa học thì 

còn thấp chỉ 26,32%. 

Khi SV được hỏi “Trong số các phần mềm sau đây, bạn biết sử dụng phần 

mềm nào? (bạn có thể chọn nhiều ý)” thì có 124/139 SV (89,21%) trả lời là biết sử 



dụng phần mềm Microsoft Office PowerPoint 2007; 57,55% SV biết sử dụng phần 

mềm Microsoft Office Word 2007; 8,63% SV biết sử dụng phần mềm Hot Potatoes 

6; 12,23% SV biết sử dụng phần mềm ProShow Gold. 

Câu 8: Kỹ năng sử dụng các phần mềm sau của bạn ở mức độ nào? (mức độ 0 là 

hoàn toàn không biết; 1 là cơ bản; 2 là thành thạo). 

Bảng 1.3. Kết quả điều tra kỹ năng sử dụng một số phần mềm của SV 

Phần mềm 
Mức độ Trung bình 

(TB) 0 1 2 

Microsoft Office PowerPoint 2007 4 101 34 1,22 

Microsoft Office Word 2007 2 92 45 1,31 

Hot Potatoes 6 116 19 4 0,19 

Proshow Gold 102 26 11 0,35 

Từ bảng số liệu thống kê cho thấy, đa số SV đều sử dụng được phần mềm 

Microsoft Office PowerPoint 2007 và Microsoft Office Word 2007 ở mức độ cơ 

bản trở lên. Tuy nhiên, đối với các phần mềm còn lại thì kỹ năng sử dụng của SV 

đều ở dưới mức cơ bản. Mặt khác, tỉ lệ SV có thể thiết kế trò chơi bằng các phần 

mềm đó thì còn thấp, cụ thể: 

Bảng 1.4. Kết quả điều tra tỉ lệ SV có thể thiết kế trò chơi bằng các phần mềm 

Phần mềm Tổng số Tỉ lệ 

Microsoft Office PowerPoint 2007 57 41% 

Microsoft Office Word 2007 35 25,18% 

Hot Potatoes 6 13 9,35% 

ProShow Gold 14 10,07% 

Tổng cộng 139 SV  

Với câu hỏi “Bạn thường gặp khó khăn gì khi học cách sử dụng một phần 

mềm mới? (có thể chọn nhiều ý)”. 



Bảng 1.5. Kết quả điều tra khó khăn mà SV gặp khi học cách sử dụng một phần 

mềm mới 

Nội dung Tổng số Tỉ lệ 

Tìm kiếm tài liệu 38 27,34% 

Không có hướng dẫn chi tiết 88 63,31% 

Hạn chế về ngoại ngữ 74 53,24% 

Hướng dẫn khó hiểu 50 35,97% 

Ý kiến khác: Thiếu kỹ năng 1 0,72% 

Đa số SV đều cho rằng khó khăn lớn nhất khi học cách sử dụng một phần 

mềm mới là do không có hướng dẫn chi tiết cách sử dụng (63,31%); hạn chế về 

ngoại ngữ (53,24%) và nếu có hướng dẫn thì cũng khó hiểu chiếm tỉ lệ 35,97%. 

Mặt khác, theo kết quả cuộc khảo sát hiện nay chỉ có 14 SV (10,07%) đã từng 

sử dụng E-Book hỗ trợ rèn kỹ năng thiết kế trò chơi trong quá trình học tập của 

mình ở khoa Hóa trường ĐHSP TP. Hồ Chí Minh. Vì thế, các bạn SV phần đông 

đều muốn có một E-Book hỗ trợ ứng dụng CNTT để thiết kế trò chơi trong dạy học 

hóa học sau này của mình.  

Sau đây là một số ý kiến của SV về vấn đề ứng dụng CNTT để thiết kế trò 

chơi và sử dụng trò chơi trong dạy học hóa học hiện nay: Nhiều SV cho rằng việc 

ứng dụng CNTT để thiết kế trò chơi và sử dụng trò chơi trong dạy học hóa học là 

rất cần thiết vì  

− Đó là ứng dụng của thời đại. 

− Giúp cho việc giảng dạy sẽ sinh động hơn vì vừa học vừa chơi, tăng hứng thú 

nhận thức, học sinh tiếp thu bài dễ hơn. 

− Ngoài việc học thì học sinh và SV cũng cần phải giải trí, mà nếu là trò chơi liên 

quan đến hóa học thì càng tốt vì học sinh, SV vừa giải trí, vừa củng cố lại kiến 

thức và vừa biết thêm kiến thức mới. 

− Nâng cao khả năng sử dụng CNTT trong hóa học của GV và giúp học sinh tiếp 

cận với CNTT. 



− Giúp ta thiết kế trò chơi một cách nhanh chóng, ít tốn thời gian, đẹp mắt,… 

 
Hình 1.3. Biểu đồ về mức độ mong muốn được sử dụng E-Book ứng dụng CNTT để 

thiết kế trò chơi trong dạy học hóa học của SV 

Sau đây là một số ý kiến của SV về mức độ cần thiết của việc ứng dụng CNTT 

để thiết kế trò chơi và sử dụng trò chơi trong dạy học hóa học hiện nay: 
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 Đối với GV 

Để biết thêm về thực trạng ứng dụng CNTT để thiết kế trò chơi trong dạy học 

hóa học ở các trường THPT, chúng tôi cũng thực hiện khảo sát trên đối tượng là GV 

ở các trường THPT, kết quả điều tra như sau: 

Về mức độ thường xuyên ứng dụng CNTT trong giảng dạy, có 1/25GV (4%) 

không sử dụng, 15/25 GV (60% ) thỉnh thoảng sử dụng, 2/25 GV (8%) sử dụng rất 

thường xuyên và còn lại 7/25 GV (28%) GV thường xuyên sử dụng. 

Về mục đích ứng dụng CNTT trong dạy học hóa học, 100% GV dùng để thiết 

kế bài giảng điện tử, 24% GV dùng để thiết kế trò chơi và 36% GV thiết kế mô 

phỏng thí nghiệm. 

Về kỹ năng sử dụng các phần mềm của thầy (cô): (Mức độ từ 0 là hoàn toàn 

không biết; 1 là cơ bản; 2 là thành thạo). 

Bảng 1.6. Kết quả điều tra kỹ năng sử dụng một số phần mềm của GV 

Phần mềm 
Mức độ TB 

0 1 2 

Microsoft Office PowerPoint 2007 2 18 7 1,28 

Microsoft Office Word 2007 1 12 9 1,3 

Hot Potatoes 6 17 6 3 0,48 

ProShow Gold 19 4 2 0,32 

Khi được hỏi “Thầy (cô) có thể thiết kế được trò chơi sử dụng trong dạy học hóa 

học bằng phần mềm nào trong các phần mềm dưới đây?”, kết quả thu được: 

Bảng 1.7. Kết quả điều tra tỉ lệ GV có thể thiết kế trò chơi bằng các phần mềm 

Phần mềm Tổng số GV Tỉ lệ  

Microsoft Office PowerPoint 2007 15 60% 

Microsoft Office Word 2007 7 28% 

Hot Potatoes 6 5 20% 

ProShow Gold 2 8% 



Qua bảng số liệu thống kê cho thấy, đa số thầy (cô) đều sử dụng phần mềm 

Microsoft Office PowerPoint 2007 và Microsoft Office Word 2007 ở mức độ cơ 

bản, vì nó rất quen thuộc đối với hoạt động dạy học của GV. Đối với các phần mềm 

còn lại, kỹ năng sử dụng của GV đều ở dưới mức độ cơ bản (bảng 1.6). Và tỉ lệ GV 

có thể thiết kế được trò chơi bằng các phần mềm đó cũng ở tỉ lệ khá khiêm tốn 

(bảng 1.7). 

Khi được hỏi “Theo thầy (cô), việc GV phổ thông hiện nay ngại thiết kế các 

trò chơi hóa học có ứng dụng CNTT trong dạy học hóa học là do đâu? (thầy (cô) có 

thể chọn nhiều ý)” thì  

Bảng 1.8. Kết quả điều tra khó khăn mà GV gặp khi học cách sử dụng một phần 

mềm mới 

Ý kiến Số lượng GV Tỉ lệ  

Không có thời gian 21 84% 

Không biết dùng phần mềm nào để thiết kế 15 60% 

Không biết thiết kế do kỹ năng CNTT còn kém 19 76% 

Ý kiến khác: GV chưa có ý tưởng phù hợp, tài liệu 

tham khảo, không có hiệu quả với mục đích dạy để thi 

2 8% 

Kết quả khảo sát cho thấy 84% GV đánh giá là không có thời gian, 60% GV 

không biết dùng phần mềm nào để thiết kế, 76% GV không biết thiết kế do kỹ năng 

CNTT còn kém và có 4% GV chưa có ý tưởng phù hợp, chưa có tài liệu tham khảo, 

4% GV cho là không có hiệu quả với mục đích dạy để thi cử. 

Với câu hỏi “Thầy (cô) đã từng sử dụng trò chơi có ứng dụng CNTT trong dạy 

học hóa học ở trường THPT chưa?”, kết quả ở biểu đồ sau: 



 
Hình 1.4. Biểu đồ tỉ lệ GV sử dụng trò chơi có ứng dụng CNTT trong dạy học hóa 

học ở trường THPT 

Qua biểu đồ, ta thấy có 84% đã từng sử dụng trò chơi có ứng dụng CNTT 

trong dạy học hóa học ở trường THPT. Từ đó cho thấy, GV cũng rất quan tâm đến 

hoạt động dạy học thông qua việc thiết kế các trò chơi có ứng dụng CNTT. Trong 

đó, có 68% GV trả lời thường áp dụng các trò chơi khi dạy các bài luyện tập, 84% 

khi dạy hoạt động củng cố kiến thức (bảng 1.10). 

Bảng 1.9. Kết quả điều tra những bài hoặc hoạt động mà GV có thể áp dụng trò 

chơi dạy học hóa học 

 Số lượng GV Tỉ lệ  

Dạy bài mới 7 28% 

Luyện tập 17 68% 

Củng cố kiến thức 21 84% 

Mở đầu bài giảng 11 44% 

Ý kiến khác: 0 0% 

Câu 4: Theo thầy (cô) việc ứng dụng CNTT để thiết kế trò chơi và sử dụng trò chơi 

trong dạy học hóa học hiện nay có cần thiết không? Vì sao?. 

Với câu hỏi này, 100% GV trả lời là cần thiết và một số GV cũng chia sẻ ý 

kiến về tầm quan trọng của việc ứng dụng CNTT để thiết kế trò chơi và sử dụng trò 

chơi trong dạy học hóa học ở phổ thông hiện nay: 

84% 

16% 

Có 
Không 



 

 

 

 

 
Việc sử dụng CNTT trong giáo dục đã được chú trọng, quá trình kỹ thuật hóa 

hoạt động giảng dạy trong nhà trường đã diễn ra và có những kết quả đáng chú ý. Ở 

khoa Hóa trường ĐHSP TP. Hồ Chí Minh, mặc dù đã có nhiều đề tài nghiên cứu 

xây dựng và phát triển các website, E-Book hỗ trợ việc tự học cho học sinh THPT, 

nhưng đề tài để phát triển sản phẩm nhằm hỗ trợ GV, SV sư phạm ứng dụng CNTT 

để thiết kế trò chơi trong dạy học hóa học hiện nay còn chưa rộng. Bên cạnh đó, 

GV, SV sư phạm sử dụng nhiều công cụ hỗ trợ cho quá trình dạy học hóa học 

nhưng vẫn chưa khai thác hết các tiềm năng của CNTT như ứng dụng CNTT để 

thiết kế các trò chơi hóa học. 

Tóm lại, từ các số liệu khảo sát có thể kết luận rằng hầu hết SV đều có điều 

kiện và mong muốn có được một sản phẩm nhằm phục vụ, hỗ trợ rèn luyện kỹ năng 

thiết kế trò chơi có ứng dụng CNTT trong dạy học hóa học. Còn GV vì gặp khó 



khăn về thời gian, chưa có ý tưởng phù hợp, chưa có tài liệu tham khảo và kỹ năng 

sử dụng các phần mềm để thiết kế trò chơi còn kém nên GV thường ngại thiết kế 

các trò chơi hóa học có ứng dụng CNTT và cũng mong muốn sẽ có một tài liệu 

tham khảo, công cụ hỗ trợ. Chính vì vậy, điều đó đã tạo điều kiện thuận lợi để 

chúng tôi có thể đưa E-Book “ỨNG DỤNG CÔNG NGHỆ THÔNG TIN ĐỂ 

THIẾT KẾ TRÒ CHƠI TRONG DẠY HỌC HÓA HỌC” vào thực tế nhằm nâng 

cao kỹ năng ứng dụng CNTT cho SV khoa Hóa trường ĐHSP TP. Hồ Chí Minh và 

GV ở trường THPT hiện nay.  

 

 

 

 

 

 

 

 

 



CHƯƠNG II. XÂY DỰNG E-BOOK “ỨNG DỤNG CÔNG NGHỆ THÔNG 

TIN ĐỂ THIẾT KẾ TRÒ CHƠI TRONG DẠY HỌC HÓA HỌC” 

2.1. Nguyên tắc thiết kế E-Book 

Để có được một E-Book chất lượng cao, quá trình xây dựng E-Book đòi hỏi 

phải dựa trên những nguyên tắc sư phạm chặt chẽ. Sau đây là những nguyên tắc 

thiết kế E-Book được xây dựng dựa trên các yêu cầu của chuẩn SCORM với E-

Learning. 

2.1.1. Nguyên tắc thiết kế về hình thức 

E-Book có thu hút được người đọc hay không, ngoài chất lượng và chiều sâu 

nội dung còn phụ thuộc vào tính hình thức của nó. Vì thế về hình thức phải đảm bảo 

những nguyên tắc quan trọng khi xây dựng E-Book, thể hiện ở những điểm sau: 

− Giao diện chính của E-Book được thiết kế công phu với các hiệu ứng chữ 

đặc sắc, nhưng lại được sắp xếp gọn gàng, nội dung cô đặc nhất. Các ngôn từ sử 

dụng trong E-Book đơn giản, dễ hiểu.  

− Thống nhất về kích cỡ (size), kiểu chữ (font) và màu sắc (color) ở các tiêu đề 

và nội dung để người dùng dễ dàng theo dõi. 

− Tạo sự nhất quán trong các trang thiết kế (màu sắc, cấu trúc, bố cục) cho 

trang chủ và các trang nội dung liên kết hoặc nếu có thay đổi thì ít. 

− Các phương tiện minh họa: Các hình ảnh, âm thanh, đoạn phim phải phù hợp 

với từng chủ đề của E-Book và nội dung tương ứng. 

− Tạo các đường dẫn (link) qua các biểu tượng hay chữ ở tất cả các trang nhằm 

tăng khả năng liên kết giữa trang chủ với các trang nội dung với nhau. Đặc biệt có 

thanh điều hướng chung cho tất cả các trang, giúp người dùng tương tác tốt hơn 

đối với E-Book. 

2.1.2. Nguyên tắc thiết kế về nội dung 

Các nội dung trong E-Book được trình bày rõ ràng, dễ đọc. Các đoạn phim, 

các tài liệu hướng dẫn được trình bày một cách chi tiết, dễ hiểu và được thiết kế với 

tính tương tác cao. 



Nội dung hướng dẫn của E-book được trình bày đảm bảo tính sư phạm, bên 

cạnh đó E-Book cũng cung cấp cho người dùng kho trò chơi được chúng tôi thiết kế 

hoặc sưu tầm có thể sử dụng trực tiếp hoặc chỉnh sửa theo ý tưởng của SV, GV. 

Không biến E-Book là bản sao của sách in. 

2.1.3. Nguyên tắc thiết kế về tính thực tiễn 

E-Book ra đời là do nhu cầu thực tiễn và sau khi hoàn thành, nó quay lại phục 

vụ thực tiễn giảng dạy. 

Theo nhịp độ phát triển CNTT hiện nay, việc ứng dụng tin học vào dạy học trở 

nên rất cần thiết và cấp bách. Kỹ năng ứng dụng CNTT để thiết kế các hình thức trò 

chơi phục vụ cho dạy học hóa học hiện nay của SV sư phạm Hóa và GV phổ thông 

còn nhiều hạn chế và gặp nhiều khó khăn. Do đó, việc ra đời của E-Book “ỨNG 

DỤNG CÔNG NGHỆ THÔNG TIN ĐỂ THIẾT KẾ TRÒ CHƠI TRONG DẠY 

HỌC HÓA HỌC” là sự thỏa mãn nhu cầu hỗ trợ, hướng dẫn GV, SV sư phạm hình 

thành, rèn luyện, nâng cao kỹ năng thiết kế các trò chơi có ứng dụng CNTT.  

Trước đây, không có tài liệu, E-Book hướng dẫn cách sử dụng các phần mềm 

dùng để thiết kế trò chơi, GV, SV sư phạm không biết thể hiện ý tưởng trò chơi 

bằng phần mềm và thiết kế như thế nào. 

2.1.4. Nguyên tắc thiết kế về tính hiệu quả 

E-Book hướng tới các mục tiêu sau: 

− Giúp GV, SV sư phạm hình thành, rèn luyện và nâng cao kỹ năng ứng dụng 

các phần mềm để thiết kế trò chơi dạy học thông qua sử dụng E-Book. 

− Hỗ trợ GV, SV sư phạm trong hoạt động giảng dạy. 

− Cung cấp cho người dùng các ý tưởng, các mẫu trò chơi có sẵn. 

− Hệ thống các bài luyện tập-kiểm tra để giúp người đọc có thể ôn luyện, tự 

đánh giá kiến thức, kỹ năng một cách thường xuyên. 

2.1.5.  Nguyên tắc đảm bảo tính khả thi 

E-Book sau khi hoàn thành phải hoàn toàn có khả năng đưa vào thực tế phục 

vụ cho SV sư phạm Hóa trường ĐHSP TP.Hồ Chí Minh và GV ở các trường THPT. 

Tính khả thi của E-Book được đánh giá qua các tiêu chí sau: 



− Các thao tác sử dụng E-Book dễ dàng và đơn giản. 

− Nội dung E-Book phải phù hợp với trình độ, nhu cầu và điều kiện hiện có 

của SV sư phạm và GV. 

− E-Book “ỨNG DỤNG CÔNG NGHỆ THÔNG TIN ĐỂ THIẾT KẾ TRÒ 

CHƠI TRONG DẠY HỌC HÓA HỌC” được chạy trên giao diện riêng và được 

xây dựng bởi phần mềm CourseLab 2.4 nên tương thích với nhiều máy vi tính hiện 

nay. 

2.2.   Quy trình xây dựng E-Book 

Để xây dựng E-Book chúng tôi đề xuất quy trình gồm các bước theo sơ đồ sau: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Hình 2.1. Sơ đồ quy trình xây dựng E-Book 

2.2.1. Phân tích tình huống để đề ra chiến lược phù hợp 

− Hiểu rõ đối tượng sử dụng, thời điểm sử dụng. 

− Xác định mục tiêu cần đạt được về nội dung và hình thức E-Book. 

Phân tích và  
đề ra chiến lược 

Xây dựng  
nội dung 

Thiết kế và xây 
dựng hình thức 

Sử dụng thử  
E-Book 

 

Giới thiệu 
E-Book 

 

Thực nghiệm 
sư phạm 

 
 



− Xác định tài nguyên cần thiết để xây dựng E-Book: Tài liệu trên mạng Internet, 

sách hướng dẫn, các phần mềm tiện ích,… 

− Xác định công cụ để xây dựng E-Book gồm phần mềm CourseLab 2.4 cũng như 

các phần mềm chuyên dụng liên quan để xây dựng E-Book. 

Đây là bước quan trọng nhất trong qui trình xây dựng E-Book vì nó có tác dụng 

định hướng, đặt nền móng chắc chắn cho các công việc tiếp theo. 

2.2.2. Xây dựng nội dung cơ bản 

Dựa vào mục tiêu đã xác định, tác giả tiến hành xây dựng, soạn thảo nội dung 

E-Book: 

− Dùng phần mềm Microsoft Office Word 2007 để soạn thảo các văn bản 

hướng dẫn cách thiết kế trò chơi, giới thiệu phần mềm. 

− Dùng phần mềm Adobe Reader để thể hiện nội dung các văn bản hướng dẫn 

cách thiết kế trò chơi, giới thiệu phần mềm. 

− Dùng phần mềm Microsoft Office PowerPoint 2007 và PhotoShop để thiết 

kế giao diện E-Book. 

− Dùng phần mềm Camtasia Studio 7 để quay phim các thao tác sử dụng phần 

mềm, các hướng dẫn và để hiệu chỉnh các đoạn phim đã quay. 

− Tập hợp và chỉnh sửa hình ảnh (bằng phần mềm PhotoShop) sẽ sử dụng để 

làm tăng tính sinh động, hấp dẫn trong E-Book. 

Phần lớn các dữ liệu được biên soạn hoặc sưu tầm ở giai đoạn này là các tập tin 

Word (.doc), PDF (.pdf), đoạn phim (.wmv) hoặc tập tin ảnh (.png, .jpg, .gif). Tất 

cả được chuyển thành một định dạng thống nhất và phù hợp cho các cấu hình máy 

tính hiện đại. 

− Dùng phần mềm CourseLab 2.4 để xây dựng E-Book. 

2.2.3. Thiết kế và xây dựng hình thức cho E-Book 

− Xây dựng và thống nhất phong cách thiết kế chung cho E-Book (màu sắc, 

kiểu chữ, cỡ chữ, nền, hiệu ứng,…). 

− Thiết kế giao diện ở mỗi phần, ở mỗi mục sao cho đạt 3 yêu cầu: Tiện dụng, 

thẩm mỹ và thao tác đơn giản. 



− Tiến hành nhập dữ liệu vào phần mềm CourseLab 2.4 dùng để xây dựng E-

Book, chuyển các tập tin âm thanh và phim thành định dạng thông dụng như MP3 

(.mp3), (.wmv) và tập tin PDF (.pdf). 

− Việt hóa và xây dựng giao diện E-Book. 

2.2.4. Sử dụng thử E-Book 

− E-Book được đóng gói và xuất thành tập tin dạng .exe hoặc chứa trong CD-

CROM rồi sao chép cho nhóm nhỏ SV sử dụng thử để kiểm tra tính tự động, tính 

chính xác của E-Book và cho kết quả phản hồi. 

− Thu thập ý kiến phản hồi rồi chỉnh sửa những lỗi còn thiếu sót, bổ sung và hoàn 

thiện E-Book. 

2.2.5. Giới thiệu E-Book 

Phổ biến E-Book bằng cách sao chép nội dung E-Book vào USB và cho SV chép 

trực tiếp về máy. 

2.2.6. Thực nghiệm sư phạm 

− Biên soạn và phát phiếu điều tra để lấy ý kiến của SV sau khi sử dụng E-

Book trong một thời gian. 

− Dựa vào kết quả khảo sát và sản phẩm yêu cầu SV thiết kế trong học phần 

“Ứng dụng CNTT trong dạy học hóa học” để đánh giá mức độ tiếp thu và kỹ năng 

ứng dụng các phần mềm để thiết kế trò chơi dạy học hóa học của SV sư phạm sau 

thời gian sử dụng E-Book. 

2.3. Sử dụng phần mềm CourseLab 2.4 để xây dựng E-Book 

Với những tính năng mà CourseLab 2.4 cung cấp hiện tại, chúng tôi quyết 

định chọn phần mềm CourseLab 2.4 để xây dựng với mong muốn đem đến người 

dùng một E-Book đẹp về hình thức, chất lượng về nội dung và quan trọng là khai 

thác tối đa tính tương tác cao giữa người dùng với E-Book. 

Nội dung của E-Book được tổng hợp trong trang chủ. Trang chủ chứa 4 trang 

thành phần tương ứng gồm 3 trang về phần mềm “PowerPoint”, “Hot Potatoes”, 

“ProShow Gold” và trang “Hướng dẫn”. Mỗi trang thành phần đều chứa 6 đề mục 

chính được liên kết với các nội dung bên trong của nó gồm: 



− Giới thiệu tổng quan: Có thể là đoạn phim hoặc đoạn văn bản giới thiệu sơ 

lược về các phần mềm. 

− Cài đặt phần mềm: Gồm đoạn phim hướng dẫn các thao tác để cài đặt một 

phần mềm, trong trường hợp máy tính người dùng chưa cài đặt phần mềm đó hoặc 

không biết phải thực hiện công việc cài đặt. 

− Hướng dẫn cơ bản: Nội dung chính gồm 24 đoạn phim hướng dẫn các thao 

tác cơ bản và tài liệu hướng dẫn sử dụng các phần mềm tương ứng. 

− Hướng dẫn nâng cao: Cung cấp cho người dùng 23 đoạn phim hướng dẫn 

thiết kế một số trò chơi hoặc đoạn phim hay, hấp dẫn từ đơn giản đến phức tạp được 

thiết kế bằng các phần mềm giới thiệu trong E-Book.  

− Trò chơi tham khảo: Là nơi cung cấp 78 mẫu trò chơi, ý tưởng trò chơi, 

luật chơi,…được chúng tôi thiết kế và sưu tầm được. 

− Luyện tập-Kiểm tra: Hệ thống 26 bài tập tự luyện dưới hình thức trắc 

nghiệm hoặc tự luận nhằm kiểm tra sự tiếp thu cũng như kỹ năng thiết kế các trò 

chơi bằng các phần mềm có trong E-Book. 

Cụ thể như bảng thống kê bên dưới: 

Bảng 2.1. Bảng thống kế số lượng đoạn phim hướng dẫn, trò chơi và bài tập có 

trong E-Book 

Các đề mục chính Các trang thành phần  

PowerPoint  Hot Potatoes 6 ProShow Gold 

Cài đặt phần mềm 1 đoạn phim 1 đoạn phim 1 đoạn phim 

Hướng dẫn cơ bản 5 đoạn phim và 1 

tài liệu hướng dẫn 

14 đoạn phim và 2 

tài liệu hướng dẫn 

5 đoạn phim và 1 

tài liệu hướng dẫn 

Hướng dẫn nâng cao 9 đoạn phim 10 đoạn phim 4 đoạn phim 

Trò chơi tham khảo 55 trò chơi 8 trò chơi 15 đoạn phim 

Luyện tập-Kiểm tra 11 bài tập 8 bài tập 7 bài tập 



Cấu trúc cụ thể của E-Book như sau: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Hình 2.2. Sơ đồ cấu trúc của E-Book 
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Trang chủ 



2.3.1. Trang chủ 

Cấu trúc trang chủ bao gồm 4 đề mục đồng cấp. Từ trang chủ, người dùng 

có thể truy xuất đến bất kì trang nào của E-Book bằng cách nhấp chuột vào các mục 

tương ứng ở trang chủ hoặc danh sách dưới thanh điều hướng. 

 
Hình 2.3. Trang chủ của E-Book 

 Nguyên tắc hoạt động 

Bằng cách nhấp chuột vào bất kì đề mục nào để đi tới trang (slide) nội dung 

chính của từng phần mềm trong E-Book. 

 Ý tưởng thiết kế 

Trang chủ là giao diện chính của E-Book, thể hiện tiêu đề của E-Book và đề 

mục chứa nội dung bên trong. Ở đây người dùng có một cái nhìn tổng quát nhất về 

toàn bộ cấu trúc của E-Book, đồng thời lựa chọn được nội dung mà mình cần tìm 

hiểu. Từ trang chủ, người đọc có thể đến các trang con bằng cách nhấp chuột vào 

tiêu đề của nó đã được mã hóa thành 4 biểu tượng có khả năng tương tác: 

− Phần mềm “PowerPoint” 

− Phần mềm “Hot Potatoes” 

− Phần mềm “ProShow Gold” 

− Hướng dẫn 



Bình thường các biểu tượng sẽ ở chế độ tối, khi người dùng di chuyển chuột 

đến các biểu tượng này thì chúng sẽ sáng lên, phát âm thanh báo hiệu đồng thời 

hiển thị các mục nhỏ chính sẽ được trình bày trong phần mềm đó. Mặt khác, tại 

trang chủ người dùng không chỉ có thể truy xuất đến trang nội dung của từng phần 

mềm mà còn truy xuất trực tiếp đến bất kì nội dung chi tiết bên trong nào của E-

Book. Khi di chuyển sang các mục khác thì các đối tượng sẽ tự động chuyển sang 

chế độ tối. Chính điều này, làm cho E-Book có giao diện khoa học, mang phong 

cách giống như là giao diện của Windows 8, hấp dẫn, thao tác dễ dàng, linh hoạt 

tránh được sự rườm rà, phức tạp của nhiều website và E-Book hiện nay đang sử 

dụng. 

 
Hình 2.4. Trang chủ của E-Book khi người dùng tương tác 

 Dùng CourseLab 2.4 để thể hiện ý tưởng 

− Trình tự các bước thiết kế 

Xây dựng một tập tin dữ liệu nguồn để chứa E-Book và chọn kiểu định dạng 

E-Book. Vào thẻ Module chọn mục Design Settings, để chọn định dạng về kích 

thước trang (1190x690), kiểu chữ, cỡ chữ,…cho toàn Module. 



Thiết kế mẫu trình bày chung cho E-Book (trang chủ và các trang nội dung) 

gồm: Hình nền, nút trang chủ, danh sách các trang nội dung, logo của E-

Book,…bằng cách dùng Slide Master. Khi đó, các trình bày, hiệu ứng áp đặt lên các 

đối tượng ở Slide Master đều tự động thiết lập trên tất cả các Slide và Frame. 

Thiết kế các biểu tượng (icon) bằng cách xử lí hình ảnh bằng phần mềm 

PhotoShop, nhập nội dung các đề mục vào các Text box trong CourseLab 2.4 và 

chèn hình ảnh các nút biểu tượng vào giao diện chính của E-Book. Sau đó, ta tiến 

hành tùy chỉnh các thông số bằng cách chọn vào đối tượng > nhấp chuột phải > 

Format Picture > điều chỉnh các thông số trong mục Colors and Lines, Size, 

Position, Display, Sound cho phù hợp với trang dữ liệu. 

Thiết lập các hiệu ứng cho các đối tượng bằng mã lệnh trong mục Actions. Và 

các thiết lập hiệu ứng, mã lệnh này sẽ được áp dụng tương tự khi thiết kế các trang 

nội dung khác. 

− Biểu tượng “PowerPoint” 

Onclick: 

CALL(Fram=’FRAM_7’Option=’Specificed Frame’) 

Onmouseover: 

DISPLAY(Object=’IMG_109’.Display=’Show’,Effect=’Object’,Duration=’0’) 

DISPLAY(Object=’IMG_122’.Display=’Show’,Effect=’Object’,Duration=’0’) 

DISPLAY(Object=’IMG_124’.Display=’Show’,Effect=’Object’,Duration=’0’) 

DISPLAY(Object=’IMG_126’.Display=’Show’,Effect=’Object’,Duration=’0’) 

DISPLAY(Object=’IMG_128’.Display=’Show’,Effect=’Object’,Duration=’0’) 

DISPLAY(Object=’IMG_130’.Display=’Show’,Effect=’Object’,Duration=’0’) 

SOUND(Object=”IMG_110’,File=’C:\CHEMDATA\button_16.wav) 

Onmouseout: 

DISPLAY(Object=’IMG_109’.Display=’Hide’,Effect=’Object’,Duration=’0’) 

DISPLAY(Object=’IMG_122’.Display=’Hide’,Effect=’Object’,Duration=’0’) 

DISPLAY(Object=’IMG_124’.Display=’Hide’,Effect=’Object’,Duration=’0’) 

DISPLAY(Object=’IMG_126’.Display=’Hide’,Effect=’Object’,Duration=’0’) 



DISPLAY(Object=’IMG_128’.Display=’Hide’,Effect=’Object’,Duration=’0’) 

DISPLAY(Object=’IMG_130’.Display=’Hide’,Effect=’Object’,Duration=’0’) 

− Các biểu tượng “Hot Potatoes” và “ProShow Gold” đều sử dụng các mã lệnh 

như trên. 

− Các biểu tượng nhỏ “Cài đặt phần mềm”, “Hướng dẫn cơ bản”, “Hướng dẫn 

nâng cao”, “Trò chơi tham khảo”, “Luyện tập-Kiểm tra”: 

Onclick: 

CALL(Fram=’FRAM_31’Option=’Specificed Frame’) 

Onmouseover: 

DISPLAY(Object=’IMG_109’.Display=’Show’,Effect=’Object’,Duration=’0’) 

DISPLAY(Object=’IMG_122’.Display=’Show’,Effect=’Object’,Duration=’0’) 

DISPLAY(Object=’IMG_124’.Display=’Show’,Effect=’Object’,Duration=’0’) 

DISPLAY(Object=’IMG_126’.Display=’Show’,Effect=’Object’,Duration=’0’) 

DISPLAY(Object=’IMG_128’.Display=’Show’,Effect=’Object’,Duration=’0’) 

DISPLAY(Object=’IMG_130’.Display=’Show’,Effect=’Object’,Duration=’0’) 

DISPLAY(Object=’IMG_119’.Display=’Show’,Effect=’Object’,Duration=’0’) 

SOUND(Object=”IMG_122’,File=’C:\CHEMDATA\button_16.wav) 

Onmouseout: 

DISPLAY(Object=’IMG_109’.Display=’Hide’,Effect=’Object’,Duration=’0’) 

DISPLAY(Object=’IMG_122’.Display=’Hide’,Effect=’Object’,Duration=’0’) 

DISPLAY(Object=’IMG_124’.Display=’Hide’,Effect=’Object’,Duration=’0’) 

DISPLAY(Object=’IMG_126’.Display=’Hide’,Effect=’Object’,Duration=’0’) 

DISPLAY(Object=’IMG_128’.Display=’Hide’,Effect=’Object’,Duration=’0’) 

DISPLAY(Object=’IMG_130’.Display=’Hide’,Effect=’Object’,Duration=’0’) 

DISPLAY(Object=’IMG_119’.Display=’Hide’,Effect=’Object’,Duration=’0’) 

2.3.2.  Trang phần mềm “PowerPoint” 

 Ý tưởng thiết kế 

Đối với phần mềm PowerPoint, chúng tôi giới thiệu tổng quan những nội dung 

mà người dùng sẽ tìm hiểu về phần mềm Microsoft Office PowerPoint 2007. Nội 



dung hướng dẫn trong trang này gồm 6 đề mục nhỏ: Phần giới thiệu tổng quan về 

phần mềm; hướng dẫn cài đặt phần mềm; hướng dẫn thực hiện các thao tác cơ bản; 

hướng dẫn chi tiết cách thiết kế một số mẫu trò chơi bằng phần mềm này; kho trò 

chơi tham thảo và phần luyện tập-kiểm tra. 6 mục này được liên kết với nhau và liên 

kết trực tiếp với trang phần mềm “PowerPoint”. 

 
Hình 2.5. Trang chính của phần mềm Microsoft Office PowerPoint 2007 

 Nguyên tắc hoạt động 

Sau khi nhấp chuột vào biểu tượng “PowerPoint” ở trang chủ sẽ dẫn đến giao 

diện chính của trang phần mềm “PowerPoint”. Giao diện gồm có: 

Slide giới thiệu về phần mềm Microsoft Office PowerPoint, có thể là một đoạn 

phim hoặc đoạn văn bản giới thiệu tổng quan về giao diện và một số công cụ chính. 

Ở slide cài đặt phần mềm là một đoạn phim hướng dẫn cách cài đặt phần mềm 

Microsoft Office PowerPoint 2007 vào máy tính. 



 
Hình 2.6. Trang hướng dẫn thao tác cơ bản trong Microsoft Office PowerPoint 

Slide hướng dẫn thao tác cơ bản, chúng tôi thực hiện 5 đoạn phim và 1 tài liệu 

hướng dẫn các thao tác cần thiết sử dụng để thiết kế mẫu trò chơi. Khi nhấp chuột 

vào các biểu tượng ở slide này sẽ chuyển đến trang chứa các đoạn phim hướng dẫn 

tương ứng. 

 
Hình 2.7. Đoạn phim hướng dẫn thực hiện thao tác triggers trong PowerPoint 2007 

Slide hướng dẫn thao tác nâng cao, chúng tôi giới thiệu các đoạn phim hướng 

dẫn chi tiết cách thiết kế một số mẫu trò chơi “Noughts and Crosses”, “Hang man”, 

“Leo núi” bằng phần mềm Microsoft Office PowerPoint 2007. 



 
Hình 2.8. Trang hướng dẫn thao tác thiết kế một số trò chơi trong PowerPoint 2007 

Vì phần mềm Microsoft Office PowerPoint 2007 là phần mềm rất thông dụng, 

nên chúng tôi đặc biệt chú ý đến kho trò chơi tham khảo được chúng tôi thiết kế và 

sưu tầm bên cạnh những hướng dẫn thao tác cơ bản, nâng cao. Với mong muốn 

cung cấp cho người dùng những mẫu trò chơi có sẵn hoặc khơi gợi ý tưởng thiết kế 

trò chơi, phát huy tính sáng tạo cho người dùng trong quá trình thiết kế trò chơi. 

 



 
Hình 2.9. Trang trò chơi tham khảo được thiết kế bằng PowerPoint 2007 

Ngoài ra, trong nội dung chính của trang phần mềm “PowerPoint” còn có hệ 

thống câu hỏi và bài tập kiểm tra để người dùng có thể tự mình đánh giá được trình 

độ sau khi tìm hiểu cũng như giúp người dùng có thể đánh giá được năng lực CNTT 

của mình, năng lực tự học, tính tích cực cho người học. 

 
Hình 2.10. Trang luyện tập-kiểm tra trong phần mềm PowerPoint 

Ở mỗi slide đều có liết kết về trang chính “PowerPoint” và trang chủ của E-Book 

thông qua các nút lệnh ở thanh điều hướng.  



 
Hình 2.11. Thanh điều hướng chính trong E-Book 

 Thể hiện ý tưởng bằng CourseLab 2.4 

Nhập văn bản vào Text box và chèn các hình ảnh vào giao diện chính của các trang. 

Cách thiết kế, sắp xếp các đối tượng ở trang này hoàn toàn giống với trang chủ. 

Sử dụng chức năng Action để tạo hiệu ứng cho các biểu tượng như mong 

muốn cũng tương tự như thao tác thực hiện ở trang chủ nhưng có thêm các lệnh sau: 

Dùng lệnh Action thiết lập hiệu ứng cho các biểu tượng: giới thiệu tổng quan, 

cài đặt phần mềm, hướng dẫn cơ bản, hướng dẫn nâng cao, luyện tập-kiểm tra. 

Onclick: 

CALL(Frame=’FRAME_31’,Option=’Specificed Frame’) 

Onmouseover: 

DISPLAY(Object=’IMG_164’.Display=’Show’,Effect=’Object’,Duration=’0’) 

DISPLAY(Object=’TXT_12’.Display=’Show’,Effect=’Object’,Duration=’0’) 

SOUND(Object=”IMG_165’,File=’C:\CHEMDATA\button_16.wav) 

Onmouseout: 

DISPLAY(Object=’IMG_164’.Display=’Hide’,Effect=’Object’,Duration=’0’) 

DISPLAY(Object=’TXT_12’.Display=’Hide’,Effect=’Object’,Duration=’0’) 

Quay các đoạn phim giới thiệu và hướng dẫn bằng phần mềm Camtasia Studio 

7 sau đó hiệu chỉnh đoạn phim cũng bằng phần mềm Camtasia Studio 7. 

Đưa các đoạn phim quay được vào các slide trong CourseLab 2.4 bằng cách 

chèn Media vào Insert > Object…> Video. Chọn Player Control là Full và chọn 

Movie autostart để đoạn phim tự động chạy và người dùng có thể tùy chỉnh được. 



 
Hình 2.12.  Đoạn phim hướng dẫn thiết kế trò chơi leo núi bằng PowerPoint 

Tạo hệ thống các câu hỏi, bài tập dưới hình thức trắc nghiệm bằng công cụ 

JQuiz trong Hot Potatoes 6 rồi xuất ra dưới dạng web. Đưa các trang bài tập vào các 

slide của CourseLab 2.4 bằng cách chèn IFRAME vào Insert > Object…> Extemal 

> Iframe. 

 
Hình 2.13. Trang luyện tập-kiểm tra trong phần mềm PowerPoint  



 

2.3.3.  Trang phần mềm “Hot Potatoes” 

 Ý tưởng thiết kế 

Hot Potatoes 6 là chương trình cho phép tạo các ứng dụng (bài tập điện tử, trò 

chơi...) E-learning trên www (World Wide Web), bằng việc xuất thành dạng HTML 

hay các mô-đun để đưa lên web thực hiện việc chơi trên mạng rất dễ dàng. Với 

mong muốn thiết kế các mẫu trò chơi hóa học có thể chạy đồng thời trên các máy 

tính khi kết nối mạng giống như các trò chơi trực tuyến, GV có thể thiết kế và đưa 

trò chơi đó lên mạng, học sinh có thể ở nhà, trực tiếp chơi, thông qua hình thức vừa 

chơi vừa học, ôn tập kiến thức về hóa học. 

 
Hình 2.14. Trang chính của phần mềm Hot Potatoes 6 

Mặt khác, với công cụ JCross mà Hot Potatoes 6 cung cấp cho phép GV có thể 

thiết kế hàng loạt các ô chữ hóa học bằng cách nhập nội dung ô chữ sau đó chương 

trình sẽ tự động tạo ô chữ. 

 Nguyên tắc hoạt động 

Khi nhấp vào biểu tượng “Hot Potatoes” ở trang chủ sẽ dẫn đến trang giao 

diện chính của phần mềm Hot Potatoes 6. 



Ở trang này, giao diện hoàn toàn giống với trang giao diện của phần mềm 

“PowerPoint”. Nhưng ở slide hướng dẫn cơ bản, E-Book cung cấp cho người dùng 

6 công cụ chính có trong Hot Potatoes 6 và thao tác chụp hình một đối tượng bất kì 

trên màn hình máy vi tính bằng công cụ “Snipping Tool” do Windows 7 cung cấp 

và tài liệu hướng dẫn. 

 
Hình 2.15. Trang hướng dẫn thao tác cơ bản trong Hot Potatoes 6 

Slide hướng dẫn nâng cao, chúng tôi cung cấp 10 đoạn phim hướng dẫn chi 

tiết cách thiết kế một số mẫu trò chơi hóa học đơn giản được thiết kế bằng phần 

mềm Hot Potatoes 6 như: trò chơi ô chữ, sắp xếp dãy thế điện cực chuẩn của kim 

loại, ghép hình dụng cụ thí nghiệm hóa học. 

Ở slide trò chơi tham khảo sẽ bao gồm 8 mẫu và ý tưởng trò chơi hóa học 

được chúng tôi thiết kế sẵn để người dùng có thể tham khảo. 



 
Hình 2.16. Trang trò chơi tham khảo trong phần mềm Hot Potatoes 6 

Ở mỗi slide đều có liên kết về trang giao diện chính của phần mềm “Hot 

Potatoes” và trang chủ của E-Book thông qua các nút lệnh ở thanh điều hướng. 

 Thể hiện ý tưởng bằng CourseLab 2.4 

Nhập văn bản vào Text box và chèn các hình ảnh vào giao diện chính của các 

trang. Cách thiết kế, sắp xếp các đối tượng ở trang này hoàn toàn giống với trang 

chủ và trang chính của phần mềm “PowerPoint”. 

Sử dụng chức năng Action để tạo hiệu ứng cho các biểu tượng như mong 

muốn cũng tương tự như các lệnh ở trang chủ và trang giao diện phần mềm 

“PowerPoint”. 

Quay các đoạn phim giới thiệu và hướng dẫn bằng phần mềm Camtasia Studio 

7 sau đó hiệu chỉnh đoạn phim cũng bằng phần mềm Camtasia Studio 7. 

Đưa các đoạn phim quay được vào các Slide trong CourseLab 2.4 bằng cách 

chèn Media vào Insert > Object…> Video. Chọn Player Control là Full và chọn 

Movie autostart để đoạn phim tự động chạy và người dùng có thể tùy chỉnh được. 

Tạo liên kết giữa các slide với nhau và với trang giao diện chính “Hot 

Potatoes”. 

2.3.4.  Trang phần mềm “ProShow Gold” 



 Ý tưởng thiết kế 

ProShow Gold là phần mềm làm phim có hỗ trợ các hiệu ứng và âm thanh rất 

chuyên nghiệp. Phần mềm này có thể giúp GV thiết kế một lượng lớn các phim 

chứa nội dung về hóa học được sử dụng cho các trò chơi dạng như tăng tốc hoặc sử 

dụng trong các bài giảng điện tử.  

 Nguyên tắc hoạt động  

Khi nhấp vào biểu tượng “ProShow Gold” ở trang chủ sẽ chuyển đến trang 

giao diện chính của phần mềm “ProShow Gold”. Từ trang này cũng sẽ có 6 đề mục 

hoàn toàn giống với trang chính của phần mềm “PowerPoint” và “Hot Potatoes”. 

 
Hình 2.17. Trang chính của phần mềm ProShow Gold 

Tương ứng với các liên kết: Một liên kết đến slide chứa đoạn phim hướng dẫn 

cài đặt phần mềm; một liên kết đến slide nội dung hướng dẫn cơ bản, bao gồm 5 

đoạn phim hướng dẫn các thao tác sẽ dùng để thiết kế đoạn phim trong ProShow 

Gold. 

Ngoài ra, còn có liên kết đến slide hướng dẫn nâng cao, ở đây chúng tôi cung 

cấp 4 đoạn phim hướng dẫn chi tiết người dùng cách thiết kế một số đoạn phim theo 

nhiều hình thức khác nhau như thiết kế nội dung đoạn phim trên PowerPoint sau đó 

xuất thành các tập tin hình ảnh, rồi dùng ProShow Gold để xử lí, xuất thành phim. 



 
Hình 2.18. Trang hướng dẫn nâng cao của phần mềm ProShow Gold 

Tương tự như trong phần mềm “PowerPoint” và “Hot Potatoes” trong 

“ProShow Gold” cũng có trang trò chơi tham khảo, giới thiệu 15 đoạn phim với các 

hình thức, nội dung phong phú được thiết kế bằng ProShow Gold và cuối cùng là 

trang luyện tập-kiểm tra. 

 
Hình 2.19. Trang trò chơi tham khảo của phần mềm ProShow Gold 

 Thể hiện ý tưởng bằng CourseLab 2.4 



Nhập văn bản vào Text box và chèn các hình ảnh vào giao diện chính của 

trang. Cách thiết kế, sắp xếp các đối tượng ở trang này hoàn toàn giống với trang 

chủ và các trang phần mềm “PowerPoint” và “Hot Potatoes”. 

Sử dụng chức năng Action để tạo hiệu ứng cho các biểu tượng như mong 

muốn cũng tương tự như các lệnh ở trang chủ và trang giao diện phần mềm 

“PowerPoint” và “Hot Potatoes”. 

Quay các đoạn phim giới thiệu và hướng dẫn bằng phần mềm Camtasia Studio 

7 sau đó hiệu chỉnh đoạn phim cũng bằng phần mềm Camtasia Studio 7. 

Đưa các đoạn phim quay được vào các Slide trong CourseLab 2.4. Chọn 

Player Control là Full và chọn Movie autostart để đoạn phim tự động chạy và người 

dùng có thể tùy chỉnh được. Tạo liên kết giữa các slide với nhau, với trang chính 

“ProShow Gold” và trang chủ. 

2.4. Giới thiệu hệ thống các phần mềm dùng để thiết kế các trò chơi trong 

dạy học hóa học  

2.4.1. Phần mềm Microsoft Office PowerPoint 2007 

Microsoft Office PowerPoint 2007 là một phần mềm thông dụng để thiết kế 

bài giảng điện tử, hay một bài trình diễn, thuyết trình,…Vì thế, nó không còn xa lạ 

với bất kì SV hay GV hiện nay. Còn đối với hóa học, Microsoft Office PowerPoint 

có rất nhiều hữu ích, nó không những dùng để thiết kế bài giảng điện tử, bài trình 

diễn, thuyết trình, mô phỏng thí nghiệm mà còn để thiết kế các trò chơi hóa học có 

ứng dụng CNTT rất sinh động và hấp dẫn. 

Với ưu điểm là dễ sử dụng, hiệu ứng phong phú, đẹp mắt và cho phép chèn 

nhiều đối tượng (âm thanh, hình ảnh, đoạn phim,…). Microsoft Office PowerPoint 

2007 có thể thiết kế được các trò chơi hấp dẫn, sinh động mà thực tế không thực 

hiện được. Với Microsoft Office PowerPoint 2007, GV có thể thực hiện được hết 

các ý tưởng trò chơi một cách dễ dàng. Nó cũng giúp ích rất nhiều trong việc tích 

cực hóa việc dạy học hóa học, phù hợp với xu hướng dạy học hiện nay của thế giới. 

Sở dĩ Microsoft Office PowerPoint 2007 được ưa dùng là do: 



− Phù hợp với hệ điều hành Windows (hệ điều hành phổ biến trên các máy tính 

ở Việt Nam). 

− Khả năng tích hợp các đa phương tiện rất mạnh. 

− Hiệu ứng đa dạng, hấp dẫn, sinh động, dễ sử dụng. 

− Tính nhất quán trong bộ Microsoft Office 2007 giúp cho người dùng đã biết 

sử dụng WinWord cũng dễ dàng tiếp cận với Microsoft Office PowerPoint 2007. 

− Việc sử dụng Microsoft Office PowerPoint 2007 để thiết kế các trò chơi sẽ 

làm cho hoạt động giảng dạy sinh động hơn, tăng hứng thú nhận thức, tạo không 

khí sinh động, khơi dậy được sự hào hứng học tập cho học sinh, giúp cho học sinh 

cảm thấy kiến thức hóa học gần gũi, củng cố kiến thức một cách tự nhiên, học sinh 

dễ tiếp thu hơn. 

2.4.2. Phần mềm Hot Potatoes 6 

Hot Potatoes 6 do University of Victoria (Canada) hợp tác với Half-Baked 

Software và Creative Technology thực hiện. Hot Potatoes 6 là một chương trình để 

tạo các ứng dụng E-learning trên www (World Wide Web), Hot Potatoes hỗ trợ việc 

tạo các bài tập điện tử đa dạng sau đó xuất thành dạng HTML hay các mô-đun để 

đưa lên web thực hiện việc thi qua mạng theo kiểu Client-Server. 

 
Hình 2.20. Giao diện trang chủ Hot Potatoes 6 



Hot Potatoes 6 gồm các công cụ sau: 

− JQuiz: Dùng tạo các bài tập hỗ trợ 4 loại câu hỏi: Đa lựa chọn, câu hỏi trả lời 

ngắn, câu hỏi lai, câu hỏi nhiều câu trả lời. 

− JCloze: Gồm các bài tập điền vào chỗ trống. 

− JCross: Tạo trò chơi ô chữ (crosswords). 

− JMix: Mô-đun dùng tạo các câu hỏi sắp xếp các từ, cụm từ lộn xộn thành một 

cụm từ, câu, đoạn theo yêu cầu. 

− JMatch: Tạo các bài tập gồm các câu hỏi so khớp hay sắp xếp các câu trả lời 

tương ứng với các câu hỏi. 

− The Masher: Công cụ để quản lí khi có số lượng lớn các trang HTML bài thi và 

câu hỏi. 

Để bắt đầu làm việc với công cụ nào chọn công cụ đó từ Hot Potatoes 6 hoặc 

chọn trực tiếp từ các "củ khoai" trên màn hình chính. 

Một số chức năng của phần mềm Hot Potatoes 6: 

− Tạo tác mẫu bài tập phong phú nhờ các công cụ đa dạng có trong Hot Potatoes 6. 

− Chỉ xuất được dưới dạng HTML có khả năng chạy độc lập, không nhúng được 

vào PowerPoint. 

− Giao diện tương tác HTML cũng mang tính tương tác cao nhưng khá đơn điệu. 

− Thiết lập tuỳ biến cách hiển thị số câu trên giao diện tương tác HTML. 

− Có khống chế thời gian trả lời và cho điểm. 

− Có công cụ The Masher tạo bảng tổng hợp chỉ mục. 

− Đảo ngẫu nhiên ngân hàng câu hỏi (kể cả đảo thứ tự đáp án). 

− Cho phép chèn hình ảnh. 

− Có thể in ra giấy kèm đáp án (thông qua một phần mềm gõ văn bản như 

Microsoft Office Word). 

− Người dùng có thể gửi bài trắc nghiệm lên trang Hot Potatoes 6 để học sinh có 

thể làm thử ở bất kỳ đâu khi máy tính có kết nối Internet. 



Với những ưu-khuyết điểm khác nhau, người GV có thể kết hợp với 

PowerPoint tuỳ tình huống để có thể tạo ra các bài tập điện tử thật thiết thực cho bài 

giảng của mình. 

Trong Hot Potatoes 6 cung cấp nhiều công cụ hỗ trợ GV thực hiện các ý tưởng 

trò chơi dưới dạng trang HTML có thể chạy trên máy tính cục bộ hoặc đưa lên web 

phục vụ trên mạng toàn cầu.  

2.4.3. Phần mềm ProShow Gold  

Proshow Gold là sản phẩm của hãng Photodex, là một phần mềm thông dụng 

hiện nay cho phép người dùng làm những đoạn phim hay đoạn Flash có hỗ trợ các 

hiệu ứng cực đẹp và độc đáo tương thích với nhiều loại tập tin hình ảnh, kèm theo 

âm thanh rất chuyên nghiệp. ProShow Gold cung cấp nhiều tùy chọn xuất hơn bất kì 

phần mềm tạo trình diễn nào khác. Đặc biệt, chúng cho phép tạo đoạn phim 

DVD/CD có thể xem trên TV (Television) hoặc truyền phát trình diễn trên web, các 

tập tin MPEG để xem trên máy tính, các trình bảo vệ màn hình để sử dụng cho mục 

đích cá nhân hay chia sẻ với mọi người, các trình diễn tự chạy độc lập (.EXE) để 

thuận tiện cho việc gửi qua email và gửi trực tuyến, các CD tự động phát khi cho 

vào đĩa hay các tập tin Flash, QuickTime,…Thao tác nhanh, dễ sử dụng, hiệu quả 

cao gây thích thú cho người xem đó là tính năng vượt trội của chương trình này. 

Điều quan trọng là phần mềm này có thể giúp GV thiết kế một lượng lớn các 

đoạn phim chứa nội dung phong phú về hóa học được sử dụng cho các trò chơi 

dạng tăng tốc hoặc tích hợp trong bài giảng điện tử. 



 
Hình 2.21. Giao diện trang chủ của phần mềm ProShow Gold 

Một số chức năng của phần mềm ProShow Gold: 

− Thêm và biên tập nội dung dễ dàng. 

− Thêm số lượng lớn không giới hạn cho trình diễn. 

− Thêm nội dung vào trình diễn thông qua kéo thả chuột. 

− Hỗ trợ hơn 100 định dạng tập tin. 

− Hỗ trợ hầu hết các tập tin định dạng PSD, PNG, JPG và GIF. 

− Các công cụ biên tập ảnh cho phép cắt ngắn phim, loại bỏ mắt đỏ, xoay, lật, 

làm sắc nét, đổ bóng, tô màu,...  

− Thiết lập thời gian tùy chỉnh cho một hay nhiều trang cùng lúc. 

− Tạo nhạc nền bằng cách chèn các tập tin dạng MP3, WMA hay WAV vào 

trình diễn, bạn sẽ xem được dạng sóng của bài nhạc trong danh sách trang 

trình chiếu. 

− Chia sẻ trình diễn ở bất kì đâu. 

2.5.  Giới thiệu cấu trúc và nội dung của E-Book 

Với việc tuân thủ các nguyên tắc khi thiết kế E-Book, chúng tôi đã vận dụng 

sáng tạo để xây dựng E-Book “ỨNG DỤNG CÔNG NGHỆ THÔNG TIN ĐỂ 

THIẾT KẾ TRÒ CHƠI TRONG DẠY HỌC HÓA HỌC” không chỉ đẹp, bắt mắt, 

thân thiện mà còn đơn giản về thao tác sử dụng, cũng như nội dung phải hợp lí, 



chính xác và khoa học. Chính vì thế, chúng tôi đã khai thác và phối hợp các hình 

ảnh, âm thanh, hiệu ứng, cũng như đồ họa để đem đến cho người dùng E-Book có 

giao diện thân thiện, thu hút người xem và người xem phải tò mò tìm hiểu tất cả nội 

dung bên trong, với hình thức ở mỗi trang đều có liên kết với nhau, nên người dùng 

có thể truy xuất đến bất kì trang nào mong muốn trong E-Book. 

Về nội dung E-Book, chúng tôi chú trọng khai thác 3 nội dụng chính tương 

ứng với hệ thống 3 phần mềm mà chúng tôi sẽ sử dụng và hướng dẫn để thiết kế các 

trò chơi dùng trong dạy học hóa học: 

1. Bộ Microsoft Office 2007 mà phần mềm mà chúng tôi hướng dẫn ở đây là 

Microsoft Office PowerPoint 2007. 

2. Phần mềm Hot Potatoes 6. 

3. Phần mềm ProShow Gold. 

Nội dung của từng phần được chúng tôi cân nhắc, chọn lọc những nội dung cơ 

bản cần thiết nhằm giúp người dùng hình thành, rèn luyện kỹ năng ứng dụng CNTT 

để thiết kế các trò chơi trong dạy học hóa học. Bên cạnh đó, E-Book còn hỗ trợ 

người dùng những công cụ, mẫu trò chơi, ý tưởng trò chơi để người dùng tham 

khảo và thiết kế ra những trò chơi bằng những phần mềm mà chúng tôi đã cung cấp 

và hướng dẫn. Nhưng nội dung quan trọng vẫn là những đoạn phim hướng dẫn các 

thao tác thiết kế trò chơi. Để người dùng dễ quan sát, học tập, thực hành, các thao 

tác mà chúng tôi quay, được thực hiện với tốc độ vừa phải, hình ảnh đoạn phim rõ 

nét, đồng thời kèm theo là những chỉ dẫn bên cạnh các thao tác chuột có tác dụng 

hướng dẫn tốt nhất. 

 

 

 

 

 

 

 



2.5.1. Trò chơi được thiết kế bằng phần mềm PowerPoint 2007 

 

 

 

 

 

 

 

            

            

            

            

            

            

            

            

            

            

            

            

            

            

    

  

 

Hình 2.22.  Sơ đồ nội dung phần mềm Microsoft Office PowerPoint 2007 

Để giới thiệu phần mềm, chúng tôi quay đoạn phim hướng dẫn từ cài đặt đến 

cách thực hiện các thao tác cơ bản trong phần mềm Microsoft Office PowerPoint 

Phần mềm PowerPoint 

Giới thiệu 
tổng quan 

Hướng dẫn 
cơ bản 

Hướng dẫn 
nâng cao 

 

Trò chơi 
tham khảo 

Luyện tập 
kiểm tra 

Cài đặt 
phần mềm 

Giao diện phần mềm 

Tạo các đối tượng 

Tạo các hiệu ứng 

Noughts and Crosses 

Hang man 

Leo núi 

Ai thông minh? 

Bắt bướm 

Bắt ếch 

Bóng rỗ 

Câu cá 

Chiếc nón kì diệu 

Chúa tể rừng xanh 

Con số may mắn 

Đấu trường 20 

Đi tìm ẩn số 

Đi tìm kho báu 

Đoán chữ 

Đoán suy nghĩ 

Đua ếch 

Giải đáp câu đố 

Giải mã không gian 

Học sinh triệu phú 

Hollyquood squares 

Kho báu đại dương 

(55 trò chơi) 

Hướng dẫn tạo triggers 
 

Câu hỏi trắc nghiệm 

Tài liệu hướng dẫn 



2007 cũng như hướng dẫn cách thiết một số trò chơi từ đơn giản đến phức tạp. Hệ 

thống phim hướng dẫn bao gồm 15 đoạn phim trong đó được chia thành: 

− Đoạn phim hướng dẫn cài đặt phần mềm (1 đoạn phim). 

− Hướng dẫn các thao tác cơ bản (5 đoạn phim). 

− Hướng dẫn các thao tác nâng cao (9 đoạn phim). 

Ở đây, chúng tôi cung cấp các đoạn phim hướng dẫn người xem cách thiết kế 

một số mẫu trò chơi. Sở dĩ, chúng tôi quyết định chọn hướng dẫn trò chơi “Noughts 

and Crosses” và “Leo núi” vì thông qua trò chơi này, người đọc sẽ nắm được các kỹ 

năng cơ bản thường sử dụng để thiết kế các mẫu trò chơi từ đơn giản đến phức tạp. 

2.5.1.1. Trò chơi “Noughts and Crosses” 

Đối với trò chơi “Noughts and Crosses” thông qua đoạn phim hướng dẫn, 

người thiết kế sẽ biết được kỹ thuật tạo triggers; vẽ các đối tượng trong AutoShape 

rồi định dạng màu sắc, kích cỡ, bề dày,…; tạo và định dạng hiệu ứng trong 

Entrance, Exit; tạo liên kết đến slide câu hỏi,… 

 Mục đích 

Gây hứng thú cho học sinh trong việc vận dụng các kiến thức hóa học đã tiếp 

thu được để trả lời các câu hỏi. Nếu trả lời đúng thì đội (nhóm) đó sẽ được đánh dấu 

kí hiệu của đội mình lên ô câu hỏi đó. Đội nào có 3 kí hiệu giống nhau ở bất kì hàng 

ngang, dọc, chéo trước tiên thì đội đó sẽ chiến thắng. 

Làm cho việc khắc sâu kiến thức của học sinh diễn ra nhẹ nhàng nhưng hiệu quả. 

Rèn luyện kĩ năng hợp tác nhóm nhỏ, nỗ lực để giành chiến thắng về đội mình. 

 Chuẩn bị 

− Đối với GV: Chuẩn bị các câu hỏi cho mỗi ô (dạng bài tập trắc nghiệm hoặc 

tự luận).  

Thiết kế bàn cờ carô trên slide. 

Phiếu bài tập ôn tập cho học sinh. 

− Đối với học sinh: Chuẩn bị trước nội dung ôn tập trong SGK, bảng, bút lông. 

 Cách tiến hành 

− Chia nhóm: Chia lớp thành 2 đội. Mỗi đội có kí hiệu đại diện là X và O. 



− Có 9 ô sắp xếp thành hình vuông. Mỗi đội lần lượt chọn một ô, sau đó trả lời 

các câu hỏi. 

− Phát cho mỗi nhóm bảng, bút lông. 

 Luật chơi 

− Nếu đội lựa chọn ô vuông đó trả lời đúng thì đội đó sẽ được ghi kí hiệu của đội 

mình vào (X hoặc O) ngược lại, đội còn lại sẽ có cơ hội trả lời, nếu trả lời đúng 

thì đội đó được phép ghi kí hiệu của đội mình vào ô vuông đó. 

− Nếu đội nào có được 3 ô chứa 3 kí hiệu X (O) theo bất kì hàng ngang, dọc, chéo 

trước sẽ là đội chiến thắng. 

 Thiết kế trò chơi 

− Thiết kế Slide mẫu trò chơi 

 
 

− Các bước thực hiện: 

Bước 1: Tạo và định dạng cho các đối tượng 

Vẽ các kí hiệu X: Vào Shapes > Equation Shapes > Multiply. 

Vẽ các kí hiệu O: Vào Shapes > Basic Shapes > Donut. 

Vẽ các đường thẳng chéo, ngang, dọc: Vào Shapes > Lines > Line. 

 
Thực hiện liên kết (Hyperlink) 

tới slide câu hỏi. 

 
Nhấp chuột vào kí hiệu X lớn sẽ 

hiện ra, X và O nhỏ sẽ biến mất. 

 
Nhấp chuột vào kí hiệu O lớn sẽ 

hiện ra, X và O nhỏ sẽ biến mất. 

 
Nhấp chuột vào N1, D1, 

C1 thì các đường ngang, 

dọc, chéo sẽ hiện ra. 



 
Định dạng màu sắc, kích thước cho các đối tượng trên: Nhấp đúp chuột vào 

đối tượng > Shape Styles > tùy chỉnh trong mục Shape Fill, Shape Outline, Shape 

Effects. 

 
• Tô màu: Shape Fill > Color (tùy ý) hoặc tô màu Gradient (2 hoặc nhiều màu) 

hoặc Texture (nền). 



• Thay đổi kích cỡ: Shape Outline > Weight (3pt), màu sắc Shape Outline > 

Color, kiểu đường viền Shape Outline > Weight  Dashes. 

Bước 2: Tạo và định dạng hiệu ứng cho các đối tượng 

Kí hiệu X, O lớn: Chọn đối tượng > Add Effect > Entrance > Descend. 

Mục Start: Chọn With Previous. 

 
Kí hiệu X, O nhỏ: Chọn đối tượng > Add Effect > Exit> Disappear. 

Mục Start: Chọn With Previous. 

 
Kí hiệu X, O lớn: Chọn đối tượng > Add Effect > Exit > Disappear. 

Mục Start: Chọn With Previous. 

Các đường dọc, ngang: Vào Add Effect > Entrance > Ease in. 

Mục Start: Chọn On Click. 



Direction: From bottom. 

Các đường chéo: Vào Add Effect > Entrance > Curve Up. 

Bước 3: Tạo triggers cho các đối tượng 

− Tạo triggers cho kí hiệu X (O) lớn với X (O) nhỏ (khi nhấp chuột vào dấu X 

(O) nhỏ thì X (O) lớn sẽ hiện ra). 

Chọn đối tượng X (O) lớn vào Timing > Triggers > Start effect on click of > 

chọn tên hiệu ứng của kí hiệu X (O) nhỏ tương ứng. 

 
− Tạo triggers cho kí hiệu X (O) nhỏ với chính nó (khi nhấp chuột vào dấu X 

(O) nhỏ thì X (O) nhỏ sẽ biến mất). 

Chọn đối tượng X (O) nhỏ vào Timing > Triggers > Start effect on click of > 

chọn tên hiệu ứng của kí hiệu X (O) nhỏ tương ứng. 

− Tạo hiệu ứng triggers cho lần lượt đường ngang, chéo, dọc với các nút lệnh 

N1, N2, N3,…; C1, C2, C3,…; D1, D2, D3, D4,… 

Chọn đối tượng đường ngang, chéo, dọc vào Timing > Triggers > Start effect 

on click of > chọn tên hiệu ứng của các nút lệnh N1, N2, N3, C1, C2, C3, D1, D2, 

D3 tương ứng. 

Sau đó bạn chọn hết các kí hiệu X, O lớn và X, O nhỏ sao chép sang cho các ô 

còn lại mà bạn không cần phải thiết kế lại. 
Bước 4: Tạo slide nội dung câu hỏi 



 

Tạo liên kết (Hyperlink) tới slide chủ khi nhấp chuột vào đối tượng . 

Tương tự sao chép slide và thay đổi nội dung câu hỏi để tạo các câu hỏi tiếp theo 

cho các slide còn lại. 

 
− Ý nghĩa: Việc tạo các liên kết tới slide chủ sẽ tạo ra một trò chơi logic, 

thống nhất. Trò chơi này rất dễ chỉnh sửa, GV chỉ cần thay đổi nội dung, số lượng, 

dạng câu hỏi ở lần chơi tiếp theo. 

Những nội dung có thể áp dụng: Trò chơi này có thể áp dụng để ôn tập, củng 

cố lí thuyết cho học sinh ở các phần câu hỏi về ứng dụng, sản xuất, về hiện tượng, 

giải thích,…GV có thể cho học sinh ôn tập, trả lời theo nhóm hoặc cá nhân. 

2.5.1.2. Trò chơi “Leo núi” 

Đối với trò chơi “Leo núi” thông qua đoạn phim hướng dẫn, người xem sẽ biết 

được kỹ thuật tạo triggers; vẽ các đối tượng AutoShape rồi định dạng màu sắc, kích 

Tạo các Text box chứa câu hỏi và các 

đáp án. Tạo hiệu ứng: Entrance > 

Descend cho các Text box. 
 



cỡ, bề dày,…; tạo và định dạng hiệu ứng trong Entrance, Emphasis, Motion Paths 

và tạo liên kết đến slide câu hỏi. 

 Mục đích 

− Kiểm tra mức độ tiếp thu kiến thức của học sinh, được sử dụng khi dạy các 

bài luyện tập. Nếu sử dụng để kiểm tra đầu giờ thì giúp công việc kiểm tra đầu giờ 

trở nên nhẹ nhàng, vui vẻ. 

− Tạo không khí thi đua sôi nổi giữa các học sinh, giúp cho học sinh có cảm 

giác như đang được leo núi thực sự. 

 Chuẩn bị 

− Đối với GV: Chuẩn bị các câu hỏi cho mỗi bậc thang (dạng bài tập trắc 

nghiệm hoặc tự luận), thiết kế đỉnh núi và người leo núi trên slide chủ, phiếu bài tập 

ôn tập cho học sinh. 

− Đối với học sinh: Chuẩn bị trước nội dung ôn tập trong SGK, giấy A0, bút 

lông. 

 Cách tiến hành 

− Chia nhóm: Chia lớp thành 2 đội. Mỗi đội sẽ có nhân vật leo núi đại diện. 

− Có 5 nấc thang dẫn lên đỉnh núi. Mỗi đội lần lượt trả lời các câu hỏi tương ứng 

với nấc thang từ số 1 đến 5 ở phía bên mình. 

− Phát cho mỗi nhóm bảng, bút lông. 

 Luật chơi 

− Nếu đội nào trả lời đúng, sẽ leo lên 1 bậc của câu hỏi đó. 

− Nếu đội nào trả lời câu hỏi của mình sai thì đội kia sẽ bắt đầu trả lời câu hỏi ở 

từng nấc bên phía mình, nếu đúng sẽ leo lên 1 bậc của câu hỏi đó. 

− Đội nào lên được đỉnh núi trước sẽ thắng.  

 Thiết kế trò chơi 

− Thiết kế slide mẫu trò chơi. 



 
 Ý tưởng thiết kế 

− Khi nhấp chuột vào nấc thang thì nó sẽ chuyển sang màu xanh, ấn định nấc 

thang đó đã được leo lên. 

− Khi nhấp chuột vào các số 1, 2, 3, 4, 5 thì sẽ đi tới slide chứa nội dung câu 

hỏi tương ứng. 

− Khi nhấp chuột vào hình Mendeleev và Marie Curie thì nó sẽ di chuyển lên 1 

bậc thang. Nhân vật nào leo lên đỉnh núi trước tiên, thì chữ chiến thắng sẽ hiện lên 

để chúc mừng.  

 Cách thực hiện 

Bước 1: Tạo hình ảnh đỉnh núi 

− Các nấc thang: Shapes > Rectangles > Rectangle.  

− Các số 1, 2, 3, 4, 5: Shapes > Basic Shapes > Oval. Sau đó chọn đối tượng, 

nhấp phải chuột > Edit text > gõ số vào. 

− Chèn hình ảnh Mendeleev và Marie Curie: Insert > Picture > chọn đường 

dẫn tới vị trí lưu hình ảnh. 

− Chữ “Chiến Thắng”: Word Art > chọn kiểu màu sắc thích hợp > gõ chữ vào. 

Định dạng màu sắc, đường viền, kích thước cho các đối tượng trên: Nhấp đúp chuột 

chọn đối tượng > Shape Styles > tùy chỉnh trong mục Shape Fill, Shape Outline, 

Shape Effects. 

Bước 2: Tạo và định dạng hiệu ứng cho các đối tượng 



− Các nấc thang: Chọn đối tượng > Add Effect > Emphasis > Change Fill Color. 

Mục Start: On Click 

Fill: Chọn màu sẽ chuyển 

Speed: Fast 

Trong thẻ Timing, bỏ chọn Smooth Start, Smooth End. 

− Hình ảnh Mendeleev và Marie Curie: Chọn đối tượng > Add Effect > Motion 

Paths > Turn Up Right. Sau đó, dùng chuột kéo để xác định điểm đầu và điểm 

kết thúc hiệu ứng di chuyển. 

Mục Start: On click 

Path: Unclocked 

Speed: Medium 

 
− Chữ “Chiến Thắng”: Chọn đối tượng > Add Effect > Entrance > Descend. 

Mục Start: On Click 

Speed: Fast 

− Chữ “Chiến Thắng”: Chọn đối tượng > Add Effect > Emphasis > Flash Bulb. 

Mục Start: After Previous 

Speed: Fast 

Bước 3: Tạo triggers cho các đối tượng 

Khi nhấp chuột vào nấc thang thì nấc thang sẽ chuyển sang màu xanh để ấn định 

nấc thang đó đã được leo lên. 



− Chọn nấc thang vào thẻ Timing > Triggers > Start effect on click of > chọn tên 

hiệu ứng của nấc thang đó. 

Khi nhấp chuột vào hình Mendeleev và Marie Curie, thì nó sẽ di chuyển lên 1 bậc 

thang.   

− Chọn hình Mendeleev vào thẻ Timing > Triggers > Start effect on click of > 

chọn tên hiệu ứng của chính nó. 

− Tương tự hình Marie Curie: Chọn đối tượng vào thẻ Timing > Triggers > Start 

effect on click of > chọn tên hiệu ứng của chính nó. 

Bước 4: Tạo slide nội dung câu hỏi 

 
− Tạo các Text box chứa nội dung câu hỏi và các đáp án.  

− Tạo hiệu ứng: Entrance > Descend cho các Text box. 

− Tạo triggers cho các Text box câu hỏi với nút lệnh  và Text box đáp 

án với đối tượng . 

− Tạo liên kết tới slide chủ khi nhấp chuột vào đối tượng . Tương tự sao 

chép slide và thay đổi nội dung câu hỏi để tạo các slide câu hỏi tiếp theo. 

− Ý nghĩa: Việc tạo các liên kết tới slide chủ sẽ tạo ra một trò chơi logic, 

thống nhất. Trò chơi này rất dễ chỉnh sửa, giáo viên chỉ cần thay đổi nội dung, số 

lượng, dạng câu hỏi ở lần chơi tiếp theo. 



Những nội dung có thể áp dụng: Trò chơi này có thể áp dụng để ôn tập, củng 

cố lí thuyết cho học sinh ở các phần câu hỏi về ứng dụng, sản xuất, về hiện tượng, 

giải thích,…GV có thể cho học sinh ôn tập, trả lời theo nhóm hoặc cá nhân. 

2.5.2. Trò chơi được thiết kế bằng phần mềm Hot Potatoes 6 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Hình 2.23.  Sơ đồ nội dung phần mềm Hot Potatoes 6 

Phần mềm Hot Potatoes 6 

Giới thiệu 
tổng quan 

Hướng dẫn 
cơ bản 

Hướng dẫn 
nâng cao 

 

Trò chơi 
tham khảo 

Luyện tập 
kiểm tra 

Cài đặt 
phần mềm 

Giới thiệu phần mềm  

JMatch 

JMix 
 

Trò chơi ô chữ 

Sắp xếp thế điện cực 
chuẩn của kim loại 

Ghép hình dụng cụ 
thí nghiệm 

Tìm chất chưa biết 

Trắc nghiệm hóa học 

Sắp xếp  
nguyên tố hóa học 

Hoàn thành phương 
trình phản ứng 

Xây dựng 
 bảng tuần hòan 

 

JQuiz 
 

JCloze 

JCross 
 

The Masher 
 

Snipping Tool 

Tài liệu hướng dẫn 
 

(8 mẫu và ý tưởng 
trò chơi) 



Ở phần mềm này, chúng tôi cũng đưa ra 6 nội dung chính: Giới thiệu tổng 

quan, cài đặt phần mềm, hướng dẫn cơ bản, hướng dẫn nâng cao, trò chơi tham 

khảo và luyện tập-kiểm tra. Giới thiệu tổng quan là một đoạn phim mô tả chung về 

6 công cụ chính của Hot Potatoes 6, kèm theo là các slide trình bày ưu, nhược điểm, 

một số lưu ý khi làm việc với các công cụ của Hot Potatoes 6.  

Chúng tôi quay các đoạn phim hướng dẫn từ cài đặt đến các thao tác cơ bản 

trong phần mềm Hot Potatoes 6 cũng như hướng dẫn cách thiết một số mẫu trò 

chơi. Hệ thống phim hướng dẫn các thao tác cơ bản bao gồm 25 đoạn phim trong đó 

được chia thành: 

− Giới thiệu về giao diện phần mềm Hot Potatoes 6. 

− Các thao tác cơ bản khi làm việc với 6 công cụ của Hot Potatoes 6: JCross, 

JQuiz, JMix, JCloze, JMatch, The Masher. Gồm các phim: 

• Giới thiệu giao diện từng công cụ. 

• Các thao tác chính khi làm việc trong JCross, JMix được thực hiện theo 3 

bước: 

o Nhập và ghi nội dung dữ liệu 

o Thay đổi cấu hình trang HTML 

o Xuất dữ liệu thành dạng web 

• Công cụ Snipping Tool. 

Vì phần mềm Hot Potatoes 6 không hỗ trợ viết và vẽ công thức hóa học, vì thế 

nếu trong nội dung thiết kế có các công thức hóa học, cách tốt nhất là nên thực hiện 

thao tác chuyển chúng thành các tập tin hình ảnh và lưu với tên không dấu và không 

có dấu cách rồi dùng lệnh Insert picture from file để chèn như hình ảnh. Chính vì 

thế công cụ Snipping Tool do Windows 7 cung cấp cho phép chuyển bất kì đối 

tượng nào trên màn hình thành dạng tập tin hình ảnh. 

Hệ thống 10 đoạn phim hướng dẫn các thao tác thiết kế một số trò chơi điển 

hình như trò chơi ô chữ, sắp xếp dãy thế điện cực chuẩn của kim loại, ghép hình 

dụng cụ thí nghiệm hóa học. 



Ngoài các hướng dẫn cơ bản, nâng cao chúng tôi còn sưu tầm và thiết kế sẵn 

những mẫu trò chơi, ý tưởng thiết kế để người dùng tham khảo: 

− Trắc nghiệm hóa học 

− Trò chơi ô chữ 

− Tìm chất chưa biết 

− Xây dựng bảng tuần hoàn 

− Sắp xếp dãy thế điện cực chuẩn của kim loại 

− Hoàn thành phương trình phản ứng 

− Ghép hình dụng cụ thí nghiệm hóa học 

 
Hình 2.24. Trang trò chơi “Ghép hình dụng cụ thí nghiệm hóa học” 

Trong phần mềm Hot Potatoes 6 có 6 công cụ chính, ứng với mỗi công cụ 

chúng ta có thể thiết kế được một số trò chơi. Sở dĩ, chúng tôi quyết định hướng dẫn 

thiết kế trò chơi ô chữ và trò chơi “Sắp xếp dãy thế điện cực chuẩn của kim loại” vì 

2 trò chơi này được thiết kế bằng công cụ JCross và JMix quen thuộc và thông qua 

trò chơi, người đọc sẽ nắm được các kỹ năng cơ bản thường sử dụng để thiết kế các 

mẫu trò chơi trong Hot Potatoes 6. 

2.5.2.1. Trò chơi ô chữ 



Trò chơi ô chữ được thiết kế bằng công cụ JCross, đây là trò chơi đơn giản, 

quen thuộc, GV thường hay sử dụng trong dạy học hóa học. Thông qua hướng dẫn, 

người đọc có thể nắm được các bước thiết kế một trò chơi ô chữ vừa nhanh lại đẹp, 

hấp dẫn. Mặt khác, người đọc còn biết được các kỹ thuật chính như nhập tiêu đề 

cho trò chơi, tạo ô chữ theo cách thủ công hoặc tự động, chỉnh màu sắc, định dạng 

trang giao diện HTML khi xuất ra, các phản hỏi, thông báo hiển thị, thiết lập thời 

gian khi làm bài. 

 Mục đích 

− Gây hứng thú cho học sinh trong việc vận dụng các kiến thức hóa học đã tiếp 

thu để đi tìm các từ khóa trong mỗi ô chữ. 

− Làm cho việc khắc sâu kiến thức của học sinh diễn ra nhẹ nhàng nhưng thoải 

mái. 

− Rèn luyện tính tự lực, chủ động khi giải quyết vấn đề hoặc kỹ năng hợp tác 

nhóm nhỏ, cùng khám phá các kiến thức ẩn sau mỗi ô chữ. 

 Luật chơi 

− Hoàn thành các ô chữ bằng cách gõ đáp án vào khung và nhấn “Enter”, sau đó 

nhấp nút “Kiểm tra” để kiểm tra đáp án.  

− Nếu gặp khó khăn, người chơi có thể nhấp nút “Gợi ý” để biết một từ khóa có 

trong ô chữ. Chú ý, khi chấp nhận gợi ý người chơi sẽ bị trừ điểm.  

− Nhấp vào con số ở các hàng ngang, hàngdọc để thấy nội dung câu hỏi của từ 

khóa. 

− Chú ý, mỗi ô chữ sẽ có quy định thời gian tối đa hoàn thành. 

 Thiết kế trò chơi 



 
Hình 2.25. Trang trò chơi ô chữ 

Khởi động phần mềm Hot Potatoes 6, chọn công cụ JCross để tạo trò chơi ô chữ. 

Bước 1: Nhập và ghi nội dung dữ liệu 

− Nhập nội dung tiêu đề trò chơi vào khung “Title”. 

 
− Nhập từ khóa của ô chữ: Có 2 cách  

 
+ Nhập ô chữ tự động nhờ chức năng “Auto Manage grid maker” cho phép tạo 

trò chơi ô chữ rất đơn giản, người thiết kế chỉ cần liệt kê các từ khóa trong màn hình 

soạn thảo, mỗi từ trên một dòng, chỉnh kích thước ô chữ trong khung

 và chọn chức năng “Make the grid” JCross sẽ tự 

động tạo ra ô chữ có các từ khóa cần tìm. 

+ Đánh chữ vào mỗi ô trên vùng làm việc của 

JCross. Người thiết kế có thể tùy ý sắp xếp 

hình dạng của ô chữ. 

 



 
− Nhập nội dung câu hỏi 

Chọn Add Clues > hộp thoại Add Clues sẽ hiện ra. Nhập nội dung câu hỏi tương 

ứng với từng ô chữ ở hàng ngang, dọc. 

 
Bước 2: Thay đổi cấu hình trang HTML 

− Chỉnh kiểu chữ (font), cỡ chữ (size) vào Options menu > Font. 

− Thay đổi giao diện trang HTML vào Options menu > Configure Output > xuất 

hiện hộp thoại Configuration. 



 
+  Thẻ lệnh Titles/Instructions: Nhập tiêu đề và các hướng dẫn cách thức hoàn 

thành ô chữ. 

+  Thẻ Prompts/Feedback: Việt hoá các thông báo hiển thị khi trả lời đúng-sai đáp 

án, hay các tiêu đề phụ khác. 

 

 

 

 
+  Thẻ Buttons: Việt hoá các nút công cụ trên trang HTML. 

Gợi ý hàng ngang có nội dung như sau: 

Gợi ý hàng dọc có nội dung như sau: 

Hiển thị thông báo khi trả lời đúng. 

Hiển thị số điểm đạt được. 



 
Cho phép ẩn/hiện thị các nút chuyển qua trang tiếp theo hay quay lại trang 

trước đó trong trang HTML. 

 
+  Thẻ Appearance: Thay đổi giao diện trang HTML (nền, màu chữ, cỡ chữ,…). 

 
Chọn nền (Background) trang web từ một trang URL trên mạng hoặc có trong 

máy, kiểu chữ (Font), cỡ chữ khi xuất ra. 

Ngoài ra, người thiết kế có thể thay đổi màu sắc các đối tượng khác trên trang 

HTML. 

 

Nút kiểm tra đáp án “Kiểm tra” 

Nút nhập đáp án “Enter” 

Nút hoàn tất “OK” 

Cho phép ẩn/hiện thị nút gợi ý  

  
 

Màu sắc thanh trang chủ. 

Màu sắc nền trang web. 

Màu sắc tiêu đề . 

Màu sắc ô chữ. 

Màu sắc chữ trên trang web. 

 



+  Thẻ Timer: Thiết lập thời gian hoàn thành ô chữ. 

 
+  Thẻ Other: Thiết lập các thông số khác. 

Phân biệt đáp án chữ hoa thường. 

Hiển thị tất cả gợi ý phía dưới ô chữ. 

 
Bước 3: Xuất dữ liệu dưới dạng web 

− Cách 1: Vào lệnh File > chọn Create Web page, Create Zip Package hoặc 

Create SCORM 1.2 Package. 

 

− Cách 2: Nhấp giữ phím F6 hoặc nhấp chọn nút lệnh  trên thanh công cụ. 



2.5.2.2.  Trò chơi “Sắp xếp dãy thế điện cực chuẩn của kim loại” 

Trò chơi “Sắp xếp dãy thế điện cực chuẩn của kim loại” được thiết kế bằng 

công cụ JMix, đây là trò chơi hay, đơn giản, giúp học sinh nhớ dãy thế điện cực 

chuẩn của kim loại dễ dàng và nhanh chóng. Thông qua hướng dẫn người đọc biết 

được các kỹ thuật chính như nhập tiêu đề, chèn hình ảnh, chỉnh màu sắc, định dạng 

trang giao diện khi xuất ra, các phản hỏi, thông báo hiển thị, thiết lập thời gian khi 

làm bài. Đặc biệt, chúng tôi quyết định hướng dẫn trò chơi này, vì phần mềm Hot 

Potatoes 6 không cho phép viết công thức hóa học, nên cách khắc phục là chuyển 

chúng thành tập tin hình ảnh rồi chèn vào nên thông qua trò chơi, người đọc sẽ làm 

quen được cách tạo Table, gõ công thức hóa học trong Math Type và dùng công cụ 

Snipping Tool do Windows 7 cung cấp để chuyển một đối tượng trên màn hình vi 

tính thành hình ảnh. 

 Mục đích 

− Luyện tập sắp xếp dãy thế điện cực chuẩn của kim loại theo chiều tăng dần thế 

điện cực chuẩn. 

− Giúp học sinh nhớ dãy thế điện cực chuẩn của kim loại dễ dàng và nhanh 

chóng. 

 Luật chơi 

− Có 4 mức chơi, tương ứng với sự tăng dần số cặp oxi hóa-khử của kim loại từ 

5-10-15-20 trong mỗi mức. 

− Người chơi hãy nhấp chuột vào tên của các cặp oxi hóa-khử của kim loại để sắp 

xếp chúng theo chiều tăng dần thế điện cực chuẩn. 

− Khi bạn chắc chắn rằng bạn đã sắp xếp đúng hãy nhấp vào nút "Kiểm tra" để 

xem bạn được bao nhiêu điểm.  

− Người chơi có thể nhấp vào nút "Gợi ý" để được giúp đỡ và bạn sẽ bị trừ điểm. 

− Nhấp vào nút "Quay lại" để trở lại thao tác trước. Nhấn nút "Bắt đầu" để chơi 

lại. 

 Thiết kế trò chơi 



 
Hình 2.26. Trang trò chơi “Sắp xếp dãy thế điện cực chuẩn của kim loại” 

Khởi động phần mềm Hot Potatoes 6, chọn công cụ JMix để bắt đầu thiết kế. 

Để thiết kế trò chơi này, trước tiên người thiết kế phải gõ các công thức hóa học của 

20 cặp oxi hóa-khử Mn+/M trên Word. Kẻ bảng để thống nhất kích thước hình ảnh 

các công thức hóa học của 20 cặp oxi hóa-khử Mn+/M khi xuất ra. 

Chọn Insert > Insert table > xuất hiện hộp thoại Table. 

   
Dùng chuột kéo điều chỉnh kích thước của các ô trong Table phải bằng nhau.  

Chọn nét đậm cho viền Table: Nhấp chuột phải vào Table > Chọn Borders and 

Shading xuất hiện hộp thoại Borders and Shading. 

+ Số cột: 7 

+ Số hàng: 3 



 
Nhập công thức hóa học của 20 cặp oxi hóa-khử Mn+/M vào mỗi ô của Table 

bằng công cụ Math Type. 

Nhấp chuột vào nút lệnh Math Type trên thanh công cụ Microsoft Office 

Word 2007 > hộp thoại Math Type hiện ra. 

 

+ Ở Tab Style: Chọn kiểu 

viền Table. 

+ Ở Tab Color: Chọn màu 

đường viên khung Table. 

+ Ở Tab Width: Chọn bề dày 

khung Table. 

Ví dụ: Style: Nét liền 

Color: Màu nâu đỏ 

Width: 3 pt 



 
 Khởi động chương trình Snipping Tool do Windows 7 cung cấp: Vào Start > All 

programs > Accessories > Snipping Tool > Hộp thoại Snipping Tool xuất hiện. 

 
Dùng chuột kéo chọn khung nội dung cần chuyển thành hình ảnh.  

Chú ý: Chọn đường dẫn lưu tập tin hình ảnh trên máy tính và lưu với tên không dấu 

và không dấu cách. 

Bước 1: Nhập và ghi nội dung dữ liệu 

Nhập nội dung tiêu đề trò chơi vào khung “Title”. 

 
Nhập công thức hóa học của 20 cặp oxi hóa-khử Mn+/M vào khung “Main 

sentence”: Vào Insert > Picture > Picture from Local File. Mỗi cặp oxi hóa-khử 

Mn+/M sẽ nằm trên mỗi dòng. 



 
Nhập công thức hóa học của 20 cặp oxi hóa-khử Mn+/M đúng theo thứ tự tăng dần 

thế điện cực chuẩn vào khung “Alternate sentence” bằng cách vào Insert > Picture > 

Picture from Local File. 

 
− Mức chơi thứ 1: Người chơi sẽ phải sắp xếp 5 cặp oxi hóa-khử Mn+/M đúng 

theo thứ tự tăng dần thế điện cực chuẩn. 

− Mức chơi thứ 2: Tăng thêm 5 cặp oxi hóa-khử Mn+/M nữa so với mức 1. 

− Mức chơi thứ 3: Tăng thêm 5 cặp oxi hóa-khử Mn+/M nữa so với mức 2. 

− Mức chơi thứ 4: Tăng thêm 5 cặp oxi hóa-khử Mn+/M nữa so với mức 3. 

JMix cho phép việc sắp xếp các cặp oxi hóa-khử Mn+/M không sử dụng hết toàn bộ 

các phần trong "Main sentence" hay không thông qua tùy chọn "Alow sentences 

which do not use all words and punctuation in main sentence". Nhưng người thiết 

kế phải chọn 1 trong 2 tùy chọn bên dưới như: 

- Cho phép câu không sử dụng tất cả các từ và dấu chấm câu trong câu. 

- Cảnh báo nếu câu lựa chọn không sử dụng tất cả các từ và dấu chấm câu. 

 
Bước 2: Thay đổi cấu hình trang HTML 

− Chỉnh kiểu chữ (font), cỡ chữ (size) vào Options menu > Font. 

− Thay đổi giao diện trang HTML vào Options menu > Configure Output > xuất 

hiện hộp thoại Configuration.  



 
+  Thẻ lệnh Titles/Instructions: Nhập tiêu đề và hướng dẫn cách sắp xếp dãy thế 

điện cực chuẩn của kim loại. 

+  Thẻ Prompts/Feedback: Việt hoá các thông báo hiển thị khi trả lời đúng-sai, đáp 

án, hay các tiêu đề phụ khác. 

    
+  Thẻ Buttons: Việt hoá các nút công cụ trên trang HTML. 

Hiển thị thông báo khi trả lời đúng. 

Hiển thị thông báo khi trả lời sai. 

Số câu trả lời đúng. 

Từ khóa đúng tiếp theo. 

Hiển thị số điểm đạt được. 

 
 



 
Cho phép ẩn/hiện thị các nút chuyển qua trang tiếp theo hay quay lại trang 

trước đó trên trang HTML. 

 
+  Thẻ Appearance: Thay đổi giao diện trang HTML (nền, màu chữ, cỡ chữ,…). 

+  Thẻ Timer: Thiết lập thời gian hoàn thành trò chơi. 

+  Thẻ Other: Thiết lập các thông số khác. 

Các thông số trong các thẻ lệnh Appearance, Timer, Other, việc thiết lập sẽ thực 

hiện giống như công cụ JCross. 

Bước 3: Xuất dữ liệu dưới dạng web 

− Cách 1: Vào lệnh File > chọn Create Web page, Create Zip Package hoặc 

Create SCORM 1.2 Package. 

 

Nút kiểm tra đáp án “Kiểm tra”. 

Nút nhập đáp án “Enter”. 

Cho phép ẩn/hiện nút quay lại. 

Cho phép ẩn/hiện nút bắt đầu. 

Cho phép ẩn/hiện nút gợi ý. 
 



Có 2 chế độ xuất ra:  

- Drag/drog Format: Xuất thành tập tin HTML dạng kéo thả chuột để sắp xếp. 

- Standard Format: Xuất thành tập tin HTML dạng sắp xếp bằng cách nhấp chuột 

tuần tự vào các cụm từ. 

− Cách 2: Nhấp giữ phím F6, Ctrl + F6 hoặc nhấp chọn nút lệnh , trên 

thanh công cụ. 

2.5.3. Trò chơi được thiết kế bằng phần mềm ProShow Gold  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Hình 2.27. Sơ đồ nội dung phần mềm ProShow Gold 

Trình bày về phần mềm ProShow Gold trong E-Book, chúng tôi đưa ra các nội 

dung chính sau: Giới thiệu phần mềm, các hướng dẫn từ cài đặt phần mềm đến một 

số các thao tác cơ bản trong ProShow Gold. 

Nội dung trình bày chính ở phần này tập trung hướng dẫn cách chèn hình ảnh, 

đoạn phim, kèm theo là thao tác định dạng, xử lí trước khi xuất thành đoạn phim 

hoàn chỉnh.  

Phần mềm ProShow Gold 

Giới thiệu 
tổng quan 

Hướng dẫn 
cơ bản 

Hướng dẫn 
nâng cao 

 

Trò chơi 
tham khảo 

Luyện tập 
kiểm tra 

Cài đặt 
phần mềm 

Giới thiệu phần mềm 

Chèn các đối tượng 
 

Định dạng đối tượng 
 

Đoạn phim thiết kế 
bằng ProShow Gold 

ProShow Gold kết 

hợp với PowerPoint 

Chuyển Slide 
PowerPoint thành 

hình ảnh 
Xuất thành đoạn phim 

 

 Tài liệu hướng dẫn 
 

 



 
Hình 2.28. Trang hướng dẫn cơ bản các thao tác trong ProShow Gold 

Đặc biệt ở phần này, chúng tôi có quay đoạn phim hướng dẫn cách chuyển 

một đối tượng trên slide hoặc cả slide PowerPoint thành hình ảnh. 

 
Hình 2.29. Đoạn phim hướng dẫn chuyển slide PowerPoint thành hình ảnh 

Tuy nhiên, với mục tiêu hỗ trợ người dùng có ý tưởng xây dựng các đoạn 

phim có nội dung phong phú để dùng cho các dạng trò chơi. Chúng tôi đã sưu tầm 

và thiết kế được 15 đoạn phim có nội dung phong phú. 



 
Hình 2.30. Trang trò chơi tham khảo, một số đoạn phim chứa nội dung mẫu 

Bên cạnh đó, ở mỗi phần mềm đều có trang “Luyện tập-Kiểm tra” giúp người 

dùng có thể tự luyện tập, kiểm tra kỹ năng của mình. 

 
Hình 2.31. Trang luyện tập-kiểm tra 

2.6. Một số ý tưởng trò chơi được giới thiệu trong E-Book 

 Một số ý tưởng trò chơi sử dụng trong dạy học hóa học có thể được sử dụng 

dùng để củng cố kiến thức trong các bài luyện tập hóa học. Bởi bài luyện tập hóa 



học là một trong những dạng bài mà khi chúng ta soạn giảng bằng giáo án điện tử, 

hay các phần mềm chuyên dụng khác sẽ hiệu quả hơn rất nhiều so với phương pháp 

truyền thống. Vì chúng ta có thể thiết kế nhiều dạng câu hỏi trắc nghiệm khác nhau, 

hoặc lồng ghép nội dung bài học vào hình thức trò chơi học tập để gây hứng thú học 

tập cho học sinh mà không cần phải chuẩn bị các đồ dùng học tập kèm theo và GV 

có nhiều thời gian hơn trong việc hướng dẫn học sinh vận dụng tri thức bởi vì hệ 

thống câu hỏi hay các yêu cầu của GV đã được thể hiện thông qua hình thức các trò 

chơi và biểu diễn trên các chương trình, khi đó học sinh cả lớp sẽ tập trung cùng 

theo dõi các hoạt động luyện tập hơn. 

Mặt khác, thông qua kết quả khảo sát đối với SV, GV chúng tôi nhận thấy một 

trong những nguyên nhân làm SV, GV ngại thiết kế các trò chơi hóa học có ứng 

dụng CNTT trong dạy học hóa học hiện nay là do chưa có ý tưởng trò chơi phù hợp, 

chưa có tài liệu hướng dẫn và mẫu trò chơi tham khảo. Vì thế, trong mỗi trang phần 

mềm giới thiệu trong E-Book chúng tôi đều thiết kế một trang con là “Trò chơi 

tham khảo”. Đây là nơi cung cấp các mẫu trò chơi, ý tưởng trò chơi, luật chơi,… 

được chúng tôi thiết kế và sưu tầm được. Các mẫu trò chơi có thể sử dụng được 

trong dạy học hóa học và đặc biệt là được thiết kế bằng những phần mềm giới thiệu 

trong E-Book. Cụ thể:  

Trang trò chơi tham khảo ở phần mềm PowerPoint gồm 55 mẫu, ý tưởng trò chơi: 

 



 
Hình 2.32. Hình ảnh một số biểu tượng mẫu, ý tưởng trò chơi có trong E-Book 

Trang trò chơi tham khảo ở phần mềm Hot Potatoes 6 gồm 8 mẫu, ý tưởng trò chơi: 

− Các mẫu trò chơi: Trò chơi ô chữ, sắp xếp dãy thế điện cực chuẩn của kim 

loại, ghép hình dụng cụ thí nghiệm hóa học, sắp xếp nguyên tố hóa học,… 

− Các ý tưởng trò chơi: Trắc nghiệm hóa học, hoàn thành phương trình phản 

ứng, tìm chất chưa biết, xây dựng bảng tuần hoàn,… 

Trang trò chơi tham khảo ở phần mềm ProShow Gold gồm 15 đoạn phim, mỗi đoạn 

phim là một hình thức nội dung, cung cấp cho người xem ý tưởng để thiết kế các 

đoạn phim. 

 
Hình 2.33. Một đoạn phim tham khảo trong trang phần mềm ProShow Gold 



Mặt khác, đây còn là nơi xây dựng hệ thống các trò chơi dùng để củng cố kiến 

thức (các trò chơi lớn như một Gameshow,…); các trò chơi rèn luyện kỹ năng giải 

bài tập; các trò chơi dùng để ôn tập chung;… 

2.7. Một số định hướng sử dụng E-Book 

E-Book “ỨNG DỤNG CÔNG NGHỆ THÔNG TIN ĐỂ THIẾT KẾ TRÒ 

CHƠI TRONG DẠY HỌC HÓA HỌC” được chúng tôi xây dựng nhằm hỗ trợ GV, 

SV sư phạm rèn luyện và nâng cao kỹ năng ứng dụng các phần mềm để thiết kế trò 

chơi dạy học theo 2 hướng:  

1. Hỗ trợ việc tự học có hướng dẫn của SV sư phạm trong học phần ứng 

dụng CNTT trong dạy học hóa học. Hiện nay SV sư phạm được đào tạo theo hệ 

thống tín chỉ, thời gian học trên lớp ít. Mặt khác, môn ứng dụng CNTT trong dạy 

học hóa học hiện nay (tương ứng 2 tín chỉ hoặc 30 tiết) có khối lượng kiến thức 

nhiều, phong phú nên đòi hỏi việc tự học của SV nhiều. Vì vậy, E-Book sẽ giúp SV 

bổ trợ những kiến thức mà GV chưa truyền đạt, hướng dẫn lại một lần nữa giúp SV 

khắc sâu kiến thức hơn và phát huy tính sáng tạo. 

2. Tài liệu tham khảo để tự học, rèn luyện và nâng cao kỹ năng ứng dụng 

CNTT để thiết kế trò chơi dạy học hóa học của GV và SV. Cụ thể: 

- Đối với người đã biết thiết kế trò chơi hóa học bằng các phần mềm được giới 

thiệu trong E-Book, đây có thể là một phương tiện giúp người dùng có thể củng cố 

và mở rộng kiến thức khi người dùng tham chiếu đến mục “Luyện tập-Kiểm tra” ở 

bất kì phần mềm nào. Ngoài ra, nếu người dùng chưa có ý tưởng trò chơi hoặc chưa 

có tài liệu tham khảo thì người dùng có thể tham chiếu đến kho “Trò chơi tham 

khảo” cũng có ở bất kì trang chủ của phần mềm. Hơn nữa, có nhiều chức năng của 

các phần mềm mà người dùng chưa biết thì E-Book này có thể bổ sung thêm kiến 

thức cho người dùng. 

- Đối với người chưa biết thiết kế trò chơi hóa học có ứng dụng CNTT, E-

Book này sẽ là công cụ hữu hiệu giúp GV, SV nhanh chóng học được cách sử dụng 

hoặc cải thiện thêm thao tác làm việc với các phần mềm có trong E-Book. Ngoài ra, 

với các đoạn phim hướng dẫn cách thiết kế một số trò chơi hay, đơn giản sẽ giúp 



người dùng từng bước có thể tự mình thiết kế ra những trò chơi và sử dụng trong 

dạy học hóa học. Mặt khác, kho tư liệu về trò chơi mẫu và ý tưởng trò chơi trong E-

Book có thể giúp người dùng phát huy sự sáng tạo trong quá trình thiết kế trò chơi. 

Với giao diện trực quan, sinh động cùng với các hướng dẫn chi tiết, chúng tôi 

hy vọng E-Book này sau khi được hoàn thiện và xuất bản sẽ phát huy được hết các 

chức năng mà người xây dựng mong muốn trong việc hỗ trợ SV sư phạm hình 

thành cũng như GV ở THPT, rèn luyện và nâng cao kỹ năng ứng dụng các phần 

mềm để thiết kế trò chơi trong dạy học hóa học. 



CHƯƠNG 3. THỰC NGHIỆM SƯ PHẠM 

2.6.  Mục đích thực nghiệm 

Đánh giá tính khả thi và tính hiệu quả của E-Book trong việc hỗ trợ GV, SV 

sư phạm hình thành, rèn luyện và nâng cao kỹ năng ứng dụng các phần mềm để 

thiết kế trò chơi trong dạy học hóa học. 

• Tính khả thi được thể hiện qua: Số lượng SV sử dụng E-Book và ứng 

dụng CNTT để thiết kế các trò chơi trong dạy học hóa học. 

• Tính hiệu quả được thể hiện qua: Sự đánh giá cao của SV sư phạm về hình 

thức, cấu trúc cũng như nội dung của E-Book (đánh giá thông qua “Phiếu khảo sát ý 

kiến SV sau khi sử dụng E-Book”). Chất lượng và số lượng trò chơi mà SV thiết kế 

trong học phần ứng dụng CNTT trong dạy học hóa học (đánh giá thông qua “Phiếu 

khảo sát ý kiến SV sau khi sử dụng E-Book” và sản phẩm trò chơi, hồ sơ bài dạy mà 

SV thiết kế được). 

2.7.  Nội dung thực nghiệm 

Để thực hiện được mục đích TN trên phải triển khai các công việc sau: 

Chúng tôi đã tiến hành TNSP trong học phần ứng dụng CNTT trong dạy học 

hóa học vào học kì I năm học 2012-2013, cụ thể: 

Bảng 3.1. Bảng thông tin về nhóm TN và đối chứng (ĐC)  

Lí do để chọn đối tượng thực nghiệm: 

− SV sư phạm có chất lượng học tập tốt và tương đối đồng đều (thông qua điểm 

học phần tin học đại cương). 

− Trình độ giữa nhóm ĐC và TN khá đều nhau nên công bằng trong việc so sánh, 

đối chứng kết quả. 

− SV đang học học phần ứng dụng CNTT trong dạy học hóa học. 

Lớp TN Lớp ĐC GV phụ trách 

K35A-nhóm 2 (19SV) 

K35B-nhóm 2 (20SV) 

K35A-nhóm 1 

K35B-nhóm 1 

Thầy Trịnh Lê Hồng Phương 

Cô Thái Hoài Minh 



− Lớp có trang thiết bị dạy học đầy đủ. Đa số SV đều có máy tính nên đáp ứng 

được các yêu cầu thiết bị để tiến hành việc sử dụng E-Book. 

2.8.  Tiến hành thực nghiệm 

− Ở lớp ĐC: SV không sử dụng E-Book, GV sử dụng PPDH truyền thống. 

− Ở lớp TN: Khi SV học về nội dung thiết kế trò chơi, chúng tôi tiến hành 

hướng dẫn SV kỹ năng thiết kế trò chơi qua các bước: 

Bước 1: Tổ chức cho SV tham gia trò chơi “ĐUA NGỰA” được thiết kế bằng 

phần mềm Microsoft Office PowerPoint 2007. Sau đó chúng tôi hướng dẫn SV một 

số thao tác cơ bản để thiết kế trò chơi trong Microsoft Office PowerPoint 2007 nói 

chung (thao tác tạo triggers, tạo câu hỏi trắc nghiệm,...) và thao tác thiết kế trò chơi 

này. Sau đó SV được giới thiệu và hướng dẫn sử dụng E-Book “ỨNG DỤNG 

CÔNG NGHỆ THÔNG TIN ĐỂ THIẾT KẾ TRÒ CHƠI TRONG DẠY HỌC HÓA 

HỌC”. 

Bước 2: GV yêu cầu SV làm bài tập về nhà với nội dung “Thiết kế một trò 

chơi trong dạy học hóa học”. Sản phẩm trò chơi bao gồm luật chơi và mẫu trò chơi, 

có thể giống các mẫu có trong E-Book hoặc trò chơi mới. Thời gian thực hiện bài 

tập là 1 tuần, SV có thể sử dụng E-Book để tham khảo các ý tưởng và cách thực 

hiện trò chơi được gợi ý.  

Bước 3: Cuối học phần điều tra bằng phiếu khảo sát ý kiến SV sau khi sử 

dụng E-BOOK “ỨNG DỤNG CÔNG NGHỆ THÔNG TIN ĐỂ THIẾT KẾ TRÒ 

CHƠI TRONG DẠY HỌC HÓA HỌC”. 

Bước 4: Tiến hành thu các sản phẩm trò chơi và đánh giá theo hệ thống tiêu 

chí định sẵn. Chúng tôi cũng thu thập và đánh giá các hồ sơ bài dạy mà SV thiết kế 

để tham gia hội thi “Thiết kế hồ sơ bài dạy có ứng dụng CNTT năm học 2012-

2013” do trường ĐHSP TP.Hồ Chí Minh tổ chức. 

  



2.9.  Kết quả thực nghiệm 

 Thông qua phiếu khảo sát ý kiến của 35 SV sau khi sử dụng E-Book, 

chúng tôi thu được số liệu sau: 

Bảng 3.2. Kết quả nhận xét của SV về E-Book 

STT Tiêu chí đánh giá Mức độ TB 

1 2 3 4 

Hình thức, giao diện E-Book 

1 Thiết kế khoa học 0 8 15 12 3,11 

2 Giao diện đẹp, thân thiện 0 7 13 15 3,23 

3 Bố cục hợp lí, logic 0 5 16 14 3,26 

Tính khả thi 

1 Thao tác sử dụng E-Book 0 6 14 15 3,26 

2 Đáp ứng được nhu cầu người dùng 0 5 17 13 3,23 

3 Phù hợp với điều kiện thực tế 0 8 12 15 3,2 

(1: Không tốt, 2: Bình thường, 3: Tốt, 4: Rất tốt) 

Bảng 3.3. Kết quả nhận xét của SV sau khi sử dụng E-Book 

Tiêu chí đánh giá Phần mềm 
Mức độ TB 

1 2 3 

Đoạn phim hướng dẫn 

sử dụng các phần mềm 

trong E-Book 

Microsoft Office 

PowerPoint 2007 
0 11 24 

2,69 

Hot Potatoes 6 2 22 11 2,26 

ProShow Gold 1 21 13 2,34 

1. Khó hiểu, phức tạp           2. Bình thường      3. Dễ hiểu, dễ áp dụng 

  0 1 2 3  

Kỹ năng sử dụng các 
Microsoft Office 

PowerPoint 2007 
0 0 20 15 2,43 



phần mềm được hướng 

dẫn trong E-Book 

Hot Potatoes 6 2 5 20 8 1,97 

ProShow Gold 1 5 21 8 2,03 

0. Không biết sử dụng 1. Biết sử dụng sơ lược     2.  Căn bản      3. Thành thạo 

Hình thức là ấn tượng đầu tiên mà người dùng quan tâm khi xem một E-Book. 

Chính vì vậy, nó đóng một vai trò vô cùng quan trọng trong việc hấp dẫn người 

dùng. Qua khảo sát, SV nhận xét giao diện E-Book được thiết kế đẹp, thân thiện, bố 

cục hợp lí và khoa học (trung bình đạt từ mức độ 3 trở lên). Chắc chắn rằng, không 

thể mong một sự hoàn hảo vì mỗi SV có một cách nhìn thẩm mỹ khác nhau. Nhưng 

nhìn chung, E-Book đã cơ bản đáp ứng được yêu cầu về hình thức.  

Tính khả thi là nguyên tắc cơ bản của một E-Book, nó phải được thiết kế sao 

cho dễ sử dụng, đáp ứng được nhu cầu của người dùng và phù hợp với điều kiện 

thực tế. Chính vì thế mà hầu hết các tiêu chí về tính khả thi đều được SV đánh giá 

cao, trung bình từ mức độ 3 trở lên và không có SV nào đánh giá dưới mức 2. Cho 

nên, xét về tổng thể thì E-Book cũng đã đạt yêu cầu về tính khả thi. 

Về nội dung, hệ thống các đoạn phim hướng dẫn sử dụng các phần mềm được 

giới thiệu trong E-Book hầu hết đều được SV cho rằng là cơ bản, dễ hiểu và dễ thực 

hiện, đáp ứng được yêu cầu. Cụ thể qua kết quả TN mà SV đánh giá sau một thời 

gian sử dụng: 

− Phần mềm Microsoft Office PowerPoint 2007: 31,43%  SV cho rằng đáp ứng 

được yêu cầu căn bản; 68,57% SV cho rằng dễ hiểu, dễ thực hiện và không có SV 

cho rằng đoạn phim hướng dẫn khó hiểu, phức tạp. 

− Phần mềm Hot Potatoes 6: 63,86% SV nhận xét ở mức độ căn bản; 31,42% 

SV cho rằng dễ hiểu, dễ thực hiện và một số ít đánh giá là khó hiểu, phức tạp 

5,71%. 

− Phần mềm ProShow Gold: 60,0% SV đánh giá đoạn phim hướng dẫn ở mức 

độ căn bản; 37,14% SV cho rằng đoạn phim hướng dẫn dễ hiểu, dễ thực hiện và 

2,86% SV đánh giá đoạn phim hướng dẫn là khó hiểu, phức tạp. 



Về tính hiệu quả của việc sử dụng E-Book, kỹ năng sử dụng các phần mềm 

được hướng dẫn trong E-Book của SV sau thời gian đều đạt ở mức độ căn bản trở 

lên. Cụ thể: 

 
Hình 3.1. Biểu đồ thể hiện kỹ năng sử dụng phần mềm PowerPoint của SV trước và 

sau khi dùng E-Book 

 
Hình 3.2. Biểu đồ thể hiện kỹ năng sử dụng phần mềm Hot Potatoes 6 của SV trước 

và sau khi dùng E-Book 
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Hình 3.3. Biểu đồ thể hiện kỹ năng sử dụng phần mềm ProShow Gold của SV trước 

và sau khi dùng E-Book 

Như vậy, qua biểu đồ so sánh kỹ năng sử dụng các phần mềm của SV ở nhóm 

TN trước và sau khi sử dụng E-Book, chúng ta nhận thấy rằng kỹ năng sử dụng các 

phần mềm được giới thiệu trong E-Book của SV được nâng cao, tỉ lệ SV không biết 

sử dụng giảm xuống đồng thời tỉ lệ SV biết sử dụng sơ lược, bình thường hoặc 

thành thạo thì tăng lên. 

Về phần tư liệu trò chơi (ý tưởng trò chơi, các bài mẫu trò chơi,…) hầu hết SV 

đều nhận xét là ý tưởng trò chơi độc đáo; các bài mẫu trò chơi phong phú, đa dạng, 

công phu, dễ thiết kế; có giao diện đẹp, lôi cuốn, hiệu ứng đẹp mắt; dễ sử dụng, đáp 

ứng tốt cho yêu cầu của người sử dụng. Dựa trên nền tảng các mẫu trò chơi, người 

dùng có thể tham khảo, bổ sung, sáng tạo theo ý thích để có thể tạo ra những trò 

chơi mới thú vị hơn. Ngoài ra, có nhiều mẫu trò chơi hay, phù hợp để áp dụng vào 

một số bài, một số nội dung giảng dạy. Sau đây, chúng tôi cũng trích dẫn đoạn nhận 

xét của một SV ở nhóm TN Hóa 4A-Khóa 35 trường ĐHSP TP.Hồ Chí Minh: 

“Phần tư liệu trò chơi trong E-Book rất phong phú và đa dạng, có ứng dụng rất tốt 

cho quá trình dạy của GV và quá trình học của học sinh. Ý tưởng thiết kế trò chơi 

rất sáng tạo, mang nhiều tính xây dựng và phát triển. Ý tưởng tuy đơn giản nhưng 

lại có tính ứng dụng cao, dễ xây dựng và dễ áp dụng. Các bài mẫu trò chơi rất cụ 
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thể, sát thực tế, có hướng dẫn rõ ràng, giúp người dùng dễ sử dụng và từ các bài 

mẫu trò chơi đó, người đọc có thể phát triển để tạo ra những trò chơi khác có tính 

thực tiễn cao hơn”. Tuy nhiên, một số SV cũng chia sẻ cần bộ sung một số trò chơi 

khác cho E-Book phong phú hơn nữa, một số mẫu trò chơi còn đơn giản. 

Mặt khác theo kết quả khảo sát, chúng tôi cũng thu được kết quả sau: 

Với câu hỏi “Trong học phần môn ứng dụng CNTT trong dạy học hóa học, 

bạn đã sử dụng phần mềm nào trong E-Book để thiết kế trò chơi”. 

Bảng 3.4. Kết quả khảo sát việc sử dụng các phần mềm trong E-Book để thiết kế trò 

chơi của SV 

STT Tên phần mềm Số lượng SV Tỉ lệ  

1 Microsoft Office PowerPoint 2007 33 94,29% 

2 Hot Potatoes 6 8 22,86% 

3 ProShow Gold 4 11,43% 

4 Phần mềm khác…………………….. 0 0% 

Khi được hỏi “Bạn có thiết kế được trò chơi mới nào sau khi sử dụng E-Book 

không? Hãy liệt kê tên những trò chơi mới mà bạn thiết kế được” thì có 

 
Hình 3.4. Biểu đồ tỉ lệ SV thiết kế được trò chơi mới sau khi sử dụng E-Book 

Qua biểu đồ ta thấy, có 18/35 SV (51,43%) có thiết kế được trò chơi mới sau khi sử 

dụng E-Book, một số tên trò chơi mới mà SV thiết kế được như: 

51.43% 
48.57% 
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Không 



Bảng 3.5. Tên một số trò chơi mà SV thiết kế sau khi sử dụng E-Book 

STT Tên trò chơi Tên phần mềm thiết kế 

1 Phiếu trắc nghiệm Microsoft Office PowerPoint 2007 

Hot Potatoes 6 

2 Thỏ và rùa  

 

 

 

 

Microsoft Office PowerPoint 2007 

 

 

 

3 Đường đến vinh quang 

4 Chiếc cầu kì quái 

5 Trúc xanh 

6 Đua thuyền 

7 Truy tìm thủ lĩnh 

8 Xếp ngôi sao 

9 Đuổi hình bắt bóng 

10 Đấu trường 20 

11 Đi tìm chìa khóa 

12 Đố vui  

 

Hot Potatoes 6 

13 Ai thông minh hơn học sinh lớp 11 

14 Vui để học 

15 Trò chơi ô chữ 

16 Hãy chọn chất đúng 

17 Câu chuyện các nhà giả kim thuật  

ProShow Gold 18 Tạo đoạn phim cho lớp xem và mô tả  

Trong hội thi “Thiết kế hồ sơ bài dạy có ứng dụng CNTT” năm học 2012-

2013 đã có 20/35 SV (57,14%) SV sử dụng trò chơi vào bài giảng của mình. Một số 

trò chơi mà SV thiết kế và sử dụng trong hồ sơ bài dạy như: Ô chữ, thi trả lời ngắn, 

chiếc nón kì diệu, đấu trường 20, đố vui, xếp ngôi sao, truy tìm thủ lĩnh, đua xe, cờ 

cá ngựa…Hầu hết SV đều sử dụng các trò chơi cho các bài hoặc hoạt động luyện 



tập, củng cố, khắc sâu kiến thức hoặc kiểm tra bài cũ và tăng hứng thú nhận thức 

cho học sinh. 

 
Hình 3.5. Biểu đồ thể hiện tỉ lệ SV có sử dụng trò chơi vào trong hồ sơ bài dạy 

 Đánh giá dựa trên số lượng và chất lượng sản phẩm trò chơi, hồ sơ bài 

dạy mà SV thiết kế được sau khi sử dụng E-Book.  

Cuối học phần ứng dụng CNTT trong dạy học hóa học, chúng tôi tiến hành thu 

sản phẩm trò chơi, hồ sơ bài dạy của SV và tiến hành đánh giá số lượng, chất lượng 

theo tiêu chí: 7 điểm kỹ năng CNTT và 3 điểm kiến thức hóa học. 

Bảng 3.6. Bảng tiêu chí đánh giá sản phẩm trò chơi của SV thiết kế 

STT Tiêu chí đánh giá Thang 

điểm 

1 Có slide tên trò chơi. 0,5 

2 Có slide kết thúc trò chơi. 0,5 

3 Có luật chơi rõ ràng, dễ hiểu. 1 

4 Thiết kế giao diện trò chơi đẹp, thu hút, khoa học (kiểu chữ, cỡ 

chữ, màu chữ, nền, chèn nhạc, âm thanh,…). 

2 

5 Bài mẫu thiết kế khi trình chiếu không bị lỗi (liên kết, không chạy 

được,…). 

2 

6 Nội dung câu hỏi, đáp án trong trò chơi chính xác, khoa học, đúng 

với kiến thức hóa học. 

2 

7 Trò chơi gắn với nội dung bài học hóa học cụ thể ở trường THPT. 1 

8 Ý tưởng trò chơi mới hoặc có tính sáng tạo. 1 

57.14% 
42.86% 

Có 
Không 



Về sản phẩm trò chơi mà SV thiết kế, chúng tôi tiến hành đánh giá và nhận 

thấy rằng: 

Đối với SV được sử dụng E-Book: Các bạn mạnh dạn đăng kí bài tập thiết kế 

trò chơi, trò chơi thiết kế được rất phong phú, đa dạng về ý tưởng, đẹp và bắt mắt. 

Một số ý tưởng mà SV thiết kế được như: Thỏ và rùa; cá chép hóa rồng; đua xe; đi 

tìm thủ lỉnh; xếp ngôi sao; cờ cá ngựa; đường tới vinh quang; chiếc cầu kì quái;…và 

các trò chơi ngoài được thiết kế bằng phần mềm Microsoft Office PowerPoint còn 

có các phần mềm khác như Hot Potatoes 6. 

 
Hình 3.6. Một số slide mẫu trò chơi mà SV thiết kế bằng Microsoft Office 

PowerPoint 



 
Hình 3.7. Một số slide mẫu trò chơi mà SV thiết kế bằng Microsoft Office 

PowerPoint và Hot Potatoes 6 

Đối với SV không được sử dụng E-Book: Các bạn vì chưa có ý tưởng và hạn 

chế về kỹ năng CNTT nên không mạnh dạn đăng kí bài tập thiết kế trò chơi và SV 

chỉ có ý tưởng thiết kế trò chơi ô chữ bằng phần mềm Microsoft Office PowerPoint. 

Về hồ sơ bài dạy, chúng tôi cũng tiến hành đánh giá và nhận thấy rằng số 

lượng hồ sơ bài dạy có sử dụng trò chơi dạy học hóa học ở nhóm TN cao hơn 

(57,14%) ở nhóm ĐC. Ngoài ra, chất lượng hồ sơ bài dạy của SV có sử dụng E-

Book thiết kế được tương đối tốt hơn thông qua kết quả điểm cuối kì của SV trong 

học phần ứng dụng CNTT trong dạy học hóa học ở 2 nhóm TN và ĐC. 

Bảng 3.7. Bảng điểm cuối kì của SV 

Lớp Số học sinh Điểm xi TB 

0 1 2 3 4 5 6 7 8 9 10  

TN 39 0 0 0 0 0 0 1 5 11 19 3 8.46 

ĐC 41 0 0 0 0 0 3 1 13 14 9 1 7.68 

 



Bảng 3.8. Bảng phân phối tần số điểm cuối kì 

Điểm Số SV đạt điểm xi 

TN ĐC 

1 0 0 

2 0 0 

3 0 0 

4 0 0 

5 0 3 

6 1 1 

7 5 13 

8 11 14 

9 19 9 

10 3 1 

Bảng 3.9. Bảng phân phối tần suất điểm cuối kì 

Điểm % Số SV đạt điểm xi 

TN ĐC 

1 0 0 

2 0 0 

3 0 0 

4 0 0 

5 0 7.32 

6 2.56 2.44 

7 12.8 31.71 

8 28.21 34.15 

9 48.72 21.95 

10 7.69 2.44 

Tổng 100 100 



Bảng 3.10. Bảng phân phối tần số lũy tích 

Điểm % Số SV đạt điểm xi 

TN ĐC 

1 0 0 

2 0 0 

3 0 0 

4 0 0 

5 0 7.32 

6 2.56 9.76 

7 15.36 41.47 

8 43.57 75.62 

9 92.29 97.57 

10 100 100 

Tổng 100 100 

 

 
Hình 3.8. Đồ thị đường lũy tích điểm cuối kì 
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Bảng 3.11. Tổng hợp các tham số đặc trưng của điểm cuối kì 

(m: Sai số tiêu chuẩn; V: Hệ số biến thiên; S: Độ lệch chuẩn) 

Lớp  x m±  S V% t  ,ktα   

TN 8.46± 0.15 0.91 10.76 3.35 2.617 
ĐC 7.68± 0.18 1.15 14.97 

Kiểm tra kết quả TN bằng phép thử Student, tìm giá trị ,ktα với xác suất sai 

lầm α  (từ 0.01÷0.05) và k = n1 + n2 – 2. (n1, n2 số SV ở nhóm TN và ĐC). 

Nếu t≥ ,ktα , sự khác nhau giữa TNx và ĐCx là có ý nghĩa với mức ý nghĩa α  

Nếu t≤ ,ktα , sự khác nhau giữa TNx và ĐCx là không có ý nghĩa với mức ý nghĩa α  

Tra bảng phân phối Student tìm giá trị ,ktα , ta thấy t > ,ktα vì vậy sự khác nhau 

về kết quả điểm cuối kì giữa nhóm TN và ĐC là có ý nghĩa với mức ý nghĩa α = 

0.01 (bảng 3.11). Xét đồ thị đường lũy tích điểm cuối kì của nhóm TN và ĐC, ta 

thấy đường lũy tích của nhóm TN luôn nằm bên phải đường lũy tích của nhóm ĐC. 

Qua bảng thống kê, điểm trung bình của nhóm TN ( TNx = 8.46) lớn hơn điểm 

trung bình của nhóm ĐC ( ĐCx = 7.68). Giá trị sai số tiêu chuẩn m và hệ số biến thiên 

V của nhóm TN nhỏ hơn nhóm ĐC chứng tỏ sự so sánh về giá trị điểm trung bình ở 

hai lớp đáng tin cậy và số liệu ít phân tán. 

Tóm lại, từ kết quả khảo sát chúng tôi rút ra một số nhận xét: Số lượng SV 

tham gia thiết kế trò chơi ở nhóm TN cao hơn và trò chơi phong phú, đa dạng hơn 

so với nhóm ĐC. Chất lượng sản phẩm trò chơi mà SV ở nhóm sử dụng E-Book 

thiết kế được cũng tốt hơn nhóm SV không sử dụng E-Book. Mặt khác, thông qua 

việc đánh giá hồ sơ bài dạy có ứng dụng CNTT năm học 2012-2013 của SV ở 2 

nhóm TN và ĐC, chúng tôi nhận thấy E-Book là công cụ hỗ trợ hiệu quả và đã góp 

phần đáng kể trong quá trình hình thành, rèn luyện và nâng cao kỹ năng ứng dụng 

CNTT để thiết kế trò chơi trong dạy học hóa học của SV ở nhóm TN. 



E-Book đã mang lại một hiệu quả nhất định, giúp SV có thể nâng cao kỹ năng 

tin học, phục vụ cho việc dạy học hóa học sau này. E-Book cũng được các bạn SV 

đón nhận và sử dụng khá nhiệt tình. Tuy nhiên bên cạnh đó, E-Book cũng còn tồn 

tại một số hạn chế như số lượng phần mềm hướng dẫn sử dụng chưa nhiều, số 

lượng thao tác hướng dẫn còn ít nên chưa thực sự khai thác hết tính năng ở mỗi 

phần mềm. 



KẾT LUẬN VÀ KIẾN NGHỊ 

1. Kết luận 

Quá trình nghiên cứu và thực hiện đề tài xây dựng E-Book “ỨNG DỤNG 

CÔNG NGHỆ THÔNG TIN ĐỂ THIẾT KẾ TRÒ CHƠI TRONG DẠY HỌC HÓA 

HỌC”, về cơ bản khóa luận đã hoàn thành được những mục đích và nhiệm vụ đề ra 

sau đây: 

1.1. Bước đầu nghiên cứu một số nội dung để làm cơ sở lý luận của đề tài 

− Tìm hiểu xu thế của giáo dục thế kỉ XXI, lý luận về đổi mới PPDH và một số 

xu hướng đổi mới PPDH hiện nay, đặc biệt đổi mới PPDH với sự hỗ trợ của CNTT. 

− Nghiên cứu và làm rõ vai trò, tác dụng của trò chơi dạy học hóa học, cách áp 

dụng, một số lưu ý và biện pháp khắc phục khi tổ chức trò chơi dạy học. 

− Nghiên cứu tổng quan vấn đề xây dựng E-Book và các phần mềm khác hỗ 

trợ việc xây dựng E-Book. 

1.2. Nghiên cứu cơ sở thực tiễn của đề tài 

− Nghiên cứu thực trạng ứng dụng CNTT của SV sư phạm khoa Hóa trường 

ĐHSP TP.Hồ Chí Minh, GV ở các trường THPT trong dạy học hóa học hiện nay. 

− Nghiên cứu thực trạng ứng dụng CNTT để thiết kế trò chơi trong dạy học 

hóa học của SV sư phạm khoa Hóa trường ĐHSP TP.Hồ Chí Minh và GV ở các 

trường THPT hiện nay. 

1.3. Xây dựng E-Book “ỨNG DỤNG CÔNG NGHỆ THÔNG TIN ĐỂ 

THIẾT KẾ TRÒ CHƠI TRONG DẠY HỌC HÓA HỌC” 

Sử dụng phần mềm CourseLab 2.4 để xây dựng E-Book từ trang chủ đến các 

trang chuyên sâu cho từng phần mềm vừa đẹp về hình thức, chất lượng về nội dung 

và quan trọng là khai thác tối đa tính tương tác cao giữa người dùng và E-Book. E-

Book có dung lượng 800 MB, có cấu trúc như sau: 

• Trang chủ gồm các đường liên kết đến các trang chuyên sâu về các phần mềm 

dùng để thiết kế trò chơi như PowerPoint, Hot Potatoes 6, ProShow Gold. 

• Trong mỗi trang phần mềm đều có các nội dung cơ bản sau: 



− Giới thiệu tổng quan: Có thể là một đoạn phim hoặc tài liệu giới thiệu sơ 

lược ưu, nhược điểm, một số lưu ý,…về phần mềm. 

− Cài đặt phần mềm: Cung cấp hệ thống các đoạn phim hướng dẫn thao tác 

để cài đặt một phần mềm, trong trường hợp máy tính người dùng chưa cài đặt phần 

mềm đó hoặc không biết phải thực hiện công việc này như thế nào. 

− Hướng dẫn cơ bản: Gồm hệ thống các đoạn phim hướng dẫn thao tác cơ 

bản, tài liệu tham khảo và được phân chia thành các bước cụ thể để người dùng dễ 

dàng tìm hiểu, theo dõi. 

− Hướng dẫn nâng cao: Hướng dẫn người dùng thiết kế một số mẫu trò chơi 

hay, hấp dẫn từ đơn giản đến phức tạp bằng các phần mềm được giới thiệu trong E-

Book thông qua các đoạn phim. 

− Kho trò chơi tham khảo: Là nơi cung cấp các mẫu trò chơi, ý tưởng trò 

chơi, luật chơi,…được chúng tôi thiết kế và sưu tầm được. Các mẫu trò chơi có thể 

sử dụng được trong dạy học hóa học và đặc biệt là được thiết kế bằng những phần 

mềm giới thiệu trong E-Book. 

− Luyện tập-Kiểm tra: Hệ thống các câu hỏi, bài tập tự luyện dưới hình thức 

trắc nghiệm hoặc tự luận nhằm kiểm tra sự tiếp thu cũng như kỹ năng thiết kế các 

trò chơi sử dụng trong dạy học hóa bằng các phần mềm có trong E-Book. 

Để đáp ứng được 2 định hướng sử dụng E-Book: Tự học có hướng dẫn trong 

học phần ứng dụng CNTT và tài liệu tham khảo để tự học, rèn luyện và nâng cao kỹ 

năng ứng dụng CNTT để thiết kế trò chơi dạy học hóa học của GV và SV. Nội dung 

chính ở các phần cài đặt phần mềm, hướng dẫn cơ bản và hướng dẫn nâng cao của 

mỗi phần mềm bao gồm các đoạn phim được chúng tôi quay lại bằng chương trình 

Camtasia Studio 7. Cùng hệ thống các mẫu và ý tưởng trong trò chơi tham khảo là 

các trang luyện tập-kiểm tra kiến thức dưới hình thức trắc nghiệm có tính điểm và 

dạng bài tập tự luận.  

 

 

 



Cụ thể như bảng thống kê bên dưới: 

 PowerPoint  Hot Potatoes 6 ProShow Gold 

Số lượng đoạn phim hướng dẫn 15 25 25 

Số mẫu và ý tưởng trò chơi 

tham khảo 

55 8 15 

Số bài luyện tập-kiểm tra 11 8 7 

1.4. Thực nghiệm sư phạm để đánh giá kết quả của đề tài 

Trong phạm vi của đề tài, tác giả đã tiến hành TNSP để đánh giá tính khả thi và 

hiệu quả của việc sử dụng E-Book. Kết quả TNSP cho thấy E-Book đã đạt được các 

yêu cầu sau: 

− Về mặt hình thức: E-Book đã đáp ứng được các yêu cầu về tính thẩm mỹ 

với bố cục hợp lí, khoa học, giao diện thân thiện, thao tác sử dụng dễ dàng, chuyên 

nghiệp. 

− Về tính khả thi: E-Book có thể được sử dụng bởi số đông SV có trình độ vi 

tính khác nhau. 

− Về tính hiệu quả: Thông qua phiếu khảo sát ý kiến SV sau khi sử dụng E-

Book và đánh giá sản phẩm trò chơi, hồ sơ bài dạy mà SV ở nhóm TN thiết kế được 

trong học phần ứng dụng CNTT trong dạy học hóa học. Kết quả cho thấy, việc sử 

dụng E-Book đã góp phần làm cho kỹ năng thiết kế trò chơi dạy học có ứng dụng 

CNTT của SV được nâng lên, đồng thời làm đa dạng hoạt động dạy học hóa học ở 

các hồ sơ bài dạy. Từ đó, cũng góp phần vào việc đổi mới PPDH hiện nay theo 

hướng tích cực. 

− Về mặt nội dung: E-Book đã giới thiệu được những phần mềm có thể dùng 

để thiết kế trò chơi trong dạy học hóa học ở trường THPT. Đồng thời, các đoạn 

phim hướng dẫn, tài liệu tham khảo ở các phần mềm này khá chi tiết, rõ ràng và dễ 

hiểu. 

2.  Kiến nghị và đề xuất 

Qua quá trình nghiên cứu đề tài, tác giả có một số đề xuất sau: 



2.1. Đối với trường ĐHSP TP.Hồ Chí Minh 

Hiện nay, sử dụng CNTT vào dạy học hóa học của GV ngày càng trở nên gần 

gũi và là một phương tiện hỗ trợ đắc lực cho việc dạy học của GV trong tương lai. 

Vì vậy, nhà trường cần đầu tư xây dựng thêm nhiều phòng tin học, trang bị những 

máy tính mới, thêm một số môn có ứng dụng tin học để mỗi SV có điều kiện tiếp 

cận nhiều hơn với công nghệ hiện đại, nhằm giúp SV không chỉ vững về chuyên 

môn mà còn giỏi về CNTT, đây là một tiêu chí quan trọng của người GV thế kỉ 

XXI. Tiếp tục tổ chức, phát triển các hội thi chuyên đề về ứng dụng CNTT vào 

trong dạy học như hội thi “Thiết kế hồ sơ bài dạy có ứng dụng CNTT”. 

2.2.  Đối với khoa Hóa trường ĐHSP TP.Hồ Chí Minh 

 Tổ chức các lớp chuyên đề, các cuộc thi về ứng dụng CNTT vào trong dạy 

học hóa học giúp SV có dịp thể hiện và phát huy khả năng sáng tạo của mình, cũng 

như tạo một môi trường giao lưu, học hỏi các PPDH mới để vận dụng trong quá 

trình thực tập và đúc kết các PPDH hiệu quả. Tăng cường việc xây dựng E-Book, 

việc học tập qua web, mạng Internet, trong khi hiện tại, chúng tôi chỉ mới tiếp cận 

được với phần mềm Microsoft Office PowerPoint 2007, Hot Potatoes 6, ProShow 

Gold để thiết kế trò chơi trong dạy học hóa học mà chưa tiếp cận với nhiều phần 

mềm hay khác như: Adobe Flash, Violet, Microsoft Office Word 2007,…Vì vậy, 

chúng tôi rất mong khoa có thể tạo điều kiện cho SV được học tập các phần mềm 

này như những học phần tự chọn hay nâng cao của chương trình đào tạo. Điều này 

sẽ giúp chúng tôi rất nhiều trong việc thiết kế trò chơi dạy học hóa học một cách đa 

dạng, phong phú, hấp dẫn hơn. 

2.3. Đối với sinh viên khoa Hóa trường ĐHSP TP.Hồ Chí Minh 

Chủ động tham gia vào việc tìm hiểu, nghiên cứu, thực hành các kỹ năng 

thiết kế trò chơi dạy học hóa học có ứng dụng CNTT. Mạnh dạn đề xuất, trao đổi 

với bạn bè, thầy cô các ý tưởng trò chơi mới để có thể phát triển và ứng dụng chúng 

trong các đợt thực tập sư phạm và trong giảng dạy sau này. 



Nên có chương trình cụ thể cho việc học thêm ngoại ngữ và tin học phục vụ 

công tác nghiên cứu, tìm hiểu và nâng cao kỹ năng thiết kế trò chơi dạy học hóa học 

có ứng dụng CNTT, cũng như mở mang kiến thức. 

Ý thức được tầm quan trọng và tăng cường sử dụng E-Book để hỗ trợ SV sư 

phạm rèn luyện và nâng cao kỹ năng ứng dụng CNTT để thiết kế trò chơi trong dạy 

học thông qua sử dụng học liệu điện tử. 

3. Hướng phát triển của đề tài 

Trên nền tảng của E-Book hiện nay, chúng tôi mong có thể mở rộng để nội 

dung phong phú hơn như bổ sung thêm hệ thống các đoạn phim hướng dẫn các thao 

tác cơ bản, cách thiết kế nhiều trò chơi, hệ thống các ý tưởng trò chơi cũng như các 

mẫu trò chơi tham khảo và các bài tập để SV có thể tự luyện tập, kiểm tra. 

Đẩy mạnh việc sử dụng, tích hợp nghiên cứu thêm các phần mềm khác vào 

phần mềm CourseLab 2.4 để xây dựng E-Book có tính chuyên nghiệp, hấp dẫn và 

phong phú hơn. 

Tiếp tục nghiên cứu, thiết kế và sưu tầm các trò chơi dạy học hóa học, đặc biệt 

là thiết kế các trò chơi có ứng dụng CNTT phù hợp với nền giáo dục ở Việt Nam, 

cũng như điều kiện cơ sở vật chất ở các trường THPT hiện nay. Mặt khác, cũng góp 

phần vào việc nâng cao chất lượng dạy học, tăng hứng thú nhận thức cho học sinh, 

đáp ứng yêu cầu đổi mới PPDH hiện nay. 

Tiếp tục ứng dụng, giới thiệu các phần mềm hỗ trợ khác trong việc thiết kế trò 

chơi dạy học vào E-Book như Adobe Flash, Violet, Microsoft Office Word 2007,… 

Chúng tôi hi vọng rằng những kết quả từ nghiên cứu này sẽ góp phần nâng 

cao kỹ năng ứng dụng CNTT để thiết kế trò chơi trong dạy học hóa học của SV 

sư phạm trong học phần ứng dụng CNTT nói riêng, cũng như hỗ trợ rèn luyện 

và nâng cao kỹ năng của  SV, GV nói chung. Mặt khác, E-Book còn là tài liệu 

tham khảo tự học cho thế hệ GV trong thời gian đào tạo chưa có sự tiếp xúc với 

CNTT nhiều, điều đó sẽ góp phần đưa nền giáo dục Việt Nam có thể theo kịp với 

xu hướng giáo dục của thế kỉ XXI.  
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PHỤ LỤC 

Phụ lục 1: Phiếu khảo sát GV 

Trường Đại học Sư phạm TP. Hồ Chí Minh 

Khoa Hóa Học 

------------------------------------ 

PHIẾU KHẢO SÁT THỰC TRẠNG ỨNG DỤNG CÔNG NGHỆ THÔNG TIN 

ĐỂ THIẾT KẾ TRÒ CHƠI TRONG DẠY HỌC HÓA HỌC Ở TRƯỜNG TRUNG 

HỌC PHỔ THÔNG HIỆN NAY 

Kính chào quý thầy cô! 

Đẩy mạnh ứng dụng CNTT trong công tác giáo dục và đào tạo ở các cấp học, 

bậc học, ngành học theo hướng sử dụng CNTT như là một công cụ hỗ trợ nhất cho 

đổi mới phương pháp giảng dạy, học tập ở các môn học. Tuy nhiên, việc dạy học 

hóa học hiện nay không chỉ dừng lại ở việc ứng dụng CNTT trong việc thiết kế bài 

giảng điện tử sinh động, hấp dẫn…mà còn phải tạo động lực và sự hứng thú, sự chủ 

động ở học sinh trong học tập. Với mục tiêu như trên, việc sử dụng các trò chơi 

trong dạy học là một phương pháp đem lại hiệu quả rõ rệt. Tuy nhiên, việc ứng 

dụng CNTT để thiết kế các trò chơi trong dạy học hóa học chưa được chú trọng do 

còn gặp nhiều khó khăn, như hạn chế về ý tưởng các trò chơi, kỹ năng sử dụng các 

phần mềm để thiết kế trò chơi,…Với mong muốn hỗ trợ SV sư phạm –GV tương lai 

và GV hình thành, rèn luyện và nâng cao kỹ năng ứng dụng các phần mềm trong 

việc thiết kế trò chơi dạy học thông qua sử dụng E-Book, chúng tôi đang thực hiện 

đề tài nghiên cứu “Ứng dụng CNTT để thiết kế trò chơi trong dạy học hóa học”. 

Những thông tin của quý thầy (cô) cung cấp trong phiếu điều tra sẽ giúp chúng tôi 

đánh giá thực trạng ứng dụng CNTT để thiết kế trò chơi trong dạy học môn Hóa học 

ở trường THPT hiện nay. Chúng tôi xin đảm bảo mọi thông tin quý thầy (cô) cung 

cấp sẽ không được sử dụng vào mục đích nào khác ngoài mục đích khoa học của đề 

tài nghiên cứu. Em rất mong nhận được các ý kiến của quý thầy cô! 

Xin quý thầy (cô) vui lòng cung cấp một số thông tin cá nhân: 



- Thầy (cô) đang dạy tại trường ..............................................................................  

- Số năm kinh nghiệm: 

 Dưới 5 năm.  Từ 5 đến dưới 15 năm. 

 Từ 15 đến 25 năm.  Trên 25 năm. 

Xin quý thầy (cô) vui lòng hãy đánh dấu vào những phương án phù hợp nhất. 

1. Thầy (cô) có thường xuyên ứng dụng CNTT trong dạy học hóa học không? 

 Rất thường xuyên.  Thường xuyên. 

 Thỉnh thoảng.  Không sử dụng. 

2. Trong dạy học hóa học, thầy (cô) thường ứng dụng CNTT vào mục đích gì? 

(thầy (cô) có thể chọn nhiều ý). 

 Thiết kế bài giảng điện tử. 

 Thiết kế các trò chơi. 

 Thiết kế mô phỏng thí nghiệm. 

Ý kiến khác:……………………………………………………………………… 

3. Theo thầy (cô) GV phổ thông hiện nay ngại thiết kế các trò chơi có ứng dụng 

CNTT trong dạy học hóa học là do đâu? (thầy (cô) có thể chọn nhiều ý). 

 Không có thời gian. 

 Không biết dùng phần mềm nào để thiết kế. 

 Không biết thiết kế do kỹ năng CNTT còn kém. 

Ý kiến khác…………………………….……………………………………….. 

4. Kỹ năng sử dụng các phần mềm sau đây của thầy (cô) ở mức độ nào? 

 (Mức độ từ 0 là hoàn toàn không biết; 1 là cơ bản; 2 là thành thạo) 

STT Phần mềm 
Mức độ 

0 1 2 

1 Microsoft Office Powerpoint 2007    

2 Microsoft Office Word 2007    

3 Hot Potatoes 6    

4 ProShow Gold    

5 Adobe Flash    



6 Violet    

5.  Thầy (Cô) có thể thiết kế được trò chơi sử dụng trong dạy học hóa học bằng 

phần mềm nào trong các phần mềm dưới đây? 

 Microsoft Office PowerPoint 2007. 

 Microsoft Office Word 2007. 

 Hot Potatoes 6. 

 ProShow Gold. 

 Adobe Flash. 

 Violet. 

Phần mềm khác .........................................................................................................  

6. Thầy (cô) đã từng sử dụng trò chơi trong dạy học hóa học ở trường trung học 

phổ thông chưa? 

 Có.       Không. 

7. Theo thầy (cô) trò chơi sử dụng trong dạy học hóa học có thể áp dụng khi dạy 

các bài hoặc hoạt động nào?  

 Dạy bài mới.    Luyện tập.    Củng cố kiến thức.   Mở đầu bài giảng. 

8. Theo thầy (cô) việc ứng dụng CNTT để thiết kế trò chơi và sử dụng trò chơi 

trong dạy học hóa học ở trường THPT hiện nay có cần thiết không? Vì sao? 

 .......................................................................................................................................  

 .......................................................................................................................................  

 .......................................................................................................................................  

 .......................................................................................................................................  

 .......................................................................................................................................  

 .......................................................................................................................................  

 

Em xin chân thành cảm ơn ý kiến của quý thầy (cô)! 

Mọi chi tiết xin liên hệ: Lê Thị Thu Sang 

Lớp Hóa 4B-khoa Hóa học-Trường ĐHSP TP. Hồ Chí Minh 



 

Phụ lục 2: Phiếu khảo sát SV năm thứ 4 trước khi sử dụng E-Book 

Trường Đại học Sư phạm TP. Hồ Chí Minh 

Khoa Hóa học 

------------------------------------ 

PHIẾU KHẢO SÁT 
Các bạn SV thân mến! Với mong muốn hỗ trợ SV sư phạm Hóa rèn luyện và 

nâng cao kỹ năng thiết kế các trò chơi dạy học có ứng dụng CNTT ở dạng E-Book 

(sách điện tử) theo hình thức vừa học, vừa chơi, tạo sự thoải mái và thích thú cho 

người sử dụng, chúng tôi hy vọng sẽ nhận được sự giúp đỡ của các bạn thông qua 

việc trả lời các câu hỏi khảo sát sau bằng cách đánh X vào ý phù hợp với bạn. 

Thông tin cá nhân về người được điều tra 

Sinh viên lớp……………………………………………Giới tính:  Nam.    Nữ.  

Thành tích học tập (gần đây nhất):   

 Xuất sắc, giỏi.       Khá.    Trung bình.   Yếu, Kém. 

1. Trong học phần tin học đại cương, thành tích bạn đạt được là  

 Từ 9.0 trở lên.   

 Từ 8.0 đến dưới 9.0 

 Từ 7.0 đến dưới 8.0. 

 Từ 5.0 đến dưới 7.0. 

 Dưới 5.0. 

2. Bạn có máy tính để bàn hoặc laptop (máy tính xách tay) không?   

   Có.           Không. 

3. Mỗi ngày, bạn thường dành ra bao nhiêu thời gian để sử dụng máy tính? 

 1 – 2 tiếng.         2 – 4 tiếng.        Trên 4 tiếng.      Dưới 1 tiếng. 

4. Bạn thường sử dụng máy tính vào mục đích gì? (bạn có thể chọn nhiều ý). 

 Giải trí. 

 Tìm kiếm thông tin. 

 Thiết kế bài giảng. 



 Thiết kế các trò chơi. 

 Làm tiểu luận, làm bài tập, làm việc nhóm. 

Ý kiến khác………………………………………………………………….. 

5. Trong đợt thực tập sư phạm lần 1, bạn có ứng dụng CNTT trong dạy học hóa học 

không? 

   Có.     Không. 

6. Trong đợt thực tập sư phạm lần 1, bạn có thiết kế trò chơi nào mà có ứng dụng 

CNTT để tổ chức chơi trên lớp không? 

   Có.     Không. 

7. Theo bạn SV, GV ngại thiết kế các trò chơi có ứng dụng CNTT trong dạy học 

hóa học hiện nay là do đâu? (bạn có thể chọn nhiều ý). 

 Không có thời gian. 

 Không biết dùng phần mềm nào để thiết kế. 

 Không biết thiết kế do kỹ năng CNTT còn kém. 

Ý kiến khác…………………………….………………………………………… 

8. Bạn đã bao giờ ứng dụng CNTT để thiết kế các trò chơi không? (nếu có bạn vui 

lòng làm tiếp câu 9). 

   Có.      Không.  

9. Bạn thiết kế trò chơi đó phục vụ cho hoạt động nào? (có thể chọn nhiều ý). 

 Giáo dục ngoài giờ lên lớp. 

 Dạy học hóa học (trong thực tập sư phạm đợt 1). 

 Cho các bài tiểu luận, thuyết trình. 

Ý kiến khác……………………………………………………………………… 

10. Hãy kể tên một số trò chơi, kèm phần mềm mà bạn có thể thiết kế được. 

  .....................................................................................................................................  

  .....................................................................................................................................  

  .....................................................................................................................................  

  .....................................................................................................................................  

  .....................................................................................................................................  



11.  Trong số các phần mềm sau đây, bạn biết sử dụng phần mềm nào? (bạn có thể 

chọn nhiều ý). 

 Microsoft Office PowerPoint 2007. 

 Microsoft Office Word 2007. 

 Hot Potatoes 6. 

 ProShow Gold. 

 Adobe Flash. 

 Violet. 

12.  Kỹ năng sử dụng các phần mềm sau đây của bạn ở mức độ nào? 

 (Mức độ từ 0 là hoàn toàn không biết; 1 là cơ bản; 2 là thành thạo) 

STT Phần mềm 
Mức độ 

0 1 2 

1 Microsoft Office PowerPoint 2007    

2 Microsoft Office Word 2007    

3 Hot Potatoes 6    

4 ProShow Gold    

5 Adobe Flash    

6 Violet    

13.  Bạn có thể thiết kế được trò chơi bằng phần mềm nào trong các phần mềm dưới 

đây? 

 Microsoft Office PowerPoint 2007. 

 Microsoft Office Word 2007. 

 Hot Potatoes 6. 

 ProShow Gold. 

 Adobe Flash. 

 Violet. 

Phần mềm khác .......................................................................................................  

 ................................................................................................................................  

 ................................................................................................................................  



14. Bạn thường gặp những khó khăn nào khi học cách sử dụng một phần mềm mới? 

(bạn có thể chọn nhiều ý). 

 Tìm kiếm tài liệu.   

 Không có hướng dẫn chi tiết. 

 Hạn chế về ngoại ngữ. 

 Hướng dẫn khó hiểu. 

Ý kiến khác…………………………….……………………………………... 

15.  Bạn đã từng sử dụng E-Book (sách điện tử) hỗ trợ rèn kỹ năng thiết kế trò chơi 

trong quá trình học tập của mình không? 

  Có.    Không. 

16.  Bạn có muốn có một E-Book hỗ trợ bạn ứng dụng CNTT để thiết kế trò chơi 

trong dạy học hóa học không? 

 Rất muốn. 

 Muốn. 

 Có cũng được, không có cũng được. 

 Không muốn. 

 

Xin cảm ơn sự giúp đỡ của các bạn! Chúc các bạn học tập tốt! 

Mọi chi tiết thắc mắc, đóng góp ý kiến xin liên hệ địa chỉ Email sau: 

 lethithusang201@gmail.com 

 

mailto:lethithusang201@gmail.com


Phụ lục 3: Phiếu khảo sát ý kiến SV sau khi sử dụng E-Book 

Trường Đại học Sư phạm TP. Hồ Chí Minh 

Khoa Hóa học 

------------------------------------ 

PHIẾU KHẢO SÁT Ý KẾN SINH VIÊN SAU KHI SỬ DỤNG E-BOOK “ỨNG 

DỤNG CÔNG NGHỆ THÔNG TIN ĐỂ THIẾT KẾ TRÒ CHƠI TRONG DẠY 

HỌC HÓA HỌC” 

Các bạn sinh viên thân mến! Cảm ơn các bạn đã sử dụng E-Book của chúng tôi. 

Đẩy mạnh ứng dụng CNTT trong công tác giáo dục và đào tạo ở các cấp học, 

bậc học, ngành học theo hướng sử dụng CNTT như là một công cụ hỗ trợ nhất cho 

đổi mới phương pháp giảng dạy, học tập ở các môn học. Tuy nhiên, việc dạy học 

hóa học hiện nay không chỉ dừng lại ở việc ứng dụng CNTT trong việc thiết kế bài 

giảng điện tử sinh động, hấp dẫn,…mà còn phải tạo động lực và sự hứng thú, sự chủ 

động ở học sinh trong học tập. Với mục tiêu như trên, việc sử dụng các trò chơi 

trong dạy học là một phương pháp đem lại hiệu quả rõ rệt. Tuy nhiên, việc ứng 

dụng CNTT để thiết kế các trò chơi trong dạy học hóa học chưa được chú trọng do 

còn gặp nhiều khó khăn, như hạn chế về ý tưởng các trò chơi, kỹ năng sử dụng các 

phần mềm để thiết kế trò chơi,…Với mong muốn hỗ trợ SV sư phạm rèn luyện và 

nâng cao kỹ năng ứng dụng các phần mềm trong việc thiết kế trò chơi dạy học 

thông qua sử dụng E-Book, chúng tôi đã xây dựng E-Book “Ứng dụng CNTT để 

thiết kế trò chơi trong dạy học hóa học”. 

Rất mong nhận được các thông tin phản hồi của các bạn để  giúp chúng tôi 

nâng cao chất lượng E-Book, bằng cách đánh dấu X vào khung mà bạn chọn 

(hoặc điền vào khung thích hợp ). 

1. Trong học phần môn ứng dụng CNTT trong dạy học hóa học, bạn đã sử dụng 

phần mềm nào trong E-Book để thiết kế trò chơi? 

STT Tên phần mềm 
Đánh 

dấu 
Tên trò chơi 

1 Microsoft Office PowerPoint 2007   



2 Hot Potatoes 6   

3 ProShow Gold   

4 
Phần mềm khác……………………… 

………………………………………. 
  

2. Bạn có thiết kế được trò chơi mới sau khi sử dụng E-Book không ? 

  Có.       Không. 

(Nếu bạn chọn “Có”, bạn vui lòng làm tiếp câu 3) 

3. Bạn hãy liệt kê tên những trò chơi mới mà bạn thiết kế được. 

STT Tên trò chơi Sử dụng 

1   

2   

3   

4   

4. Đánh giá của bạn sau khi sử dụng E-Book theo các tiêu chí dưới đây với mức 

độ từ thấp (1) đến cao (4)  

(1: Không tốt, 2: Bình thường, 3: Tốt, 4: Rất tốt) 

STT 

 

Tiêu chí đánh giá 

 

Mức độ 
Ý kiến khác 

1 2 3 4 

Hình thức, giao diện E-Book 

1 Thiết kế khoa học      

2 Giao diện đẹp, thân thiện      

3 Bố cục hợp lí, logic      

Tính khả thi 

1 Thao tác sử dụng E-Book      

2 
Đáp ứng được nhu cầu người 

dùng 
     

3 Phù hợp với điều kiện thực tế       



5. Đánh giá của bạn sau khi sử dụng E-Book theo các tiêu chí dưới đây: 

Tiêu chí đánh giá Phần mềm 
Mức độ 

1 2 3 

Đoạn phim hướng dẫn sử 

dụng các phần mềm trong 

E-Book 

Microsoft Office PowerPoint 

2007 
   

Hot Potatoes 6    

ProShow Gold    

1. Khó hiểu, phức tạp.  2. Bình thường      3. Dễ hiểu, dễ áp dụng. 

  0 1 2 3 

Kỹ năng sử dụng các phần 

mềm được hướng dẫn trong 

E-Book 

Microsoft Office PowerPoint 

2007 
    

Hot Potatoes 6     

ProShow Gold     

0. Không biết sử dụng.  1. Biết sử dụng sơ lược.     2.  Căn bản.    3.Thành thạo. 

6. Trong hội thi “Thiết kế hồ sơ bài dạy có ứng dụng CNTT” năm học 2012-2013, 

bạn có sử dụng trò chơi vào trong bài giảng của mình không? 

   Có.       Không. 

7. Bạn hãy liệt kê tên những trò chơi mà bạn thiết kế và sử dụng trong hồ sơ bài 

dạy của mình: 

STT Tên trò chơi Mục đích sử dụng trò chơi  

1   

2   

3   

4   

8. Bạn có nhận xét gì về phần tư liệu trò chơi (ý tưởng trò chơi, các bài mẫu trò 

chơi,…) trong E-Book? 

 .........................................................................................................................................  



 .........................................................................................................................................  

 .........................................................................................................................................  

9. Đóng góp của bạn để E-Book hoàn thiện hơn. 

 .........................................................................................................................................  

 .........................................................................................................................................  

 .........................................................................................................................................  

Chúc các bạn học tập tốt !  

CẢM ƠN CÁC BẠN NHIỀU LẮM! 

Mọi đóng góp ý kiến hay thắc mắc xin liên hệ lethithusang201@gmail.com.  

mailto:lethithusang201@gmail.com


Phụ lục 4: Phiếu khảo sát SV năm thứ 3 

Trường Đại học Sư phạm TP. Hồ Chí Minh 

Khoa Hóa Học 

------------------------------------ 

PHIẾU KHẢO SÁT THỰC TRẠNG ỨNG DỤNG CÔNG NGHỆ THÔNG TIN 

ĐỂ THIẾT KẾ TRÒ CHƠI TRONG DẠY HỌC HÓA HỌC 

Các bạn sinh viên thân mến ! 

Đẩy mạnh ứng dụng CNTT trong công tác giáo dục và đào tạo ở các cấp học, 

bậc học, ngành học theo hướng sử dụng CNTT như là một công cụ hỗ trợ nhất cho 

đổi mới phương pháp giảng dạy, học tập ở các môn học. Tuy nhiên, việc dạy học 

hóa học hiện nay không chỉ dừng lại ở việc ứng dụng CNTT trong việc thiết kế bài 

giảng điện tử sinh động, hấp dẫn,…mà còn phải tạo động lực và sự hứng thú, sự chủ 

động ở học sinh trong học tập. Với mục tiêu như trên, việc sử dụng các trò chơi 

trong dạy học là một phương pháp đem lại hiệu quả rõ rệt. Tuy nhiên, việc ứng 

dụng CNTT để thiết kế các trò chơi trong dạy học hóa học chưa được chú trọng do 

còn gặp nhiều khó khăn, như hạn chế về ý tưởng các trò chơi, kỹ năng sử dụng các 

phần mềm để thiết kế trò chơi,…Với mong muốn hỗ trợ SV sư phạm – GV tương 

lai hình thành, rèn luyện và nâng cao kỹ năng ứng dụng các phần mềm trong việc 

thiết kế trò chơi dạy học thông qua sử dụng E-Book, chúng tôi đã xây dựng E-Book 

“Ứng dụng CNTT để thiết kế trò chơi trong dạy học hóa học”. 

 Vì thế chúng tôi rất mong sẽ nhận được sự giúp đỡ của các bạn thông 

qua việc trả lời các câu hỏi khảo sát sau bằng cách đánh X vào ý phù hợp với 

bạn. 

Thông tin cá nhân về người được điều tra 

Sinh viên lớp…………………………………………….Giới tính:  Nam.    Nữ.  

Thành tích học tập (gần đây nhất):   

 Xuất sắc, giỏi.   Khá.        Trung bình.   Yếu, Kém. 

1. Trong học phần tin học đại cương, thành tích bạn đạt được là  

 Từ 9.0 trở lên.   



 Từ 8.0 đến dưới 9.0 

 Từ 7.0 đến dưới 8.0. 

 Từ 5.0 đến dưới 7.0. 

 Dưới 5.0. 

2. Bạn có máy tính để bàn hoặc laptop (máy tính xách tay) không?    

   Có.          Không. 

3. Mỗi ngày, bạn thường dành ra bao nhiêu thời gian để sử dụng máy tính? 

 1 – 3 tiếng.     3 – 5 tiếng.    Trên 5 tiếng.      Dưới 1 tiếng. 

4. Bạn thường sử dụng máy tính vào mục đích gì? (bạn có thể chọn nhiều ý). 

 Giải trí. 

 Tìm kiếm thông tin. 

 Thiết kế bài giảng. 

 Thiết kế các trò chơi. 

 Làm tiểu luận, làm bài tập, làm việc nhóm. 

Ý kiến khác…………………………………………………………………….. 

5. Theo bạn SV, GV ngại thiết kế các trò chơi có ứng dụng CNTT trong dạy học 

hóa học là do đâu? (bạn có thể chọn nhiều ý). 

 Không có thời gian. 

 Không biết dùng phần mềm nào để thiết kế. 

 Không biết thiết kế do kỹ năng CNTT còn kém. 

Ý kiến khác…………………….………………………………………………… 

6. Bạn đã bao giờ ứng dụng CNTT để thiết kế các trò chơi không? (nếu có bạn vui 

lòng làm thêm câu 7). 

   Có.      Không.  

7. Bạn thiết kế trò chơi đó phục vụ cho hoạt động nào? (có thể chọn nhiều ý). 

 Giáo dục ngoài giờ lên lớp. 

 Dạy học hóa học. 

 Cho các bài tiểu luận, thuyết trình. 

Ý kiến khác………………………..…………………………………………….. 



8. Hãy kể tên một số trò chơi, kèm phần mềm mà bạn có thể thiết kế được. 

  .....................................................................................................................................  

  .....................................................................................................................................  

9.  Trong số các phần mềm sau đây, bạn biết sử dụng phần mềm nào? (bạn có thể 

chọn nhiều ý) 

 Microsoft Office PowerPoint 2007. 

 Microsoft Office Word 2007. 

 Hot Potatoes 6. 

 ProShow Gold. 

 Adobe Flash. 

 Violet. 

10.  Kỹ năng sử dụng các phần mềm sau đây của bạn ở mức độ nào ? 

 (Mức độ từ 0 là hoàn toàn không biết; 1 là cơ bản; 2 là thành thạo) 

STT Phần mềm 
Mức độ 

0 1 2 

1 Microsoft Office PowerPoint 2007    

2 Microsoft Office Word 2007    

3 Hot Potatoes 6    

4 ProShow Gold    

5 Adobe Flash    

6 Violet    

11.  Bạn có thể thiết kế được trò chơi bằng phần mềm nào trong các phần mềm dưới 

đây ? 

 Microsoft Office PowerPoint 2007. 

 Microsoft Office Word 2007. 

 Hot Potatoes 6. 

 ProShow Gold. 

 Adobe Flash. 

 Violet. 



Phần mềm khác .......................................................................................................    

12. Bạn thường gặp những khó khăn nào khi học cách sử dụng một phần mềm mới? 

(bạn có thể chọn nhiều ý). 

 Tìm kiếm tài liệu.    Hạn chế về ngoại ngữ. 

 Không có hướng dẫn chi tiết.  Hướng dẫn khó hiểu. 

Ý kiến khác…… ......................................................................................................  

13.  Bạn đã từng sử dụng E-Book (sách điện tử) hỗ trợ rèn kỹ năng thiết kế trò chơi 

trong quá trình học tập của mình không? 

  Có.    Không. 

14.  Bạn có muốn có một E-Book hỗ trợ bạn ứng dụng CNTT để thiết kế trò chơi 

trong dạy học hóa học không? 

 Rất muốn.  Có cũng được, không có cũng được. 

 Muốn.  Không muốn. 

15. Theo bạn, việc ứng dụng CNTT để thiết kế trò chơi và sử dụng trò chơi trong dạy 

học hóa học hiện nay có cần thiết không? Vì sao? 

 .......................................................................................................................................  

 .......................................................................................................................................  

 .......................................................................................................................................  

 .......................................................................................................................................  

 .......................................................................................................................................  

 .......................................................................................................................................  

 .......................................................................................................................................  

Xin cảm ơn sự giúp đỡ của các bạn! Chúc các bạn học tập tốt! 

Mọi chi tiết thắc mắc, đóng góp ý kiến xin liên hệ địa chỉ Email sau: 

 lethithusang201@gmail.com 

SĐT: 01693302096 

mailto:lethithusang201@gmail.com
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